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Introduction

TT OVBIVIBW. « ottt e
1.2, Onwation Pro Documentalion: . ..sceessms sva sessuesies mw vaamies
1.3 Typographical Conventions. . .. .........c.vvuuinininieenn...
1.4  IfyouhaveProblems ........ ... ... ... .. ...

1.5  LlatestInformation. . .. ...t

This chapter infroduces the concept of desktop publishing and lists some of
the special features of Ovation Pro. It summarises all the documentation
provided with the software and describes the order in which it should be

read.



2 INTRODUCTION

1.1 Overview

A desktop publisher allows you to take text and
pictures and arrange them on the page in virtually
any way you wish. Text may be typed in directly
or imported from another source, such as a file or
another word processor. You can then alter the
style of the text and control how it flows around
the page. Pictures can be imported from file or
from another application such as Draw or Paint,
and then scaled, cropped, rotated etc. as required.

Once the page has been completed, it may be
printed out on a wide range of printers, such as
dot-matrix, ink jet, laser and even professional
typesetting machines.

Ovation Pro

Ovation Pro brings together word processing
with state-of-the-art page layout features to
deliver a extremely powerful desktop publishing
system. You may use Ovation Pro to create just
about any type of document, from a single-page
letter to an entire book, or from a simple leaflet to
a complex advert.

Even with such a vast range of features available,
Ovation Pro is still easy-to-use, thanks to a
superb user interface that makes the software easy
to learn and instinctive to use. It is also extremely
fast and responsive, and of course in true What
You See Is What You Get(WYSIWYG) manner,
faithfully represents the document on the screen
exactly as it is printed.

Special features of Ovation Pro, include:
e Toolbox attached to the active document.

e Context sensitive info palette gives
information and options about the current
operation.

e Definable button bar allows you to choose
which options you would like to appear on a
bar across the top of the document.

e [rregular frames drawn using lines and curves.
Text can flow inside or around irregular
frames, and pictures are cropped inside them.

e Rotated text frames with fully editable text.

CHAPTER 1

Multi-step Undo/Redo. The number of steps
that may be undone is determined by the size
of a user definable buffer.

Drag and Drop for text and objects within the
same page or even to another page or
document.

User-definable named colour system allows
you to use colours consistently throughout
your documents. You can even create your own
colour charts,

Automatic drop-caps. These are large capitals
that are often seen at the start of paragraphs.

Pasteboard around document for temporary
storage of objects and to allow objects to bleed
off the page.

Advanced justification with fully controllable

letter spacing. This allows you to fit text into
narrow columns easily.

Advanced automatic hyphenation control.

Multi-column frames, frames with rounded
corners, skewed frames and vertical alignment
of text in frames.

Automatic text flow around irregular pictures.

Picture cropping can easily be achieved using a
special tool.

Frame borders and auto drop shadows on
rectangular frames.
Straight and curved line drawing.

Grid and ruler guidelines for easy page design.
Plus facility to snap to other objects.

Full page and chapter handling with separate
master pages for each chapter. Easy-to-use
headers and footers.

Character selector and single-shift font change
allow you to easily insert special characters
from other fonts.

Extensive printing capabilities including
pamphlet and galley printing.

Integrated script language based on a subset of
the C programming language.
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1.2 Ovation Pro Documentation

The separate release notes give details of the
minimum systems requirements to run

Ovation Pro, and how to install it on your system.

If you are a beginner to desktop publishing you
should read the separate tutorial which describes
how to create a simple document step-by-step.

This reference guide describes all the features of
Ovation Pro, but does not attempt to teach you
desktop publishing or good document design. For
this you are recommended to refer to the many
specialised works on typography, book, magazine
and layout design.

It is assumed that you are familiar with the

RISC OS desktop environment and filing system.
If you are not, please read the relevant sections of
your computer user guide.

The chapters in this reference guide may be
divided into a number of groups:

The Basics

Chapter 2 describes the Ovation Pro user
interface and how to create, print and save a
simple document. Chapter 7 details options that
change the way the document may be viewed on
screen.

Adding Style

Chapters 3, 4, 5 and 6 describe how to type in
text and add style to that text. You can add local
text or paragraph effects, or define named styles
that may be applied at the press of a key.

Objects

Chapters 8 and 9 describe how to draw and
manipulate frames, which are the basic building
blocks of desktop publishing. Chapter 10 deals
with manipulating pictures in frames.

Page Handling
All aspects of handling pages, chapters, master

pages and stylesheets are described in Chapter 11.

OvartioN Pro DocuMENTATION

Miscellaneous

Chapters 12 to 17 describe all the remaining
features, such as printing, spell checking and
customisation. The integrated script language
described in chapter 17, is intended for advanced
users who have a knowledge of the C
programming language.

Appendices

The appendices at the end of this guide list
character sets, summarise key short-cuts and
provide other advanced information not normally
required in everyday use.

Glossary

This explains many of the terms used in desktop
publishing.

3



4 INTRODUCTION

1.3 Typographical Conventions

The following typographical conventions are used
throughout this user guide.

Key Presses
Key presses are shown capitalised in normal type:

Press the Page Up and Page Down keys to
scroll the window up or down by one screen.

Mouse Clicks
Mouse clicks are shown capitalised in normal
type:

Click Select to zoom up by 50%.

Dialogue Boxes
Names of dialogue boxes, and options on them
are shown in bold type:

Click on OK on the New dialogue box.

Menus
Menu options are shown in bold type:

The Misc~>Macros dialogue box allows
macros to be created and edited.

The example above means choose the Macros
option on the Misc menu.

References
References to illustrations or other parts of the
user guide are shown in italics:

These are explained in detail, later in this user
guide (see 11.2).

Please refer to Appendix A which gives full
details.

Technical Terms
The first time a technical term is used, it is shown
in italics:

Inside the document window is the default

master frame into which text may be typed or
imported.

CHarTER 1

Filenames
Filenames and pathnames are shown in Courier
type:
To run the software, double click on the
application ! OvnPro.

Messages
Warning and error messages are displayed in
Courier type:

The error message Not enough free
memory will be displayed.
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1.4 If you have Problems

If you discover a problem with Ovation Pro
please report it to us in writing by either letter, fax
or email:

Ovation Pro Support
Beebug Ltd

117 Hatfield Road
St. Albans

Herts AL1 4JS

UK

Fax: (01727) 860263
Email: software @beebug.co.uk

Please describe briefly the steps that must be
followed to reproduce the problem, and if
necessary send a copy of any problem documents.
Also include the following information about the
system you are using:

The version of Ovation Pre you are running
(found on the Info dialogue box).

The version of RISC OS you are using.
The amount of RAM you have installed.
Any additional software that is running.
Any additional hardware that is fitted.

If you are having problems when printing, give
details of the printer and printer driver you are
using.

Please do not return any discs or packaging until
requested to do so.

If you HAVE PrOBLEMS

5



6 INTRODUCTION

1.5 Latest Information

The Ovation Pro release notes describe the
contents of each disc supplied, and give details of
any changes made to the software since this user
guide was printed.

In addition, the Ovation Pro document called
ReadMe on one of the release discs, lists the
latest changes and additions. To read it, ensure
that Ovation Pro is loaded or has been ‘seen’,
then double-click on it.

CHarTer 1
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This chapter explains how to run Ovation Pro, and how to load existing
documents and create new documents. It also describes the document
environment in detail, and introduces the toolbox, info palette and

button bar. It is assumed you have installed Ovation Pro according to
the separate installation instructions.
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2.1 Loading Ovation Pro

Locate and double-click on the application
1 OvnPro. Ovation Pro should then be loaded
and its icon installed on the icon bar.

If there is insufficient memory to load

Ovation Pro, an error message will be displayed.

If this happens, remove any other applications
that are running and then try loading it again. If
you still encounter problems, please refer to
Appendix A which gives details of how to make
best use of the memory available.

Ovation Pro
Info >
New...
Clipboard...
Choices...
Quit

Fig. 2.1 - Ovation Pro icon bar menu.

CHAPTER 2

2.2 The Icon Bar Menu

Click Menu over the Ovation Pro icon on the
icon bar to display the icon bar menu (fig. 2.1).
This menu provides the following options which
are described in detail later in this user guide.

Info

Info displays information about the version of
Ovation Pro you are using (fig. 2.2). The version
number given should be quoted in any
correspondence with Beebug Ltd concerning this
product.

New

New opens the New document dialogue box
(fig. 2.4), which allows the paper size, margins
etc. to be specified (see 11.2).

Clipboard
Clipboard displays the contents of the clipboard
(see 3.7).

Choices

Choices opens a dialogue box that allows
Ovation Pro to be configured (see 14.3).

Quit
Quit exits Ovation Pro (see 3.11).

Name | Ovation Pro
Purpose | Desktop Publisher
Author | © Beebug Ltd, 1996
Version | 2.10 (04-Mar-96)

Fig. 2.2 - The Info dialogue box.
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2.3 Loading Existing Documents

To load an Ovation Pro document, double-click
on the document’s icon. This operation also loads
Ovation Pro if it has not been already loaded
(provided the application has been ‘seen’ by the
filer).

Alternatively, drag the existing document to the
Ovation Pro icon on the icon bar.

Font Mapping

If you load an Ovation Pro document that uses
fonts that are not present on your system, a
warning box will be displayed (fig. 2.3).

Click on Cancel to stop the document from being
loaded.

Click on Reflow to permanently replace the
missing fonts with Trinity. If the document is
subsequently re-saved, then Trinity will be saved
and the original fonts will be lost.

Click on Substitute to temporarily replace the
missing fonts with Trinity until the document is
closed or until the missing fonts are made
available. The Substitute facility is not available
when loading Ovation documents.

Loaping ExisTiING DocuMENTS 9

Loading Ovation Documents

You may also load old Ovation documents by
dragging them to the Ovation Pro icon bar icon.
However, please note the following points:

e Ovation documents will be bigger in size when
loaded into Ovation Pre and when re-saved in
Ovation Pro format,

e You will be warned if you load an Ovation
document into Ovation Pro then attempt to re-
save it, overwriting the original document,

e Ovation Pro does not support nested objects, so
any nested objects in Ovation documents will
not be nested in Ovation Pro. This will not
matter if you just wish to view or print the
document, but if you wish to edit it, objects may
need to be grouped to keep them together.

e Ovation line and border styles are emulated
fairly closely in Ovation Pro, but they may not
be an exact match. Extended border styles in
Ovation are not supported in Ovation Pro.

e The operation of master pages in Ovation Pro is
significantly different from Ovation. This will
not matter if you just wish to view or print the
document, but editing the master pages in
Ovation Pro may result in objects appearing
twice in the document.

. document with a new font?

This document uses 1 font (Chaucer.Medium.ltalic)
which is not present. Do you wish to reflow the

Proceed o further with loading _ Cancel _ |
Permanent replacement  Reflow

Temporary repiaoav‘nent,| Substitute |

Fig. 2.3 - Warning box if fonts are missing when loading a document.
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2.4 Opening a New Document

Click Select on the Ovation Pro icon on the icon
bar to open a new document based on the default
document. If required you can edit the default
document (see 14.2).

The default page is A4 with 10mm margins all
around, but if you want a different paper size or
margins, choose New from the icon bar menu
(fig. 2.4). Now change the page size or margins as
required and click OK when complete. At this
stage you should not change any other options on
this dialogue box. The New dialogue box is
explained in detail later in this user guide

(see 11.2).

New document

Paper | A4 °H| H[ 207mm |
con[ 1 w[ o]

[7 Master frame specification =

Columns [ 1] | /.5 7]

__|Double sided

__|sideways

top[tonm | a0 | veacer o |

.Cancelll oK |

Fig. 2.4 - The New document dialogue box.

CHAPTER 2
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2.5 The Document Window

The document window is a standard RISC OS
window, but with a roelbox, info palette and
button bar attached (fig. 2.5). You can have more
than one document open at the same time, but

only one can be active. Clicking inside a

document window makes it active; indicated by a
yellow title bar. Typing and other operations
always apply to the active window. Only the
active window has the toolbox and info palette

attached.

The document window title bar shows the name

of the document. If it is followed by the *

character, it indicates that the document has been

changed but not yet saved.

Close icon

THe Document Winpbow 11

Scrolling the Document

The amount of the document that is in view in the

window depends upon the size of the window and

the current zoom (see 2.9). You can move the

document around in the window in the following

ways:

e Use the horizontal and vertical scroll bars in the
usual way.

e Press the Page Up and Page Down keys to scroll
the window up or down by one screen.

o

)
Flo

]

‘e

Caret

\\
Toolbox

Default master frame

Scroll bars

| Eleloilﬁ/alglols-lx

x'

Y

1.1

Fig. 2.5 - The active document window.
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Default Master Frame

Inside the document window is the default master
frame into which text may be typed or imported.
The size of this frame is determined by the
margins set in the default document.

This frame is a master frame, meaning that it is
generated by the master pages and will appear on
all pages of the chapter. The size and position of a
master frame can only be changed on the master
pages or by making the frame local (see 11.3).

Text that overflows at the bottom of the default
master frame, automatically flows onto the next
page.

The default master frame has a red outline to
indicate that it is active. Click Select outside it (in
the margins) to make it non-active with a grey
outline. Click back inside it to make it active
again.

File
Edit
View
Text
Style
Object
Page
Misc &

Y Y VY VYTV YE"

Fig. 2.6 - The main menu.

CHAPTER 2

The Caret

The red I-shaped vertical bar is called the caret
and indicates where text will appear when typed
or imported into the document. When a new
document is opened, the caret is automatically
positioned in the top left corner of the default
master frame ready for text entry.

The caret is always displayed in the active text
frame (unless there is a text selection). If there is
no active text frame, the caret will disappear and
text cannot be entered.

The Main Menu

Almost all Ovation Pro operations are available
from the main menu (fig. 2.6), which is displayed
by clicking Menu over the document window.,

To clear the main menu, click Select over the
document window.
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2.6 The Toolbox

The toolbox is attached to the left-edge of the
active document (fig. 2.7).

The top eight tools are the main tools for DTP
work, including editing text and manipulating
objects. One of these tools will always be
selected; by default it is the Select tool which is
used for selecting objects and editing text.

The bottom four tools provide the four shapes that
may be used when drawing frames and lines. One
of these will always be selected; by default it is
the Rectangle tool.

To select a tool, click Select on it. Apart from the
Frame and Line tools, tools remain selected until
another tool is chosen. The Frame and Line tools
normally revert back to the Select tool once the
object has been drawn.

Select tool
Frame tool

Line tool
Path Edit tool
Rofate tool

Link tool

Crop tool

%‘4

Zoom tool

[

[ ]4+—— Rectangle
9 Ellipse

Ak
2

Fig. 2.7 - The toolbox.

Straight line segment

Curved line segment
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Moving the Toolbox

By default the toolbox is attached to the left edge
of the document window. However, if required
you may move it to a new position by dragging
on its background or by pressing Shift and
dragging on a tool. If the document window is
moved, the toolbox moves relative to it.

You may use an option on Choices to detach the
toolbox from the window (see 14.5).

Changing the Toolbox Shape

You can change the toolbox shape by clicking
Adjust on the toolbox background and dragging
up and down until the required shape is achieved
(fig. 2.8).

The position and shape of the toolbox may be
different for each open document. They are not

saved with documents, but may be saved as
default (see 14.2).

Re-ordering the Tools

You can swap the order of tools by holding down
Ctrl and dragging one tool onto another tool. The
positions of the two tools are swapped. The order
of tools may be saved with the application
choices (see 14.3).

P

| OV

Fig. 2.8 - Other toolbox shapes.
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2.7 The Info Palette

The info palette is attached to the bottom of the
active document. It is context sensitive i.e. it
provides information and options according to the
currently selected tool or object (figs. 2.9 to 2.14).
So, if you are working on text, it gives options
concerned with changing the font, size and style
of the text.

The icon in the top left corner of the info palette
shows the name of the current tool, or if the
Select tool is active, it shows the type of object
selected.

CHAPTER 2

Current Page & Chapter

The current chapter and page number are shown
in the icon in the bottom left corner of the info
palette. The number is in the form c.p, where ¢ is
the chapter number and p is the page number.

If there is more than one page visible in the
document window, the current chapter/page is the
one in the centre of the window.

Text frame X|[10mm W| 190mm
1.1 Y| 10mm H|277mm

| Trinity
INBI/|VIB || & = %5

Fig. 2.9 - The info palette displayed when a Text frame is active.

B % ©

| Picture frame X[ 34.99mm| W/19.19mm

Scale|182.35

b

[ 11 Y|5.64mm | H|17.5mm 100

Aspect

= X[0.85mm |~ A| 0
=¥[omm |= At

Fig. 2.10 - The info palette displayed when a Picture frame is active.

Line X|82.13mm| W|39.23mm
11 Y|5.64mm | H

17.5mm

Line wiam] Thin

=l

Fig. 2.11 - The info palette displayed when a Line is active.

|_Pamaalmode %[121.35mn

et Pt PR Lm0 B8 i

| 1.1 Y(5.64mm | mdu=| =x—| -

Fig. 2.12 - The info palette displayed when in Path Edit mode.

Rotate

Al o |-§,:I.lj.j[70mmr
ok T

Fig. 2.13 - The info palette displayed when the Rotate tool is active.

[ Document zoom Zoom [ 100 |~ Previous | 0% | 75% | 100% | Fit window

11 : . 150%200% [ 400% | Fit screen

Fig. 2.14 - The info palette displayed when the Zoom tool is active.
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Moving the Info Palette

By default the info palette is attached to the
bottom of the document window, However, if
required you can move it to a new position by
dragging on its background or by pressing Shift
and dragging on one of the two icons at the left-
hand side. If the document window is moved, the
info palette moves relative to it.

You may use an option on Choices to detach the
info palette from the window (see /4.5)

The info palette position may be different for
each open document, but it is not saved with

documents. However, it’s position may be saved

as default (see 14.2).

THE INFO PALETTE

15
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2.8 The Button Bar

The button bar provides access to common
general purpose functions in Ovation Pro. It is
located at the top of every document window
(fig. 2.15). A default set of buttons are provided,
and these are listed in the next column. You can
scroll the button bar by moving the pointer over
either end of the button bar.

You can change the position of a button on the
button bar by pressing Ctrl and dragging it to the
required position. The button will be placed
before the button over which it is dropped. The
new positions may be saved if required (see 16.6).

The Misc=Macros dialogue box allows you to
add, remove or define further buttons, and save
them as the default. A larger set of buttons are
also available from which you may choose those
that suit your requirements (see 16.7).

CHAPTER 2

Default Buttons
@J File info dialogue box (see 3.1).

Save as dialogue box (see 3.10).
Print dialogue box (see 3.11).

Select all (see 3.6).

Cut selection (see 3.7).

ﬂ Copy selection (see 3.7).

EJ Paste selection (see 3.7).

'X!| Delete selection (see 3.7).

1] showrhide Clipboard (see 2.2).

3‘ Undo (see 3.4).

EJ Redo (see 3.4).

™| Showhide Rulers (see 7.3).

11| showhide Guidelines (see 7.3).

EE Enable/disable Grid and grid lock (see 7.4).
@ Zoom dialogue box (see 7.5).

1| Modity text/picture box (see 4.6 & 10.7).
ﬁ Text Colour dialogue box (see 4.5).
Text Format dialogue box (see 5.4).
Display tab ruler (see 5.5).

QI Modify object dialogue box(see 9.1).
Frame border dialogue box (see 9.6).
E Spellcheck Word (see 13.3).

ZJ Spellcheck Story (see 13.2).

AR EERE

0l sls| Floza -]

E
»

g vv

Fig. 2.15 - The default button bar.
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2.9 Document Zoom

You can view and edit the document in range of
preset zooms or any variable zoom. The default
zoom is 100% which shows your document on
screen at approximately 100% of the true printed
size.

To change the zoom choose the Zoom tool

(fig. 2.16). Now move the pointer over the point
in the document you wish to zoom in on, and
click Select to zoom up by 50% or click Adjust to
zoom down by 50%. The current zoom is shown
in the info palette.

You may enlarge a particular area of the
document by dragging a box around that area
with the Zoom tool.

Fig. 2.16 - The Zoom tool.

Document Zoom 17

When the Zoom tool is selected, the info palette
provides the following options (fig. 2.17).

Zoom allows you to enter any zoom value
between 10% and 1000%. Press return to update
the document. You may also step up and down by
1% using the up and down arrows.

Previous restores the zoom that was current
before the zoom tool was chosen.

50%, 75%, 100%, 150%, 200% and 400% are
the standard preset zooms.

Fit window sets the document zoom so that an
entire page (or pair of pages) fits in the document
window.

Fit screen sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

75% | 100% | Fit window |

Document zoom Zooml 100 I'} Previousl 50%
11 - 150%

200% | 400%

Fit screen

Fig. 2.17 - The info palette displayed when the Zoom fool is active.
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2.10 Interactive Help

Ovation Pro supports the standard Acorn
interactive help system.

Since interactive help uses a considerable amount
of memory, it is normally disabled. To use it, it
must be enabled using an option on Choices

(see 14.4), and then Ovation Pro must be re-run.

To display interactive help, double-click on

! Help which is supplied with your computer.
When this has loaded, the Help icon appears on
the icon bar and a window entitled Interactive
help is displayed (fig. 2.18).

The window contains information about whatever
the mouse pointer is over. As you move the
mouse, the information changes.

You can remove the interactive help window by
clicking on its close icon. To re-display the
window, click Select on the Help icon on the icon
bar. To close down interactive help altogether,
choose quit from the Help icon bar menu.

CHaAPTER 2

R R
This is the Title bar.
Click SELECT to bring the window to the top.

Drag SELECT to move the window around the desktop.
Drag ADJUST to move the window without affecting the order of windows.

Fig. 2.18 - The interactive help window.
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This chapter describes all aspects of typing, editing and importing text.
Once you have created a simple document, it explains how to save and
print the document, and finally how to quit Ovation Pro.
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3.1 Typing & Editing Text

You can type and edit text whenever there is an
active frame containing the caret. A later chapter
will describe how to draw your own frames, but
this chapter assumes you have opened a new
document as described in the previous chapter
(see 2.4). You should have a document window
open, with the caret in the default master frame
frame ready for text entry. The Select tool should
be chosen (fig. 3.1).

Try typing a few words at the keyboard. The caret
moves to the right of each character as you type.
The style and format of the text you type is
determined by the style called BodyText. By
default BodyText uses the font Trinity
(equivalent to Times) at a size of 12pt, and is
suitable for general-purpose word processing.

Type more words until you have filled a complete
line. If necessary the window automatically
scrolls sideways so that the portion of the page
you are editing always remains in view,

The entire text in a frame or in a number of linked
frames is referred to as a story.

Select tool

i
A
@
@)

J |
Al
|

|

|
L
=]
<)
|

|

."\'\/

| alads |
k)

©

|

Fig. 3.1 - The Select tool.
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Word Wrap

Ovation Pro automatically re-formats text to fit
into the active frame, so there is no need to press
Return at the end of each line. If a word is too
long to fit on a line, it is automatically transferred
to the start of the next line. Similarly, if a word at
the beginning of a line is reduced sufficiently in
length for it to fit on the end of the previous line,
then it will be automatically moved up.

New Paragraph & New Line

Press Return to start a new paragraph, putting the
caret at the start of the next line. You can
optionally add white space at the end of a
paragraph to separate it from the next paragraph.
This is called Space after (see 5.4).

Choose Misc Insert<>New line or press Shift
Return to start a new line, without starting a new
paragraph (see 5.1).

New paragraph and new line characters may be
deleted, causing paragraphs and lines to be joined
back together.
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Caret Movement

If the Select tool is chosen, and the pointer moved
over an active text frame, the pointer shape
changes to the text insertion tool (fig. 3.2). You
may position the caret by clicking with this tool:

e If you click within some text, the caret appears
at that position.

e If you click beyond the end of a line, the caret
appears at the end of that line.

e If you click in an empty frame, the caret appears
in the top left corner of the frame.

The caret may also be moved using the cursor
keys on the keyboard:

— = Caret left/right one character
T4 Caret up/down one line

Te N> Caret left/right one word
1Tl Caret up/down one paragraph
he— Ay Caret to start/end of line

AT Al Caret to start/end of text story
AT AL Scroll up/down through story

Where * and T refer to the Ctrl and Shift keys.
Tab Key

Pressing Tab inserts a tab character into the text,
causing subsequent text to be aligned to the next
tab stop. The default tab stops are at 10mm
intervals, but these may be changed if required
using the tab ruler. (see 5.5).

Transposing Characters

A common typing mistake is to transpose
character pairs e.g. feild and ot fen. This can
easily be corrected by positioning the caret
between the two characters and pressing

Ctrl Shift Q.

|

Fig. 3.2 - The Text Insertion tool.
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Deleting Text

Press Delete or Backspace to delete the character
to the left of the caret, or Copy/End to delete the
character to the right of the caret.

Press Shift Delete to delete the word containing
the caret, or Shift Copy/End to delete the word
after the caret.

Press Ctrl Delete to delete from the caret to the
start of the line, or Ctrl Copy/End to delete from
the caret to the end of the line.

Press Ctrl Shift Delete to delete the line at the
caret.

You may also delete selected blocks (see 3.7).

Automatic Page Creation/Deletion

If text fills the default master frame, a new page
is added with its own master frame. The text then
flows automatically into that frame. This process
is called auromatic page insertion and the frames
are said to be linked.

If you delete sufficient text from a document to
leave the default master frame on the last page
completely empty, the last page is deleted. This is
called automatic page deletion. This only
happens if the last page doesn’t contain any
additional objects.
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Force Page Break

You can force a page break in the default master
frame at any time by pressing Ctrl P (or by
pressing Enter on the keypad or choosing
Misc<Insert>New page). This inserts a new
page and forces the text after the caret to the top
of it.

The page break character may also be deleted,
causing text that follows to flow back onto the
previous page.

Moving Around Pages

Once you have a document with a number of
pages, you may use the following keys to move
around the pages.

flPage Up Start of previous page

MTPage Down Start of next page

~Page Up Start of first page in chapter
~Page Down  Start of last page in chapter
Home Start of first page in document
THome Start of last page in document

You can also move directly to any page using
PageGoto page (see 11.1).

Remember that the current page number is shown
on the info palette (see 2.7).

03 _Text

Document |
 Date | 5:09pm 14th March 1996
“size [ 719k Story size [ 1K
Words | 5793 Words instory | 501

Pagal W 'Tq_tlfalpgges| 19
_ Chapter | 1 Totalchapters [ 1

Fig. 3.3 - The document Info dialogue box.
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Document Info
Choose File“Info to display a dialogue box that
gives information about the document (fig. 3.3).

Document is the name of the document.

Date is the time and date stamp of the file. If the
document has not been saved, it is the time and
date the document was created.

Size is the size, in bytes, of the entire document
(in bytes).

Story size is the size of the text story containing
the caret (in bytes).

Words is the total number of words in the
document i.e. all stories.

Words in story is the number of words in the text
story containing the caret.

Page is the current page number i.e. the one in the
centre of the document window.

Total pages is the number of pages in the
document.

Chapter is the current chapter number.

Total chapters is the number of chapters in the
document.
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3.2 Inserting Special Characters

There are a number ways of inserting special

characters and control sequences into a document.

Insert Menu

The MiscwInsert menu allows a number of
special control characters to be inserted at the
caret (fig. 3.4).

Chapter number inserts the current chapter
number.

Page number inserts the current page number.
Date inserts the current date. The date format
may be set in Choices (see 14.4).

Active date inserts the current date which is
updated automatically each time the document is
loaded. The date format may be set in Choices
(see 14.4).

Time inserts the current time. The time format
may be set in Choices (see 14.4).

New page inserts a page break (see 3.7).

New line starts a new line, but not a new
paragraph (see 5.1).

Chapter number
Page number "N
Date "D
Active date

Time

New page P
New line TTReturn

Hard space

Hard hyphen

Soft hyphen  *-
Merge tag... MM

Fig. 3.4 - The Insert menu.
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Hard space inserts a non-breaking space. Words
separated by a hard space are never split between
lines and the space between them is not expanded
during justification.

A hard space can also be inserted from the
keyboard using Alt Space.

Hard hyphen inserts a non-breaking hyphen.
Words separated by a hard hyphen are never split
between lines (see 5.7).

A hard hyphen can also be inserted from the
keyboard using Alt -.

Soft hyphen inserts a soft hyphen that doesn’t
appear until it is needed to split the word at the
end of a line (see 5.7).

A soft hyphen can also be inserted from the
keyboard using Ctrt -.

Merge tag inserts a field for the mail merge
facility (see 12.5).
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Characters

Most fonts contain a wide range of special
characters that are not accessible directly from the
keyboard. You can easily obtain these using
Misc=Characters. This opens a dialogue box
displaying all the characters in the character set,
for the current font (fig. 3.5). Just click on a
character to insert it at the caret. Click on the
Close icon to close Characters.

You can change the font displayed, using the
options at the top of the dialogue box. This font is
used for the inserted characters only and any
typing afterwards will be in the original font i.e.
the one that was current before opening
Characters.

Notice that when choosing characters, the pointer
shows the ASCII code for each character. This is
useful if you wish to insert special characters
directly from the keyboard using the Alt key.

CHAPTER 3

Inserting Characters using Alt

You can type characters not normally accessible
from the keyboard by holding down Alt and
typing the ASCII code on the numeric keypad.
When Alt is released, the character is inserted at
the caret. So to type the bullet character «, hold
down Alt, type 143 on the keypad, and then
release Alt.

A full list of ASCII codes is given in Appendix B.

cdefghijklmn'op

™™ G| o

m:
o |

| Trinity *H| _|Bold _|Malic

(1] |nis|ol& [ [*]+].]-]- |1 |o|1|2]3]a]5]|6|7[8]9]:|: |<|
|@ A BCDE|FGH|IJ IK_L:M‘N'O_P"Q_R_SIT:U'V:WfJ(‘Y:Z_[ [\
“lalb

q|ris(tju|viw|x|ylz|{]|]

06000xOUUODY

213 1 p -] 0] [4]%

Fig. 3.5 - The Characters dialogue box.

o600 6|+|enadi

—_



Secrion 3.2

Single Shift Font (SSF)

This facility allows you to switch to another font
to insert a single character and then return to the
previous font. The default single shift font is
Selwyn which contains a range of symbols, but
you can choose another font (see 14.6).

Single shift font is accessed using the key F10.
Telephone @ (01727) 840303

To produce the line above, type Telephone
followed by a space, then press F10 and type &.
Then type another space followed by (01727)
840303. This works because in Selwyn font, &
appears as the ‘telephone’ character. '

You may also use the Alt key to insert characters
not normally accessible from the keyboard.

Jack of Diamonds 4

To produce the line above, type Jack of
Diamonds followed by a space, then press F10,
hold down Alt, type 169 on the keypad, and then
release Alt. This works because the diamond
character has ASCII code 169 in Selwyn font.

See Appendix B for a full list of characters in
Selwyn font.

Combining SSF and Characters

If you press F10 before opening Characters, the
font used in Characters will be set to the single
shift font.

INSERTING SpECIAL CHARACTERS
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3.3 Importing Text

Instead of typing in text, you may drag ASCII
text files directly from disc or from other
applications. The imported text is inserted at the
pointer position and takes the style of the
preceding text.

If you import text into a frame that is too small
and that frame isn’t linked, the text will overflow
(see 8.3).

You can also drag a text file to the Ovation Pro
icon on the icon bar causing a new default
document to be opened and the text file inserted
into it.

Stripping Return Pairs

If you hold down the Ctrl key when dragging in a
text file, single Return characters in it will be
converted to spaces and pairs of Return characters
will be converted to single Return characters.
This is useful when importing text from text
editors such as Edit which terminate each line
with a Return, since in Ovation Pro the line
breaks will not necessarily fall in the same places.
If Ctrl is not held down while importing text,
Return characters will be unaffected.

CHAPTER 3

Smart Quotes

When text is imported, plain single quotation
marks (') or double quotation marks (") enclosing
text are converted to fancy open and closing
single (**) or double (“"*) quotation marks
respectively. This gives a more professional
appearance to quotations and expressions such as
“fish ‘n’ chips™ and “rock ‘n’ roll”.

This facility is called ‘smart quotes’ and can be
disabled if required (see 14.6).

Importing Other Types of files

Please refer to the Ovation Pro release notes for
details of other formats that may be imported.

If you attempt to import a file that is not
supported, you will be asked to confirm whether
you wish to proceed (fig. 3.6). If you do proceed,
only the ASCII content of the file will be
imported.

want to proceed?

o |

YE—S'].

Inserted file is of type DOS not Text. Are you sure you

Fig. 3.6 - The text import warning box.
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3.4 Undo & Redo

Undo

EditUndo (fig. 3.7) cancels the last operation
performed, restoring your work to its previous
state. You can undo anything that changes a
document, such as deleting or editing text,
changing styles or manipulating objects. You
cannot undo things that just change the way a
document looks e.g. View menu options.

A special feature of Ovation Pro is that you can
undo more than one operation. The number of
undo operations that can be performed depends
upon the size of the undo buffer which can be
increased or decreased as required (see 14.4).

Undo is shaded if there is no further operation
that can be undone.

By default, the undo buffer is automatically
flushed before saving a document. This means
that after the document has been saved, you
cannot undo operations that were carried
before saving.

There are two reasons for automatically flushing
the undo buffer before saving a document:

e As you edit a document, deleted objects are
retained in memory so that they can be undone.
Flushing the undo buffer when the document is
saved, recovers the memory used by these
objects.

e It ensures that the saved document uses as little
disc space as possible.

Unpo & Rebo 27

Redo

Redo cancels the last undo operation performed.
The Redo option will be shaded if there is no
further operation that can be re-done i.e. the
document is up-to-date.

Note that if you edit a document after using undo,
the Redo function will not be available.

Min. Memory

Whilst the undo buffer is automatically flushed
when you save a document, you may need to
flush it manually if you run out of memory when
editing a document. You can do this using the
option Misc>Min. memory. This minimises the
memory used by a document by flushing the undo
buffer and recovering any memory used by
deleted objects.

Saving the Undo Buffer

You can use an option on Choices which causes
the undo buffer to be saved with documents
(see 14.4).



28 WoRrkING WiTH TEXT

3.5 Revert to Saved

File~Revert to saved restores the document to
the most recently saved version. A warning
prompt is displayed before proceeding (fig. 3.7).
Click on Discard to delete the current document
and reload the previously saved one, or on
Cancel to cancel the operation.

Revert to saved is shaded and unavailable if the
document has not changed since it was last saved
or if it has never been saved.

Ovation Pro

version?

Discard | Cancel |

Revert to previous version of file and discard this

Fig. 3.7 - The Revert to saved warning box.

CHarTER 3
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3.6 Selecting Text

Many operations are applied to a text selection.
The selection may be any amount of text from a
single character to an entire story.

There are a number of way to select text:

I. Click and hold down Select at the start of the
text to be selected, drag to the end of the text
and then release Select.

2. Click Select to position the caret at the start of
the text to be selected. Click Adjust at the end
of the text. Further clicks on Adjust can be
used to adjust the range of the selection at
either end.

3. Use one of the following short-cuts:
» Double-click on a word to select that word.
¢ Triple-click on a line to select that line.

» 4 clicks Select anywhere in a paragraph to
select that paragraph.

* 5 clicks Select anywhere in text to select the
entire story.

4. Choose Edit<Select all (fig. 3.7) to select all
the text in a story.

After any of these operations the selected text is
highlighted, i.e. inverted (normally white text on
a black background).

Note, it is not possible to have more than one
region of text selected at any time.
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Clearing a Selection
There are a number of ways to clear a selection:

« Click once anywhere in the document.

* Choose EditoClear (fig. 3.7).

 Select something else.

Overtyping

Note that if you type anything while text is

selected, the selection will be deleted and
replaced with the text typed.

This facility may be disabled on Choices
(see 14.6).
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3.7 Cut, Copy, Paste & Delete

The Cut, Copy and Paste options on the Edit
menu (fig. 3.7), are used to move or copy text
within the same document or to another
document.

They do this via a clipboard, which may be
viewed using the Clipboard option on the icon
bar menu (fig. 2.2). Text or pictures are displayed
on the clipboard in exactly the same format as
they appear in the document.

Please note that if there is no selected text, the
following options are used to manipulate other
selected objects, such as frames or pictures.

Cut text

Cut deletes the selected text and places it on the
clipboard. The previous contents of the clipboard
are overwritten by this operation.

Copy text

Copy copies the selected text onto the clipboard.
The previous contents of the clipboard are
overwritten by this operation.

Paste text

Paste inserts the text that is on the clipboard into
the document at the caret. Text can be pasted into
any Ovation Pro document, not just the one from
which it was cut or copied. After pasting, the
clipboard contents remain unchanged so you can
paste more than once.

Use Cut followed by Paste to move text.
Use Copy followed by Paste to copy text.

Delete text

Delete deletes the selected text. It does not place
the deleted text on the clipboard. This option is
only available if there is some text selected.

You may also delete selected text by pressing
Delete on the keyboard.

CHaPTER 3

Transferring Between Documents
Ovation Pro uses special rules to deal with
clashing style names when using cut, copy and
paste between documents.

The situation occurs when text containing a
defined style is transferred to another document
which contains a style of the same name, and that
style has a different definition. If this situation
occurs, by default Ovation Pro renames the style
in the transferred text. So if you edit BodyText
in one document and then transfer it to another
document containing BodyText, the transferred
style will be renamed BodyText01.

Alternatively, you may use an option on Choices,
that causes the clashing style name to be
discarded (see 14.6).

The above rules for clashing style names, also
apply to clashing colour names.

—~~\
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3.8 Drag & Drop

Instead of using Cut, Copy and Paste to move or
copy text via the clipboard, you can use the drag
and drop facility to do this directly.

To use drag and drop, first select the text you
wish to move or copy. Now press Alt and click
Select over the selection so that the drag and drop
tool is displayed (fig. 3.8). Now drag until the
pointer is over the required insertion point and
release Select to insert the text.

If you drag and drop within the same document,
the text is moved, if you drag and drop to another
document, the text is copied.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, the text is
copied; if you drag and drop to another document,
the text is moved.

If you drag and drop to something that isn’t an
Ovation Pro document, such as a directory
display or an Edit document, the text is exported

as plain ASCII text.

If you start a drag operation and wish to cancel it,
press Esc.

a

Fig. 3.8 - The drag and drop tool.
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Transferring Between Documents

The rules given earlier for dealing with clashing
style and colour names when using cut, copy and
paste, also apply to drag and drop (see 3.7).
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3.9 Find & Replace

Edit>Find opens a dialogue box which allows
you to search a story or document for a string,
and optionally replace the found string with
another string (fig. 3.9).

If there is no selected text, the search starts at the
caret and continues to the end of the story. If
there is a selection, only the selection is searched.

The options in the Find dialogue box are
described below.

Find

Type in the string that you want to search for.
Pressing Return in this field will place the caret in
the Replace with field below.

Replace with

Type in the replacement string that will be
substituted for the the search string when it is
found. Leave this field blank if you do not want
to replace the search string or if you want to
delete the search string. Pressing Return in this
field will start the search i.e. it is equivalent to
clicking on Go.

CHaPTER 3

Case Sensitive

If Case sensitive is not selected, the search will
match all occurrences of the search string, making
no distinction between upper and lower case
characters. So searching for Abc will match with
abc, Abc and ABC etc. The replace string will
match the uppercase/lowercase format of the
found string. So replacing with pgr in the
example above gives par, Pgr and PQR.

If Case sensitive is selected, the search will only
match occurrences of the search string with
exactly the same uppercase/lowercase format. So
searching for Abc will only match with Abc and
not abc or ABC. The replace string is substituted
unchanged.

Whole Word

If Whole word is not selected, the search will
match occurrences of the search string even if
bounded by other letters and numbers. So
searching for her would match with there and
other.

If Whole word is selected, the search will only
match occurrences of the search string that are not
bounded by other letters and numbers. So
searching for her would match with her and
(her), but not with there and other.

__|Find from start | Wildcards

Find
. Find | l |
Replace with | ]
__|Case sensitive __|Wholeword | All stories

[ Notfound Cancel | Count | Previous || Go |

Fig. 3.9 - The Find dialogue box.

—
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All Stories

If All stories is not selected, the search starts at
the caret and continues to the end of the story. If
there is a selection, only the selection is searched.

If All stories is selected, the search starts at the
beginning of the document and continues through
each story until the end of the document.

Find From Start
If Find from start is not selected, the search
starts at the caret.

If Find from start is selected, the search starts
from the beginning of the current story rather than
the caret position or start of the marked area. It is
useful if you wish to search an entire story but
have forgotten to, or do not wish to move the
caret to the start of the story.

Find from start does not apply if you have a
selection or if All stories is selected.

Count

Click on Count to count all the occurrences of
the search string. The number counted is
displayed in the icon to the left of the Cancel
option.

Previous

When you open the Find dialogue box, clicking
on Previous updates the the search and replace
strings with those used in the last Find operation.

Text found |
Coninve |  Replace |
Endoffilerepiace |

| Found

Fig. 3.10 - The Found dialogue box.
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Go

Click on Go to start the search. If the search
string cannot be found, the message Not found
is displayed in the Find dialogue box. Click on
Cancel to close the dialogue box.

When the first occurrence of the search string is
found, the Text found dialogue box is displayed
(fig. 3.10), indicating the operations available.
The found string is selected in the document.

Click on Continue to find the next occurrence of
the search string.

Click on Replace, to replace the search string
with the replace string, and continue to the next
occurrence. If the replace string is blank, the
found string will be deleted.

Click on End of file replace to find and replace
all occurrences of the search string without
stopping for further instructions.

Click on Stop to abandon the search.

If the search string cannot be found, the message
Not found is displayed. Click on Stop to close
the dialogue box.
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Wildcards

Click on Wildcards to display the extended Find
dialogue box (fig. 3.11). In this mode you can
introduce wildcards or special characters into the
search string (and in one case, into the replace
string).

To insert a wildcard, position the caret correctly
in the search string and then click on the required
wildcard icon. The escape sequence for that
wildcard is inserted into the string. If you wish
you may type the wildcard escape sequence
directly into the string.

In the following table, the escape sequence is
shown first, followed by the icon name, followed
by a description of the wildcard function.

\d

\a

\ *
\&

\
VL
\p

\t
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Any char matches any single character.
Any digit matches any single digit 0 to 9.

Any alpha matches any single alphanumeric
character. AtoZ,atoz,0to 9 and _.

Any string matches any string of characters.

Found refers to the string found and is used
in the replace string. For example, if you
search for ¢\ . t, putting \ &s in the replace
string will replace cat, cot and cut with
cats, cots and cuts.

\\ =\ matches the \ character.
New line matches the new line character.

New para matches the new paragraph
character i.e. Return character.

Tab matches the tab character.

Find
Find | l |
Replace with | |
__|case sensiive ~__|[Wholeword | All stories
__|Find from start [/ Wildcards
\Anychar | \dAnydigit | \aAnyalpha
\* Any string | \& Found W=\
\l New line ‘\n New para \t Tab

[T canon| Ooum]Pmious” Go |

Fig. 3.11 - The extended Find dialogue box with wildcards.
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3.10 Saving Documents

Before selecting the Save option, you must open
a directory display for the the directory into
which the file is to be saved.

To save the document choose File>Save. A box
appears containing an icon, the document name,
and an OK box (fig. 3.12). If the document,
hasn’t been saved before, a default name will be
supplied e.g. Document1, Document2, etc. If
you want to change the name, edit it in the usual
way.

Ensure that the option Ovation Pro is selected,
and drag the icon to the required directory display
to save the file. An icon representing the file
appears in the directory display to confirm that
the file has been saved and the name of the file is
updated in the document window title bar.

You may also save documents in DDL (document
description language) format by choosing DDL
before saving (see Appendix I).

If a document has already been saved and has a
full pathname assigned to it, it can be resaved
with the same filename by clicking on OK or by
clicking on File~Save.

S&V@&S_

[oocument] o]
@ OvationPro
g

Fig. 3.12 - The Save dialogue box.
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Saving Text Stories
In addition to saving entire documents, you may
just save text stories.

To save a text story, position the caret in the
story, and choose File<>Save story. Now use the
standard save box to save the story as a plain
ASCII file. You may also save the story in DDL
format by choosing DDL before saving

(see Appendix J).

To save selected text, select the text required then
choose Filew>Save selection. Now save the file in
the usual way.
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3.11 Basic Printing

Before you can print, you must load a printer
driver suitable for your printer. Ensure that the
printer driver has been configured correctly, such
as resolution and number of colours.

Choose File~Print or press Print to display the
Print dialogue box (fig. 3.13). The name of the
current printer driver is displayed in the title bar.
A brief description of the options on the Print
dialogue box is given below, but more detailed

information is given later in this user guide
(see 12.2).

Copies
Copies is the number of copies of each page that
you want to print.

Format
Format should be set to Normal.

All Pages
All pages prints all pages in the document.

From allows you to print the range of pages
specified in the two writable fields.

All Sides
All sides prints both left and right hand pages.

Left and Right allow you just to print one side of
the document. This is useful if you want to print a
double-sided document by printing one side then
turning the paper over and printing the other.

CHaPTER 3

Pause

If Pause is selected, Ovation Pro will pause
between each page printed until you click on
Continue on the Printing dialogue box (see
overleaf).

Reverse

If Reverse is selected, the order of printing is
reversed.

Collate

If Collate is not selected, Ovation Pro prints
multiple copies of each page. so pages are printed
in the order 1,1,1,2,2,2, 3,3,3.

If Collate is selected when printing multiple
copies, Ovation Pro prints multiple copies of the
document, so pages are printed in the order 1,2,3,
.23 1.2.3.

No Pictures

If No pictures is selected, Ovation Pro will
ignore pictures and just print text. Only the
picture frame guideline is printed. On some
printers printing pictures is very slow, so this
option may be useful for quickly printing draft
copies.

Print Setup

Print setup extends the Print dialogue box to
provide further advanced printing options
(see 12.3).

Print (No Driver Installed)
Copies Format | Normal |
(@ All pages ) From 1 to
@ All sides U Left ) Right
__|Pause __|Reverse __|Coliate
__|No pictures
__|Print setup Set | Cancel || Print |

Fig. 3.13 - The Print dialogue box.
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Set

Click on Set to set the options in the Print
dialogue box, without actually printing the
document. These options will be saved with the
document when it is saved.

Print

Click on Print to print the document. The pointer
changes to an hourglass and the Printing
dialogue box is displayed (fig 3.14). It shows the
Page and Copy being printed.

The green slider gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Click on Cancel to terminate printing. Please note
that only a limited amount of multi-tasking is
possible when printing i.e. when the hourglass
occasionally turns back to the standard pointer.
So there may be a delay before Cancel takes
effect. Usually it is quicker to press Escape
instead.

Click on Pause to pause printing. Again, there
may be a delay before Pause takes effect. When
paused, the Pause option changes to Continue
which you should click on to continue printing.

Please note that by default Ovation Pro does not
perform background printing, but this may be
enabled if required (see 12.4).

Fig. 3.14 - The Printing dialogue box.

Basic PrINTING
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3.12 Closing Documents & Quitting

When you have finished working on a document,
close it by clicking on the close icon of the
document window. If the document has been
modified since it was last saved, a warning will
be displayed (fig. 3.15). Click on Save to save the
document before closing it; click on Discard to
close the document losing the latest changes;
click on Cancel to cancel the close operation and
retain the document in memory.

If you have finished using Ovation Pro, you can
remove the program from the computer’s memory
by choosing Quit on the icon bar menu (fig. 2.2).
Again, you will be warned if your document has
been modified since it was last saved (fig. 3.16).
Click on Discard to quit Ovation Pro losing the
latest changes made to any modified documents,
or click on Cancel to cancel the quit operation.

This document has been modified?

Discard| Canoeil | Save I

Fig. 3.15 - Confirm box when closing a modified document.

Discard | | : Cancel |

Fig. 3.16 - Confirm box when quitting Ovation Pro.

CHAPTER 3
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This chapter describes how to add a wide range of local style effects to
your text. These are applied directly to a selection or at the caret. They
provide the easiest and most direct way of adding style to a document.

Local format effects such as tab, indent and alignment which affect whole
paragraphs are described in Chapter 5.

Local effects are normally used when you wish to make a simple change to
a document, such as making a word bold. If you are producing a short or
simple document, then it is practical to use combinations of effects; if you
want to change them, it is reasonably quick in a short document.

In long or complex documents you should use defined styles described in
Chapter 6. These allow style and format effects to be combined together in
a named style and applied in a single operation. Defined styles can easily
be modified at a later stage, automatically updating all occurrences in the
document.
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4.1 Applying Effects

Local effects are used to change the appearance
of text in the document. Most effects may be
combined, so for example, you can have text in a
larger size that is bold and underlined.

The options Font, Size, Effect and Colour on the
Text menu (fig. 4.1) provide the basic effects that
may be applied. The Modify text dialogue box
provides all the basic effects plus a range of
advanced effects, all from a single dialogue box.

Changing Existing Text

You can apply an effect to any amount of text
from a single character to an entire story. To do
this, select the text required (see 3.6), and then
choose the required effect from the appropriate
menu or dialogue box.

Applying Style Effects as you Type

As you are typing, you can choose the required
effect from the appropriate menu or dialogue box,
and then continue typing. Any text subsequently
typed at the caret will use that effect. However, if
you move the caret before typing any text, the
effect will be removed.

Modify text... F6
Font [
Size >
Effect [
Colour...

Format.. AE
Alignment ™~
Leading P
Tabs... “Tab

Fig. 4.1 - The Text menu.
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Moving the Caret

If you move the caret into another part of the
document, any characters typed will be displayed
in the style that was current for the text
immediately before the new caret position.

Clearing Effects

You can clear all locals effects from the current
selection by choosing the option
Style>Remove~ Local effects (fig. 4.2).

Local effects”L

Fig. 4.2 - Use Local effects to remove effects.
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4.2 Changing Font

To change text to a new font, select the text or
position the caret as required, then choose the
new font from the Font menu (fig. 4.3). The font
menu is available from either the Text menu

(fig. 4.1) or the info palette (fig. 4.4). Applying a
font in this way, overwrites any other font already
present.

Current Font

If there is no selection, the font that is current at
the caret is ticked on the Font menu and indicated
on the info palette.

If there is a selection, the font that is present
throughout the entire selection is ticked on the
Font menu and indicated on the info palette. If
there is no tick on the menu and no font name on
the info palette, it means that there is more than
one font present in the selection.

CHANGING Font 41

Current font  Font menu

Textframe  X|1omm | w[190mm Trini ﬁ“ 2ot g
1.1 Y |10m H|277 U
Hamertnn - e !_I_UMB I LR EL
Fig. 4.3 - Top of Fig. 4.4 - The info pafeﬂe dfspfays the current font and pmv:des a Font menu for

ihe Font maris, choosing a new font.
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4.3 Changing Size Units

The default units for type size are points (pt). In
computer terms, 1pt equals 1/72 of an inch. The
table below gives metric and imperial equivalents
for the standard type sizes.

To change the size of text, select the text or
position the caret as required, then choose the size
required from the Size menu (fig. 4.5). The Size
menu is available from either the Text menu

(fig. 4.1) or the info palette (fig. 4.6). pt mm in
Standard Sizes 8 2.82 0.11
The Size menu offers a range of standard sizes, 1 3'23 014
shown below at actual size. 12 423 0.17
14 4.94 0.19
8 point 18 6.35 0.25
10 point 24 8.47 0.33
12 point 36 12.71 0.50
14 point
18 point
24 point
36 point
Size
8pt
10pt
v 12pt Current type size  Size menu
14pt
18pt
24pt '
36pt Textirame  X[tomm |w[190mm | | Trinity B[ 12t
1.1 Y|10mm | H|277mm mﬂﬂg l| 3] |§:§-

Fig. 4.5 - The Size Fig. 4.6 - The info palette displays the current type size and provides a Size menu
menu. for changing to a new size.
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Other Sizes

The last entry on the Size menu allows you to
enter any size between Ipt and 1000pt. The
default unit is points, but if you wish you may
specify another unit e.g. Smm or 0.25in. In this
case the value will be converted to points next
time the menu is displayed.

Sizes may be specified to two decimal places.
However, the font manager has a maximum
resolution of 1/16pt, so the type size plotted may
be rounded up slightly.

Current Size

If there is no selection, the type size that is -
current at the caret is ticked on the Size menu and
indicated on the info palette.

If there is a selection, the type size that is present
throughout the entire selection is ticked on the
Size menu and indicated on the info palette. If
there is no tick on the menu and no size given on
the info palette, it means that there is more than
one size present in the selection.

CHANGING Size
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4.4 Miscellaneous Effects

The Text<Effect menu (fig. 4.7) provides the
effects that may be applied to selected text or at
the caret. Effects may also be chosen by clicking
on icons on the info palette (fig. 4.8).

Please note that applying effects toggles them on
and off. For example, if you apply Bold to some
normal text, the text will change to bold as
expected. However, if you apply Bold to some
text that is already bold, the bold effect will be
cancelled and the text changed to normal.

Normally the Effect menu closes after choosing
an effect, which is inconvenient if you wish to
choose a number of effects in one operation. If
you choose effects by clicking Adjust instead of
Select, the Effect menu will remain open. To
close the menu, click Select on the last effect you
require.

v Norma AN
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Normal
Normal de-selects other effects such as Bold,
Italic etc.

This is normal text

Bold

Bold selects the bold variant of the current font. It
is useful for highlighting words. Bold can only be
used if there is a bold version of the current font
available.

Example of bold text

Italic

Italic selects the italic variant of the current font.
It is useful for emphasizing words. Italic can only
be used if there is a italic version of the current
font available.

Example of italicised text
Underline

This effect underlines all characters including
spaces and punctuation characters.

Example of underlined text

Advanced underline effects may be specified on
the Modify text dialogue box.

Bold B | Textframe  X|10mm

Italic A | 1.1 Y| 10mm

Underline MU
Reverse AV
Superscript* fi=
Subscript  Af-
Fig. 4.7 - The Effect

menu or fo the caret.

Underline

Fig. 4.8 - The info palette allows a range of effects to be applied to the selected text

TN



Section 4.4

Reverse

Reverse swaps the text foreground and
background colours. By default this produces
white text on a black background.

Example of {SUSEEY text
Superscript
This effect produces superscript text.

Example of superscript text
The size of the superscript may be specified in
MiscoPreferences (see 14.12).
Subscript
This effect produces subscript text.

Example of subscript text

The size of the subscript may be specified in
MiscoPreferences (see 14.12).
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Current Effect

If there is no selection, any effects that are current
at the cdret are ticked on the Effect menu and
indicated (in orange) on the info palette.

If there is a selection, any effects that are present
throughout the entire selection are ticked on the
Effect menu and indicated on the info palette. If
an effect is not ticked on the menu and not
indicated in orange on the info palette, it means
that it is not present throughout the selection.
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4.5 Text Colour

The Text<Colour opens a dialogue box (fig. 4.9)
which allows you to change the colour of text.
Colour can be applied to a selection or at the caret
if there is no selection.

The scrollable window lists all the colours
available. A sample of each colour is given,
followed by its name. You can add your own
colours to the list using Misc~Edit colours
(see 15.2).

Click Select on a colour to choose it. The two
coloured squares at the bottom of the dialogue
box show the chosen colour and the previous
colour i.e. the one that was current before the
dialogue box was opened.

Click on OK to apply the colour to the text.

Alternatively double-click on a colour to select it
and apply the colour in one operation.

Please note that the procedure described above
for selecting a text colour, is the standard system
of selecting colours throughout Ovation Pro.

CHAPTER 4

Tints

If you do not specify a tint, the chosen colour is
applied exactly as shown in the sample. This is
referred to as a solid colour and has 100% tint.
You can apply a tint of the solid colour by
choosing a percentage from the tint menu or by
entering an integer between 0 and 100 in the
writable field at the bottom of the menu.
Alternatively, use the up and down buttons to
change the tint value one percent at a time.

A Colour picker

[l Black
[ Jwhite
Transparent

Bl Red

i Blue
B Cyan
[l Magenta
[]Yellow

S

Current colour—T

Previous colour —

Tint {100 % /_\ *BK

ik

= 10

20

30

40

50

60

70

80

90

v 100

I—— N Tio

Cancol I OK | inr menu

Fig. 4.9 - The standard Ovation Pro colour picker.
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4.6 Advanced Text Effects

The Text>Modify text dialogue box (fig. 4.10)
provides a wide range of advanced text effects
that may be applied to a selection or at the caret.

Current Text Effects

The Modify text dialogue box reflects all the
settings that are current at the caret or throughout
a selection.

If any effects are not present throughout a
selection, they are indicated on the Modify text
dialogue box as follows:

1. If the effect is set by a value in an icon, that
icon will be blanked out.

2. If the effect is set by a button, the button will
be indicated with a cross.

For example, the dialogue box shown in fig 4.10
shows the effects present in a selection. Since
Size and H scale are blank, it means that they are
not present throughout the selection.

The same is true for Bold which is indicated with
a ‘crossed’ button. Blank buttons such as that for
Italic, indicate that the effect is switched off
throughout the selection. Ticked buttons such as
Underline, indicate that the effect is switched on
throughout the selection.
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Font
Changes the font of the text (see 4.2).

Size

Changes the size of the text (see 4.3).
Case

This provides a menu with three options for
specifying the case of the text:

Normal displays text in the case in which it was
typed or imported.

Title changes the first letter of each word to
upper case and the rest to lower case. Any
individual characters are changed to upper case.

This Text Is In Title Style.
All caps changes all letters to upper case.
THIS TEXT IS IN ALL CAPS.
Foregrnd

Changes the colour of the text using the colour
picker (see 4.5).

Modtfv text

"] Hicale

- roregm I 5
MWGW 8
~ [<Bod _|mnc
_lslparmr;)t __|Suhsmpl q_|Strﬂcaout
_|Smallcaps _|navma T

|" Underiine - *E]

5

g

| emfa]

Fig. 4.10 - The Modify text dialogue box.
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Backgrnd

Changes the background colour of the text using
the colour picker. The default background colour
is transparent (see 4.5).

H scale

Horizontal scale allows you to compress or
expand text horizontally. You can scale text from
10% to 1000% of the normal unscaled width
without changing the text height.

75% horizontal scaling
100% horizontal scaling
125% horizontal scaling

The default horizontal scale is 100%.

Kern

If there is no selection, the Kern option becomes
available. If there is a selection, Kern changes to
Track (see below).

Kerning moves the characters on either side of the
caret further apart or closer together. Characters
are moved apart using positive kerning values or
closer together using negative values. Kerning is
normally used to improve the appearance of
certain letter pairs such as AV and WA which
look better if they are moved closer together. In
the examples below the first pair of letters are
spaced normally (zero kerning), while the second
pair have a kerning value of -200.

AV AV

Kerning values are specified in units of .001 of an
em space and can be any integer value between
-1000 and 1000. In Ovation Pro, an em space is
defined as the current point size.

Please note that the latest outline fonts
incorporate auto-kerning which automatically
improves the appearance of some letter pairs
(see 5.4). However, you may wish to use the
Kern option for fine tuning.

CHarTER 4

Track

If there is a selection, the Track option becomes
available. If there is no selection, Track changes
to Kern (see above).

Tracking is identical to kerning described above,
but is applied to selected text rather than letter
pairs. Negative tracking is useful for fitting text
onto lines, although if your text is justified you
may obtain better results using enhanced
justification (see 5.7). Positive tracking can give
attractive results for titles and headings.

Text tracked -100
Text tracked 0
Text tracked 250

V shift
This effect shifts text vertically above or below
the baseline. V shift is expressed as a percentage
of the type size. A positive value shifts the text up
and a negative value shifts the text down.
shift
Vertical 100%
Vertical shift -50%

Rotate

This effect rotates characters about their centres,
to the angle specified. A positive value rotates
text anti-clockwise, and a negative value rotates
text clockwise. The best results are obtained with
upper case text.

TEXT RO ATED TO 20°
TEXT ROTA TEDTO -20°
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Skew
This effect skews text to the angle specified. A
positive value skews the text to the right and a
negative value, to the left. The angle is specified
in degrees and must be within the range -80° to
80°.

Text skewed 20°

Text skewed -20°

Bold
Bold selects the bold variant of the current font
(see 4.4).

Example of bold text

Italic

Italic selects the italic variant of the current font
(see 4.4).

Example of italicised text
Superscript
This effect produces superscript text (see 4.4).
Example of superseript text

Subscript
This effect produces subscript text (see 4.4).

Example of subscript text

4.11 - The Underline specification dialogue box.
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Underline

This effect underlines text. Click on the icon to
the right of the Underline option to display the
Underline specification dialogue box (fig. 4.11).

Word underline underlines all characters except
spaces.

Double underline underlines with a double line.

Example of underlined text

Text word underlined

Double underlining
Width opens a menu allowing you to specify the
width of the underlining (fig. 4.12). The width is
specified as a percentage of the type size of the
first character on the line. Thin is 2%, Medium is
4% and Thick is 8%. The last entry on the Width
menu allows you to specify a width in the range
of 1% to 50%.

Colour allows you to specify the underline colour
using the standard Ovation Pro colour picker.
The default colour is Transparent, which has a
special significance when used for underlining. It
causes the underline colour to be the same colour
as the text being underlined. This means that if
the text colour is changed, the underline colour
will change to match.

4.12 - The Width menu.
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Strikeout
This effect draws a line centrally through the text.

Example of text with strikeout.

Click on the icon to the right of the Strikeout
option to display the Strikeout specification
dialogue box (fig. 4.13). Width and Colour
options are the same as for underline above.

Small caps

This effect changes all lower case letter to small
capitals. The default size is 75% of normal
capitals, but this can be changed in
MiscoPreferences (see 14.12).

ExampLE oF SMaLL Caps

Reverse

Reverse swaps the text foreground and
background colours (see 4.4).

Example of text

Canoei|| oK |

4.13 - The Strikeout specification dialogue box.

CHAPTER 4
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This chapter describes how to format paragraphs using local format
effects. These are applied directly to an individual paragraph or selection
of paragraphs and take effect immediately.

Local effects are normally used when you wish to make a simple change to
a document, such as justifying a paragraph. If you are producing a short
or simple document then it is practical to use combinations of local effects,
since if you want fo change them, it is reasonably quick to do so in a short
document.

In long or complex documents you should use defined styles described in
Chapter 6. These allow style and format effects to be combined together in
a named style and applied in a single operation. Defined styles may easily
be modified at a later stage, automatically updating all occurrences in the
document.
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5.1 Applying Format Effects

Local format effects are used to change the
format of paragraphs of text. Alignment and
Leading on the Text menu (fig.5.1) provide the
basic format effects. The Format dialogue box
provides the complete range of text formatting
effects.

Tabs opens the tab ruler and allows tab stops and
indents to be set.

Format effects can only be applied to whole
paragraphs. A paragraph is defined as being the
text between two Return characters, so it may be

a single line heading or a multiple line paragraph.

If you want to start a new line within the same
paragraph choose Misc~Insert<>New line or
press Shift Return.

Changing a Single Paragraph

To change the format of a single paragraph,
position the caret in the paragraph and choose the
required effect from the appropriate menu or
dialogue box.

Changing Multiple Paragraphs

If you select a number of paragraphs, formatting
will affect all paragraphs wholly or partially
selected.

R L
Modify text...F6
Font >
Size P
Effect P
Colour..

Format.. *F
Alignment P
Leading P>
Tabs... “Tab

Fig. 5.1 - The Text menu.
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Copying Format Effects

You can copy the format attributes from one
paragraph to another. To do this, place the caret in
the destination paragraph (or select a range of
paragraphs), then hold down Shift and click
Adjust in the source paragraph. This facility does
not copy text effects such as bold and italic.

Clearing Effects

You can clear all local format effects from the
caret or from a selected region by choosing
StyleRemove= Local effect (fig. 5.2).

Joining Paragraphs

If you join two paragraphs by deleting the
carriage return between them, the new paragraph
produced will have the format attributes of the
first paragraph.

Local effects L

Fig. 5.2 - Use Local effects to remove effects.
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5.2 Alignment

To align selected paragraphs choose the
alignment you require from the Alignment menu
(fig. 5.3) or from the info palette (fig. 5.4).

Left
Left aligns paragraphs to the left margin, leaving
the right edge ragged. This is the default state. It
is also referred to as ‘flush left’, ‘ranged left’ or
‘ragged right’.

Left aligns paragraphs to the left margin, leaving the

right edge ragged. It is also referred to as ‘flush left’,
‘ranged left’ or ‘ragged right’.

Centre

Centre aligns paragraphs centrally between the
left and right indents, leaving both left and right
margins ragged.

Centre aligns paragraphs between the left and right
margins, leaving both margins ragged.

Right

Right aligns paragraphs to the right indent,

leaving the left edge ragged, It is also referred to

as ‘flush right’, ‘ranged right’ or ‘ragged left’.
Right aligns paragraphs to the right indent, leaving

the left edge ragged, It is also referred to as ‘flush
right’, ‘ranged right’ or ‘ragged left’.
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Justify
Justify aligns paragraphs so that both left and
right edges are aligned to the margins. It does this
by inserting extra space between the words on
each line.
Justify aligns paragraphs so that both left and right
edges are aligned to the margins. It does this by
inserting extra space between the words on each
line.
By default Ovation Pro uses the RISC OS font
manager to justify text by inserting extra space
between the words only. However it is possible to
achieve greater control over justification by extra
inserting space between letters. This feature is
called letter spacing (see 5.7).

Current Alignment

The alignment that is current at the caret or
throughout a selection is ticked on the Alignment
menu and indicated in orange on the info palette.

If there is more than one alignment setting in a
selection, there will be no tick on the menu and
no alignment indicated on the info palette.

u Text frame x 10mm

[—

1.1 ¥|10mm

Fig. 5.3 - The
Alignment menu.

Fig. 5.4 - The info palette allows you to align or justify paragraphs.
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5.3 Leading

The Leading menu (fig. 5.5) allows you to set the
vertical spacing between lines of text.

Single space is the default leading and should be
suitable for most purposes. It is equivalent to 20%
relative leading (see overleaf).
Single space is the default leading and should be
suitable for most purposes. It is equivalent to 20%
relative leading (see overleaf).
Double space gives increased line spacing and is
equivalent to 120% relative leading.

Double space gives increased line spacing and is

equivalent to 120% relative leading.

The writable field at the bottom of the menu
allows you to specify other values, using one of
the three methods described below: absolute,
relative or incremental leading.

Please note that the default units for absolute and
incremental leading are points, but you may
‘'specify another unit after the value e.g. Smm.

v Single space
Double space

Fig. 5.5 - The Leading menu.
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Absolute Leading

This is the distance between the top of the
bounding boxes for the each line of type (fig. 5.6).

The example below uses 14pt absolute leading.
Notice that the line spacing is equal throughout
the paragraph, regardless of the type sizes
present. It is important that the value specified is
large enough to accommodate the biggest type
size otherwise lines will overlap.

This example uses 14pt absolute leading. Notice that

the line SpaCiﬂg is equal throughout the

paragraph, regardless of the type sizes present.

Absolute leading is useful if you wish to align
text with other objects, such as lines. In the
example below, the lines have been duplicated at
Smm vertical offsets and the text is set to Smm
absolute leading.

Absolute leading is useful if you wish to align text

with other objects, such as lines. In this example the

lines have been duplicated at Smm vertical offsets

and the text is set to Smm absolute leading.

You may see type described as ‘12 set on 14° or
12/14. This means 12pt text with 14pt absolute
leading.

Op -
|

gR

Fig. 5.6 - Absolute leading.

——
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Relative Leading

This is specified as a percentage of the current
type size. For example, if the type size is 36pt and
the leading is 20%, the line spacing is 36pt + 20%
of 36pt (fig. 5.7).

To use relative leading you must add a % to the
value e.g. 15%.

Relative leading is the default type of leading
because it produces well proportioned line
spacing that is relative to the type size being used.
In the example below, the line spacing is
increased to accommodate the larger type on the
third line.

This example paragraph uses 20% relative leading.

Relative leading is popular because it produces well

proportioned line Spacing that is relative to the
type size being used.

O

43.2pt (36pt + 20% of 36pt)

gR

Fig. 5.7 - Relative leading.

LeapinG 9

Incremental Leading

This is specified as a value to be added to, or
subtracted from, the current type size. For
example, if the type size is 36pt and the leading is
+5pt, the line spacing is 36pt + 5pt (fig. 5.8).

To use incremental leading you must prefix the
value witha + or - e.g. +5pt or -2pt.

The example below uses +5pt incremental
leading. Notice that the gap between the lines is
equal throughout the paragraph, irrespective of
the type size.

A positive value specifies the gap between the lines.

This example uses +5pt incremental leading.
Notice that the gap between the lines is equal
throughout the paragraph, regardless of the type size.

Negative incremental leading closes the gap
between lines and can cause them to overlap. The
example below uses 12pt and 24pt text with -12pt
incremental leading.

effects
Special
Current Leading
The leading that is current at the caret or

throughout a selection is ticked on the Leading
menu.

If there is more than one leading value in a
selection, there will be no tick on the menu.

O

41pt (36pt + Spt)

gR

Fig. 5.8 - Incremental leading.




56 FormatTiNG TEXT

5.4 The Format Dialogue Box

The Format dialogue box (fig. 5.9) provides all
the formatting options that may be applied to the
current paragraph or a selection of paragraphs.

Please note that the indent options on this
dialogue box may also be specified on the tab
ruler (see 5.5).

Current Format Options

The Format dialogue box reflects all the settings
that are current at the caret or throughout a
selection.

If any effects are not present throughout a
selection of paragraphs, they are indicated on the
Format dialogue box as follows:

1. If the effect is set by a value in an icon, that
icon will be blanked out.

2. If the effect is set by a button, the button will
be indicated with a cross.

CHAPTER 5

For example, the Format dialogue box shown in
fig 5.9 shows the formatting effects present in a
selection. Since Space before and Alignment are
blank, it means that they are not consistent
throughout the selection.

The same is true for Auto hyphenation which is
indicated with a ‘crossed’ button. Blank buttons
such as that for Drop capital, indicate that the
effect is switched off throughout the selection.
Ticked buttons such as Auto kerning, indicate
that the effect is switched on throughout the
selection.

|7Ai:to kerning

b

_[Locktogrid REPE s

it

_Joopesp [3] [ Auohyphenation
- _|Enhanced justification - *E]|

|

Gamai” OK |:_

Fig. 5.9 - The Format dialogue box.

=N
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Left Indent

Left indent defines the left margin of the current
paragraph or selected paragraphs. It may be used

to distinguish paragraphs from surrounding text.

The left indent is measured from the left-hand

frame inset (fig. 5.10), or from the standoff of any

obstructing frames (fig. 5.11).

If the left indent value is preceded by the +

symbol, the indent is measured from the left edge

of the frame bounding box (fig.

5.12), ignoring

any obstructing frames (fig. 5.13).

Theme-
chanical
/ typewriter, which
m originated in the

"II

m

THe Formar Dialocue Box

-1
= e
o .

£1

_,".mechanical
/  typewriter, which

! originated in the
@ USA about a century

b

USA about a centu- |
1y ago, represent- /

ed the first
ma-

] an -

Fig. 5.10 - The left indent is meas
hand frame inset.

el )

vred from the left-

The|mechanical
typewriter, which
originated in the
USA about a
m century ago,
represented the
first major advance
over pen or pencil.
Its two principal ad-

1}

L =) I.’_'I

Fig. 5.11 - The left indent is measured from the left-
hand frame inset or from the standoff of any

obstructing frames.

ago, represented the |

first major advance /
" over pen or Vi

~_pencil.lIts "

i —a— [
Fig. 5.12 - If the left indent has a + prefix, the
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indent is measured from the left edge of the frame

bounding box.
r, =)
The mechanical
typewriter, which
originated in the
USA about a century

m ago, represented the [
first major advance
over pen or pencil.
Its two principal ad-
vantages were that a
& =)

Fig. 5.13 - If the left indent has a + prefix, the

indent is measured from the left edge of the frame

bounding box ignoring obstructing frames.
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Right Indent

Right indent defines the right margin of the
current paragraph or selected paragraphs. It may
be used to distinguish paragraphs from
surrounding text.

The right indent is measured from the right-hand
frame inset (fig. 5.14), or from the standoff of any
obstructing frames (fig. 5.15).

If the right indent value is preceded by the +
symbol, the indent is measured from the right
edge of the frame bounding box (fig. 5.16),
ignoring any obstructing frames (fig. 5.17).

If the right indent value is preceded by the -
symbol, the indent is measured from the left-hand
inset or edge instead.

F; e )
/ .The[ me-
/ chanical type-

/ writer, which orig-
minated in the USA H]
labout a century |
' ago, represented
\, the first ma-
S

D S : i 5 %

Fig. 5.14 - The right indent is measured from the
right-hand frame inset.

FThe[ mechanical
typewriter,  which
originated in the

USA about a T
[rentury ago, [ [j
represented the (I
first major advance

over pen or pencil.
Its two principal ad-

3 g i

Fig. 5.15 - The right indent is measured from the
rfghl‘-hand frame inset or from the standoff of any
obstructing frames.
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) — g
| = The] 2 &1

/" mechanical
/ type-writer, which
'originated in the \
USA about a century m
| ago, represented the
' first major advance
‘., over pen or

- pencil. Its

i g—" Kb

Fig. 5.16 - If the right indent has a + prefix, the

indent is measured from the right edge of the frame
bounding box.
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The| mechanical
typewriter,  which
originated in the
USA about a century =1
ago, represented the| @ J
fist major advancel [
over pen or pencil.
Its two principal ad-
vantages were that a

sl [
=]

Fig. 5.17 - If the right indent has a + prefix, the
indent is measured from the right edge of the frame
bounding box ignoring obstructing frames.
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1st Indent

This is the first line indent and defines the left
margin for the first line of the paragraph only.
First line indent is specified as an offset from the
normal left indent.

If the 1st indent is given a positive value, then the
first line of the paragraph will be indented from
the left indent by that amount (fig. 5.18). When
used in this way, the first line indent is often
called the paragraph indent.

Another use of the first line indent is to create a
hanging indent. This is where the first line indent
is positioned to the left of the left indent

(fig. 5.19). The example shown has a left indent
of 10mm and first line indent of -10mm. The
number on the first line of each paragraph starts
at the first line indent. A tab after the bullet forces
subsequent text on the first line to start at the left
indent. All subsequent lines start at the left indent.

When using hanging indents, if you want to start
anew line at the left indent, you should use
Misc=Insert>New line. If you use Return, a new
paragraph will be inserted and typing will
commence at the 1st indent.

=

The|mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first majory
advance over pen or
pencil.

Its two principal
advantages were that a
L = £
Fig. 5.18 - The text in this frame has a Omm left
indent, and a 10mm ist indent.

=
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Alignment
This option opens a menu allowing you to specify
paragraph alignment (see 5.2).

Space Before

This sets the amount of extra space inserted above
a paragraph.

Default units for Space before are points.

Space After
This sets the amount of extra space inserted
below a paragraph.

Instead of pressing Return to insert a blank line
between paragraphs, it is better to set Space after
to same value as the type size. If at a later stage
you want smaller gaps between paragraphs, you
can reduce the Space after value.

Default units for Space after are points.
Leading

This option opens a menu allowing you to set the
vertical line spacing (see 5.3).

@ = |
1. 1sfline indent is
useful for creating
numbered or
bulleted lists such as
m  this. m
2. Each number or
bullet should be fol-
lowed by atab
character.
L) == ]
Fig. 5.19 - The text in this frame has a 10mm left
indent, and a -10mm 1st indent.
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Drop Cap

Drop cap changes the first character in the
selected paragraphs to a drop cap (fig. 5.20). The
depth of the drop should be entered in the
writable icon provided.

The drop cap depth is specified in lines, based on
the depth of the first line.

Auto Kerning

Auto kerning uses the kerning data provided
with fonts to improve the appearance of certain
character pairs by adjusting the white space
between them.

Please note that this facility only works with
newer RISC OS 3 fonts such as those supplied
with Ovation Pro.

CHAPTER 5

Lock to Grid

In a multi-column or multi-frame layout, text in
one column or frame may not align horizontally
with text in the others (fig. 5.21). Lock to grid
aligns text in the selected paragraphs to a baseline
grid. If Lock to grid is enabled, the baselines of
affected text are shifted to align to the grid

(fig. 5.22).

The baseline grid origin and grid spacing are set
on Misc<Preferences (see 14.12).

Auto Hyphenation
Auto hyphenation automatically hyphenates
words that run over the ends of lines (see 5.6).

Enhanced Justification

Enhanced justification allows you to control
word and letter spacing in justified text (see 5.7).
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Fig. 5.21 - The baselines of text in columns do not align.
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Fig. 5.20 - Drop cap, 4 lines deep.

L=

Fig. 5.22 - Use Lock to grid, to align the baselines of text.
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5.5 The Tab Ruler

The tab ruler allows you to specify tab and indent
positions for the current paragraph or selection of
paragraphs. Tab stops are inserted into the
document by pressing the Tab key.

After choosing Tabs, the tab ruler is placed over
the top of the current paragraph or selection of
paragraphs (fig. 5.23). The ruler is the width of
the frame less the insets. The markings on the
ruler are in the current units.

Setting Tabs

To set a tab, choose the type of tab you require
from the Tabs dialogue box, then click on the
white area of the tab ruler at the required position.
Further clicks on the tab ruler will set more tabs
of the chosen type.

If you want to set tabs at precise positions, select
the type of tab you require, then enter the exact
position in the icon labelled Position. Press
Return to set the tab.

When you have finished setting tabs, click on OK
to update the document.
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Moving Tabs

To move a tab, click over it and drag it to the
required position. Alternatively, click on it to
highlight it in red, then enter the required position
in the Position icon on Tabs dialogue box. Press
Return to set the tab to the new position.

You can select a number of tabs by clicking
Select over the first one, then clicking Adjust over
any other tabs you wish to add to the selection. A
selection of tabs can be moved in one operation
by dragging any of the tabs in the selection.

Click Select over the ruler markings to deselect
all tabs.

Deleting Tabs
To delete a tab or selection of tabs, drag them
down onto the tab ruler.

b

1
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The mechanical typewriter, which originated in the USA about a
century ago, represented the first major advance over pen or
pencil. Its two principal advantages were that a competent
typist could write much faster with a typewriter than with pen or
pencil and that the writing produced was consistent and clearly
mlegible. It was not surprising, then, that the typewriter heralded [

an ‘office revolution

fortunes. Typing beq™
its many advamages?@,
major drawback. M}:)

was on the paper. A 7
L

Fig. 5.23 - The tab ruler is displayed above the current paragraph.
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Left Tab

The left tab causes text to be left aligned to the

tab stop (fig. 5.24).
Centire Tab

The centre tab causes text to be centred on the tab

stop (fig. 5.25).
Right Tab

The right tab causes text to be right aligned to the

tab stop (fig. 5.26).
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Fig. 5.24 - Left tab.
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Fig. 5.25 - Centre tab.
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Decimal Tab

The decimal tab causes decimal points to be
aligned to the tab stop (fig. 5.27). The decimal
point character is usually a full stop, but may be
defined in Misc< Preferences (see 14.12).

Text that doesn't contain a decimal point character
is right aligned to the tab stop.
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Fig. 5.26 - Right tab.
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Fig. 5.27 - Decimal tab.
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Tab Leader

The Tab leader is a string of one or more
characters that are automatically printed in the tab
space.

Typically the Tab leader string is set to a full stop
(or a full stop and a space character), and is often
used in the contents pages of books and
magazines (fig. 5.28).

@ =) Bl
CONTENTS
Inlroduction] ........ 1
Getting Started .. ... . 4
BasiEDIP i wvrsana B

mAdvanced DTP .. ... 10 i
PicRunes: . oramieis 12
OBIECIS: ¢ s wwiowazi 3 14
()7 " P 16
&1 370 S — 18

&= = £]

Fig. 5.28 - Page numbers tabbed
right with ‘dot-space’ tab leader.
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Setting Indents

The tab ruler may also be used to set the positions
of the indents. Indents may also be set on the
Format dialogue box, so please refer to that
section of this user guide for full details on the
operation of indents (see 5.4).

The Left indent and 1st indent are displayed
together at the left end of the tab ruler, and the
Right indent is displayed at the right end of the
tab ruler (fig. 5.29).

You may drag the indents to re-position them.
Alternatively, click on an indent to highlight it,
then enter the required position in the Position
field of the Tabs dialogue box.

You can move the Left indent and 1st indent
together by selecting them both and dragging in
one operation.

Unlike tabs, you cannot delete indents.

Ist indent Right indent
Left indent
IEIILTIH LILELIL LILELEL |||||i||||‘|‘1|1][
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Fig. 5.29 - Indents may be set on the tab ruler.
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5.6 Automatic Hyphenation

Normally when a word runs over the end of a
line, the entire word is transferred to the start of
the next line. This process is called word wrap.
Alternatively, you may hyphenate words so that
they are split at the end of lines. This enables text
to be fitted better into frames; especially in
narrow columns. In justified text, it also reduces
the size of the gaps between words.

You may manually hyphenate a word by typing a
hyphen - at the required place. If that word runs
over the end of a line, it is split at the hyphen.

Soft Hyphen

Alternatively you may insert a soft hyphen by
typing Ctrl -. A soft hyphen does not appear until
it is needed i.e. if editing the text causes the word
to run over the end of a line. In this situation, the
soft hyphen becomes visible and the word is split
at the hyphen. If editing causes the word to move
away from the end of a line, the soft hyphen will
disappear.

You may delete a soft hyphen when it is visible
using Delete or Copy in the usual way. You may
also delete an invisible soft hyphen. To do this,
step through the word containing the soft hyphen
until the caret steps over the invisible hyphen,
then press Delete.

Hard Hyphen

If you want a hyphen in a word, but do not wish
to split the word at that hyphen, you may insert a
hard hyphen using Alt -.
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Auto Hyphenation

If Auto hyphenation is enabled, words that run
over the end of lines are automatically
hyphenated.

Ovation Pro uses a hyphenation algorithm and an
exceptions dictionary to determine the best place
in a word for a hyphen. The exceptions dictionary
contains words that should not be hyphenated or
should only be hyphenated in a specific way. You
may edit or add words to the exceptions
dictionary if required (see 13.7).

Please note that hyphenation exceptions do not
take effect until the text is re-flowed.

The hyphenator ignores words that already
contain a normal, soft or hard hyphen, or words
containing non-alphabetic characters. In some
cases it may decide there is no suitable place for a
hyphen, in which case the word is not hyphenated
and word wrap occurs.

If the the automatic hyphenator splits a word
incorrectly, you may do one of two things:

1. Add the word to the exceptions dictionary
specifying the correct hyphen position or
specifying that the word should not be
hyphenated at all.

2. Type a soft hyphen using Ctrl - at the start of
the word. This will stop the word from being
hyphenated.
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Auto Hyphenation Options

The Auto hyphenation dialogue box (fig. 5.30)
allows you to control certain aspects of the
automatic hyphenator. This box is displayed by
moving the pointer of the icon to the right of
Auto hyphenation.

It is not good practice to hyphenate very short
words, so Minimum characters in word
specifies the smallest size word that will be
hyphenated.

Minimum before hyphen specifies the minimum
number of characters in the word that must
precede the hyphen. This prevents the hyphenator
splitting a word too close to its start.

Minimum after hyphen specifies the minimum
number of characters that must follow the
hyphen. This prevents the hyphenator splitting a
word too close to its end.

It is not good practice for too many consecutive
lines to end with a hyphen. Maximum
consecutive hyphens prevents this by specifying
the maximum number of consecutive lines that
may end with a hyphenated word. If this limit is
reached, the word at the end of the line will not be
hyphenated. A value of 0 means that there is no
maximum limit.

Hyphenation specification
Minimum characters in word | § |
Minimum before hyphen El
Minimum after hyphen [ 2 |
Maximum consecutive hyphens E
Hyphenation zone |

__| Break last word of paragraph

__|Break capitalised words ;
Canoelll oK |

Fig. 5.30 - The Auto hphenation dialogue box.
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Hyphenation zone specifies a zone measured
from the right margin. The start of the last word
in the line must be outside this zone, for it to be
considered for auto hyphenation. The
hyphenation zone only has an effect on text that is
left aligned.

If Break last word of paragraph is selected, the
hyphenator will attempt to break the last word in
the paragraph should it run over the end of the
line. Generally this is not regarded as good
practice, so this option is normally not selected.

The hyphenator does not normally split
capitalised words, but you may select
Capitalised words if you wish it to do so.
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5.7 Enhanced Justification

When a paragraph is justified, both left and right
edges are aligned to the margins. Normally this is
done by increasing the gaps between words until
the line fits; this is called word spacing. In some
circumstances, especially in narrow columns, this
can result in large gaps appearing in lines of text.
If these gaps join up over a number of
consecutive lines, an undesirable effect called
‘rivers of white’ may be produced.

Auto hyphenation can help reduce these
problems, but for best results you should use
Enhanced justification. This gives control over
word spacing, and allows you to introduce letter
spacing, should word spacing become excessive.

Enhanced justification is controlled from the
dialogue box which is displayed by moving the
pointer over the icon to right of Enhanced
justification (fig 5.31).

S0 P ARy e

Efg. 5.31 - The Enhanced justification dialogue
X,
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Word Spacing

Minimum and Maximum are the expansion
limits for word spacing. The values are specified
as percentages, where 100% represents the width
of a standard space character. If text cannot be
justified within these limits, letter spacing is
introduced (if it is enabled).

Reducing the Minimum value should enable you
to fit more text into lines, although some clarity
will be lost as words get closer together.

Increasing the Maximum value allows word
spacing to become much greater before any
attempt is made to use letter spacing. This value
has no effect if letter spacing is not enabled.

Letter Spacing

Minimum and Maximum are the expansion
limits for for letter spacing. The values are
specified as percentages, where 100% represents
the width of a standard space character. A normal
letter space is 0%.

To disable letter spacing, set Minimum and
Maximum to 0%.

A negative Minimum value may cause letters to
overlap.

A large Maximum value will give excessive
letter spacing which is regarded as bad practice.

-
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Enhanced Justification Rules Justification Examples

Ovation Pro tries each of the following steps, The examples below show how the same

until the text becomes justified. paragraph may be justified in two different ways.

1. Increase word spacing from 100% up to The first example (fig. 5.32), uses standard
Maximum. justification. Word spacing is increased until text

2. Decrease word spacing from 100% down to fits on a line, and there is no letter spacing.

Minimum. The second example (fig. 5.33). uses enhanced

3. Set word spacing to Maximum and increase word and letter spacing:

letter spacing from 0% to Maximum. Word spacing Minimum  75%
Word spacing Maximum  125%
Letter spacing Minimum 0%
Word spacing Maximum  +25%

4. Set word spacing to Minimum and decrease
letter spacing from 0% to Minimum.

5. Increase word spacing from Maximum until .
the line fits. Notice that there are fewer large gaps between

) . o words and more text fits into the frame.
Notice that Ovation Pro attempts to justify the

text using word spacing before trying letter
spacing, and increases spacing before decreasing.

) =, 51 ) 1=} £l
The mechanical The mechanical typewriter,
typewriter, which which originated in the
originated in the USA USA about a century ago,
about a century ago, represented the first major
represented the first major advance over pen or
advance over pen or pencil. Its two principal

gpencil. Its  two principalp radvantages were that af
advantages were that a competent typist could
competent typist could write much faster with a
write much faster with a typewriter than with pen or
typewriter than with pen \pencil and that the writing
or pencil and that the produced was consistent
writing  produced was and clearly legible. It was

= =) £ o = 2]

Fig. 5.32 - Standard justification. Fig. 5.33 - Enhanced justification with

letter spacing.
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Other Justification Options

Normally when text is justified, if there is only a
single word on a line, it becomes left justified
(fig. 5.34). If Single words is selected, a single
word on a line is justified by adding sufficient
letter spacing (fig. 5.35).

Flush zone allows you to control justification of
the line line in a paragraph Normally the last line
of a justified paragraph is not justified. However,
if the end of the line is near to the right margin, it
may look better justified.

Flush zone defines a zone measured from the
right indent. If the end of the last line of the
paragraph falls within the flush zone, then that
line is justified.

By default Flush zone is set to 0, which means
that the last line of a paragraph will never be

Jjustified.

@ & ) e g8 ——10
It was| not surprising, It was| not surprising,
then,  that the then, that the

typewriter heralded
an ‘office revolution’
in which typewriter
manufacturers made
mfortunes. Typing
became part of the
school curriculum.
Despite its many
advantages, the
mechanical

typewriter  suffered

typewriter heralded
an ‘office revolution’
in which typewriter
manufacturers made
ffortunes. Typing
became part of the
school curriculum.
Despite its many
advantages, the
mechanical
typewriter suffered

& = £] i B ¢

Fig. 5.34 - The single word is Fig. 5.35 - The single word is
not justified. justified.
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Defined Styles
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Local text and format effects described in chapters 4 and 5 allow you to
instantly alter the style of text. However, if you need to apply combinations
of effects, it is much easier to define a style that combines all the required
effects, and then apply that style in a single operation.
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6.1 Overview

A defined style is a combination of effects with a
unique name that can be applied to text in a single
operation. It enables you to apply complex
combinations of effects quickly and consistently
throughout the document. So if you want
headings to be 18pt Bold, you could define a style
called Heading to be 18pt bold, and apply it to
the appropriate headings.

A further advantage of a defined style is that if
you change its definition, all text in that style is
automatically updated throughout the document.
So if in the example above, you decide that
headings should be 24pt instead of 18pt, you need
only change style Heading to 24pt. Once this
has been done, all headings will automatically
change to 24pt.

BodyText

Initially all text in Ovation Pro appears in a pre-
defined style called BodyText. By default
BodyText is 12pt Trinity, but you may edit the
definition as required. So if you run Ovation Pro
and type in a letter, the text of that letter will
appear in 12pt Trinity. If you then change
BodyText to 13pt, all the text in the letter will be
automatically updated.

You may overlay BodyText with other defined
styles or local effects. These may overwrite
various attributes of BodyText. Local effects are
always applied on top of all other styles,
irrespective of the order in which they were
applied.

Overlayed styles and effects may be removed
from a selected region, but the base style,
BodyText, must remain.

CHaPTER 6

Scope

Normally, a style is applied to a selected region,
but you may also define a scope which specifies
the amount of text that will be affected when the
style is applied. For example, a style with
paragraph scope is applied to entire paragraphs.
This can save a lot of time because it eliminates
the need to select paragraphs before applying
styles.

Keypresses

Another time saver is the ability to assign a
keypress to a defined style. The style can then be
applied at the press of a key.
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6.2 The Edit Style Dialogue Box

Choose StylevEdit style (fig. 6.1) to open a
dialogue box which allows you to create, edit,
rename and delete styles (fig. 6.2).

The small window in the top left of the dialogue
box lists all the styles that have been defined. If
necessary, use the scroll bar to scroll through the
list. One style in this window will be pre-selected
ready for editing. The pre-selected style is the
style at the caret, or if there is more than one style
at the caret, the one that was applied last.

Initially there is only one style, BodyText, so this
is pre-selected.

You may select another style for editing by
clicking on it.

The centre panel of the dialogue box shows a
preview of what the selected style looks like. The
preview shows text attributes such as font, size
and colour, but not format attributes such as
alignment and leading. If the previewed text is
too big, it is cropped to fit the preview box.

THe Epir Styie Diatocue Box Al

The bottom panel of the dialogue box shows a
summary of the attributes of the selected style. So
BodyText sets the font to Trinity, the size to 12pt,
the text foreground colour to Black etc.

The buttons Text, Format and Tabs are used to
edit the selected style.

Any changes made in the Edit style dialogue box,
are not applied until you click on OK. If you
click on Cancel the dialogue box will be closed
and all the styles will be unchanged.

List of defined styles

Style preview

Style summary

The quick brown fox

/ /]

TR

style... AME

£

E

| Trinity + 12pt + Black F + Transparent B + H.Scale 100 + Before Opt +
Alter Opt + Leading 20% + Tab ruler

Sowl | Rename| Delete | Cancel || Ok

Fig. 6.1 - The Style menu.

Fig. 6.2 - The Edit style dialogue box allows you to create, edit,

rename and delete styles.
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6.3 Creating Styles

To create a new style click on New and type the
name of the style into the New style dialogue box
(fig. 6.3). The name must not be the same as an
existing style name.

By default Based on is not selected, so a
completely blank style is created i.e. all attributes
will have no effect.

If Based on is selected, the new style will be
based on the style that was selected when New
was chosen. However, you can base a new style
on any another style by choosing it from the
menu.

Click on OK to create the new style and close the
dialogue box. The style you have created is added
to the list in the Edit style dialogue box, and is
automatically selected ready for editing.

' . New style .
. New style | | [
_]'Basedon ' Bodytext ﬂ;

c:ama||| oK |

Fig. 6.3 - The New style dialogue box.

CHaPTER &



—

Section 6.4

6.4 Editing Styles
To edit a style, first ensure that the style you wish
to edit is selected in the Edit style dialogue box

(fig. 6.2).

Text Attributes

To edit the text attributes of the selected style,
click on Text. This opens the Modify text
dialogue box (fig. 6.4) providing all the text
effects described earlier in this user guide
(see 4.6).

Notice however that there is an additional icon to
the left of options such as Font and Size.

A ‘cross’ in this icon indicates that when the style
is applied to text, the attribute will have no effect.
When you create a new blank style, all attributes
are in this state.

If an attribute is ticked, it will have an effect
when the style is applied. Attributes automatically
become ticked if you alter them, or you can
change a cross to a tick by clicking on it.

Epiting Stytes 73

If you edit BodyText you will notice that all
attributes are ticked and cannot be changed. This
is because bodyText is the base style and must
define everything.

Attributes such as Bold and Italic may have three
states; a cross, a tick or blank. A cross in the icon
indicates that the attribute will have no effect. A
tick means that the attribute is set on, and a blank
means it is set off.

For example if you have some text that is Bold
and Underlined, and apply a style where Bold is
crossed, Italic is ticked and Underline is blank,
the resulting text will be Bold and Italic. This is
because Bold has no effect, Italic is applied and
Underline is removed.

Modify text

Font [V | Trinity

size [V 14t B
roregrna [/ [ 5/
Backgmd [V 77778

[V Bold Jltalic

__|Small caps _]Hevarss

5| Hscale [ [ 100] %

kem /[ 0 |

Vshitt V[ o J=
role V[ 0"
sen V[ 0 ]

| | _Juncerine ]
_ISWQW _]Subscript ._jStrikeout ﬂ:}_:‘": 3

5]

Fig. 6.4 - The Modify text dialogue box is used for editing styles. If an

attribute is ‘crossed’ it will not be applied to the text.
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Format Atiributes

To edit the format attributes of the selected style,
such as alignment and leading, click on Format.
This opens the Format dialogue box described
earlier in this user guide (see 5.4).

As in the Modify text option described above,
format attributes have no effect if they are
crossed, applied if they are ticked or removed if
they are blank (fig. 6.5).

Tab Attributes

To edit the tab settings for the selected style, click
on Tabs. This opens the Tab dialogue box

(fig. 6.6) and tab ruler described earlier in this
user guide (see 5.5).

An additional option on the Tab dialogue box,
Apply ruler, allows you to determine whether the
tab ruler will be applied or not. A cross indicates
that it will have no effect; a tick indicates it will
be applied.

CHaPTER 6

Example

Assume you want to create a style that will set
text to 14pt Bold. It should change nothing else,
so that the font and all other attributes are
determined by BodyText and any other
underlying styles.

1. First use New create a blank style.

2. Click on Text to open the Modify text
dialogue box. Since the style is completely
blank, all the attributes have a cross beside
them.

3. Now choose 14pt from the Size menu. Notice
that the Size option becomes ticked. Click on
Bold so that it is also ticked. (fig. 6.4).

4. Click on OK to apply the changes.

5. The preview will now show 14pt Bold text and
the style summary will confirm that these two
attributes have been assigned to the style.

oaang [7 2 ]

__|Auto kerning
___]Locktogid

. - Modly formal —
o R -
tstindent [/ [ omm |~ Aignment [/ | Centre

Spacavooe [V [om | wmr—

_oropeap. 3] __IAum hwrwnaﬁon ﬂ

_|Enhamed ]uswlcahon i

Fig. 6.5 - The Format dialogue box is used for editing styles. If an
attribute is ‘crossed” it will not be applied to the text.
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Scope

The Scope menu (fig. 6.7) allows you to specify
the amount of text affected when the style is
applied.

Selection causes the style to be applied to the text
selection. If there is no selected text, the style is
applied to the caret.

Paragraph causes the style to be applied to the
entire paragraph that contains the caret, or to all
paragraphs wholly or partially in the selection.
Paragraph is automatically selected if the
Format dialogue box has been used, since these
attributes normally only apply to whole
paragraphs.

Word causes the style to be applied to the word at
the caret, or to all the words wholly or partially in
the selection.

Key
You can assign a keypress to the selected style by
pressing the required key combination.

You can use almost any key in combination with
Ctrl, Shift or Ctrl Shift. However, to avoid
overriding existing key shorts cuts, we
recommend that you use function keys e.g.

Ctrl F1, Shift FS, Ctrl Shift F8.

In the Key icon, the Ctrl key is represented by the
symbol *, and the Shift key is represented by the
symbol M.

Tabs
IV Apolyruler’ = 5t st e
Gunw  poston o ]
JCenretab - Tapleader| |
. Right tab R
R o |
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6.5 Renaming & Deleting Styles

Rename

To rename the selected style, click on Rename to
open the Rename style dialogue box. Type in a
new name and click on OK.

Delete

Click on Delete to delete the selected style. All
occurrences of the style are deleted from the
document.

Fig. 6.6 - The Tab dialogue box.

Fig. 6.7 - The Scope menu.
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6.6 Applying Styles

To apply a style, first select the text to be
changed, then choose the required style from the
Style menu (fig. 6.8).

Changing Selections

If the scope of the style you are applying is set to
Selection, the style is applied to the selection. If
there is no selection, the style is applied at the
caret, and any text subsequently typed will appear
in that style. Note however, that if you move the
caret before typing, the style will not be applied.

Changing Paragraphs

If the scope of the style you are selecting is set to
Paragraph, the style is applied to the paragraph
containing the caret; there is no need to select the
text in the paragraph.

If there is a selection, the style is applied to all
paragraphs that are wholly or partially selected.

In Ovation Pro, a paragraph is defined as the text
between two carriage returns, which may be a
single line or multiple lines of text.

Edit style... ~ME
Remove P
Heading *F2
SubHeading "MF3
Indent#1 AF9

Fig. 6.8 - The Style menu.
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Changing Words

If the scope of the style you are selecting is set to
Word, the style is applied to the word containing
the caret; there is no need to select the word.

If there is a selection, the style is applied to all
words that are wholly or partially selected.

Overlaying Styles

By default all text is displayed in the pre-defined
style called BodyText. You may overlay any
number of additional styles on top of BodyText.
For example, if you apply a style that sets Italic,
and overlay it with a style that sets Bold, the
resulting text will be Italic and Bold.

The attributes of the last style overlayed,
overwrite those conflicting attributes of the style
beneath. For example, if you apply one style that
sets the text size to be 14pt, and overlay it with
another style that sets text size to be 18pt, the
resulting text will be 18pt.

Styles and Effects

You can apply a combination of defined styles
and local effects to the same region of text. In this
situation, the defined styles are applied first and
the local effects are overlayed on top, irrespective
of the order in which they are applied.

N,
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Current Style

If there is no selection, the styles that are current
at the caret are ticked on the Style menu.

If there is a selection, any styles that are present
throughout the selection, are ticked on the Style
menu. If a style is not ticked on the menu, it
means that it is not present throughout the
selection.

Local effects*L

Heading
SubHeading
Indent#1

Fig. 6.9 - The Remove menu.
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6.7 Removing Styles

The Remove menu (fig. 6.9) lists all the styles
that are present at the caret or somewhere within
the selection. The order of the styles on the menu
shows the order in which they were applied in the
document (the last style applied being at the top
of the menu).

Click on the style name to remove it from the
caret or selection.

Notice that BodyText is not displayed on the
Remove menu. This is because BodyText must be
present beneath all other styles, and cannot be
removed.

The Local effects options removes all local
effects at the caret or selection.

If you remove all styles and local effects from a
selection, the selection will be displayed in
BodyText style.
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6.8 Merging Styles

You can merge the styles from another document
or stylesheet by dragging a document or
stylesheet onto the Edit style dialogue box

(fig. 6.2).

If a style being merged has the same name as an
existing style, a warning box is displayed

(fig. 6.10). Since BodyText exists in every
document, this warning box will always appear at
least once.

For each style name clash, the warning box
provides a number of options.

Skip causes the style to be ignored and not
merged.

Overwrite causes the style being merged to
overwrite the existing style.

Rename changes the name of the style being
merged so that it doesn’t clash with any existing
style.

Cancel aborts the merge operation.

Duplicate style 'Bodytext' found.

Ca.ncel ] Ovarwmel Fienamell Skip |

Fig. 6.10 - This warning box is displayed for each style name clash.

CHAPTER &
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Document View
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7.5 Document Zoom. . .. ... e

This chapter describes options that change the way the document looks on
the screen. They do not affect how the document is printed.
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7.1 The View Menu

The View menu (fig. 7.1) provides a range of
options that control how the document is viewed
on-screen. View options are saved with
documents and can also be saved as default

(see 14.2).

View
New view
Options*" TV
Grid ~G P
Zoom MIZ

Fig. 7.1 - The View menu.
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7.2 New View

New view allows you to have any number of
windows open on the same document. Each
window can be scrolled to a different part of the
document and can have its own independent
zoom and view options. You can edit the
document in any of the windows; all the others
will be updated automatically. Typically this
feature is used to open a new view at a small
scale, providing an overview of the entire page.

The number of views that are currently open is
shown after the document name on the title bar.

Use the normal close icon to remove new views if
they are not needed.

View options b
[ Toolbox [V Pictures
]7 Button bar [7 Guidelines
|7 Info palette |:/_ Print margins
__|Rulers __|Facing pages
__|Pasteboard | invisibles
ok |

Fig. 7.2 - The Options dialogue box.
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7.3 View Options

Options
Options opens a dialogue box allowing a number

of miscellaneous view options to be enabled and
disabled (fig. 7.2).

Toolbox
Toolbox opens and closes the toolbox.

Button Bar
Button bar opens and closes the button bar.

Info Palette
Info palette opens and closes the info palette.
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Rulers

Rulers shows or hides the page rulers (fig. 7.3).
Rulers are a visual aid for measuring, positioning
and resizing objects.

Ruler markings are in the current document units
and the origin is at the top left corner of the
document. Both units and origin may be changed
on Preferences (see 14.10 & 14.11).

If you click on a ruler, a ruler guideline is created.
Ruler guidelines are drawn across the page
vertically or horizontally and are a further aid for
positioning objects (see 8.4).

2| & NENEEE R
IllilllﬁiIllllllﬁllllllllﬁ)IIII]IIW' ‘“x,llllllll“20 II!“D'

|§Jhl|llllr$llllllll

gllllll!l
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Il |0 IO 8 |05«

A

[ Text frame %[1omm | w[190mm

1.1 ¥ |10mm H|277mm

—_ TN T =T o T T

Triniy
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Fig. 7.3 - Document with Rulers shown.
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Pasteboard

Pasteboard shows or hides the document
pasteboard. The pasteboard is a grey margin
around the page that may be used like the normal
page, but is not printed (fig. 7.4). Typically it is
used to temporarily store objects. The contents of
the pasteboard are saved with the document.

If objects overlap from the page onto the
pasteboard, only the part of the object on the page
is printed. However, if Bleed is specified when
printing, a strip of the pasteboard around the
document is also printed (see 12.3).

The size of the pasteboard may be defined on
Preferences (see 14.11).

(5 B3| Document5 *

Flo

e i

18I0 «lra o]

r
1
L.

210 OO

[ Texttrame  x[1omm | w][190mm | Trinity EH 2ot

[ 0 ¥ [10mm

H

277mm

IN Bl 7|U|@ 2] [E = =5

Fig. 7.4 - Document at 30% zoom with an object on the Pasteboard (shown in grey).
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Pictures

Pictures shows or hides pictures in picture
frames. By default pictures are shown, but if your
document contains pictures that are slow to
redraw, you may wish to hide them. Frames
containing hidden pictures are indicated with a
cross through them (fig 7.5).

Guidelines

Guidelines shows or hides guidelines. By default
guidelines are shown, but you may wish to hide
them to see how your document will look when
printed.

There are three types of guidelines (fig 7.5):

* Frame guidelines
* Column guidelines
» Ruler guidelines

View OrTIONS 83

Print Margins

Most printers cannot print right up to the edge of
the page, so Print margins allows you to see the
margins around the paper that cannot be printed
(fig. 7.5). You should always ensure that
everything on the page to be printed is inside
these margins.

The print margins are obtained from the printer

drivers, so they will only be displayed if a printer
driver has been loaded.

e Pl x
@ |!|l|l||!l1l|[|l|| |1|||l|ﬁ1|i||||tla|)|tlll l|1|olollllllilzplillll1|‘l|0:'
7
w — = =)
5 T
- Frame
@a9) | guideline
e e 0
= ™l
—_— olumn
L ' guideline
ol \ i & &
A Print margin \ i
E Hidden picture Ruler guideline
Picture frame  X|29.63mm| W[49.95mm| Scale[23.48|<% X[onm |<A[ 0 |
11 ¥[14.96mm| H[45.16mm| Aspect| 100 | ¥[277mm |=  Ft |

Fig. 7.5 - Document with print Margins shown. The frame contains a hidden picture.
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Facing Pages
When Facing pages is not selected, pages are
displayed vertically, one on top of another.

When Facing pages is selected, pages are
displayed in horizontal pairs (fig. 7.6). Non-
existent pages such as the page before page 1, are
shown in grey.

Page 1

Page 2 Page 3

Puage 4

Fig. 7.6 - The arrangement of a 4-page
document when Facing pages is enabled.
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Invisibles

Invisibles shows or hides special symbols that
represent invisible characters in the document. It
is useful for finding where paragraph breaks have
been inserted or to check that double spaces have
not been inserted between words.

This feature is for information only and does not
affect the format or final printout of the
document.

The invisible characters and the symbols used to
represent them are shown below.

New line -
New paragraph q
New page §
Space -
Non-breaking space -
Tab »
End of story o
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7.4 Grid

This Grid option allows you to superimpose a
rectangular grid on the document. It is useful for
lining up objects or checking their relative size.
The grid is made up of ‘major points’, marked by
a cross, and ‘minor points’ marked by a dot

(fig. 7.7).

The grid is controlled from the Grid dialogue box
(fig 7.8).

Show grid displays the grid in the colour chosen
from the palette shown.

Lock grid switches grid lock on or off. Grid lock
causes new objects to align to the grid as they are
created and existing objects move in steps of the
grid spacing (see 8.4). Clicking on Grid on the
View menu also switches the grid lock on or off.
The grid does not have to be shown in order to
use the grid lock.

Grip 85

Spacing allows you to set the distance between
the major points on the grid.

Sub divisions allows you to set the number of
sub divisions between each major point.

Fig. 7.7 - Document with Grid shown.

Grid
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7.5 Document Zoom

You can view and edit the document in a range of
preset zooms or any variable zoom you require.
The default zoom is 100% which shows your
document on screen at approximately 100% of
the true printed size.

The easiest way to change the zoom is to use the
Zoom tool (see 2.9).

You may also set the zoom using the Zoom
dialogue box (fig. 7.9).

Choose 50% . 75%. 100% . 150% ., 200% or
400% to set one of the standard preset zooms.

Choose Variable to specify any zoom between
10% and 1000%. Enter the zoom value in the
writable icon, or use the up and down buttons to
alter the current value in 1% steps.

Fit window sets the document zoom so that an
entire page (or pair of pages) fits in the document
window.

Fit screen sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

Document zoom
J50% )75% ) 150%
® 100% ) 200% ) 400%
) Variable v. /A

Fitwindow | Fitscreen |
o o

Fig. 7.9 - The Zoom dialogue box.
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This chapter describes the tools for drawing and editing objects. You can
draw objects anywhere on the page, even overlapping other objects, but
not across page boundaries. There are three types of objects: frames,
lines and ruler guidelines.

Frames are the basic building blocks in Ovation Pro. They are used to
hold the text and pictures that appear on the page and are normally
rectangular (but may be any closed shape).

Lines are normally straight or curved open paths, but may be any shape

(open or closed). Even if line paths are closed, they cannot contain text or
graphics. Typically, Lines are used to add additional graphics to the page
and for this purpose are better than frames because they use less memory.

Ruler guidelines are used to help align objects on the page.
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8.1 Drawing frames

Frames in Ovation Pro may be rectangular,
elliptical or irregular. In the latter case they may
be constructed from straight and curved line
segments. To draw a frame, click Select on the
Frame tool and on the required shape from the
toolbox (fig 8.1).

Normally after drawing a frame or line, the Select
tool is automatically re-selected ready for text
entry. If you wish to draw a number of frames in
succession, choose the Frame tool by clicking
Adjust, whereupon it will remain selected until
another tool is chosen.

An empty frame can contain either text or a
picture. If you wish to put a picture in a text
frame, you must delete all the text first. Similarly,
if you want to put text in picture frame, you must
delete the picture first.

X |
e i Frame tool
R 4
W
g
&)
Q)
- Rectangle
(] g
)] Ellipse
& Straight Line Segment
& Curved Line Segment

Fig. 8.1 - The toolbox.
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Rectangular Frames

Move the crosshair to where you want one corner
of the rectangle to be, then click Select and drag
to the opposite corner. Finally release Select to
complete the operation (fig. 8.2).

To draw a perfect square, hold down Shift while
drawing the rectangle (or use grid lock).

Elliptical or Circular Frames

Ellipses are arranged to fit within a rectangular
area. Move the crosshair pointer to the centre of
the area then click Select and drag to the required
corner. Finally release Select to complete the
operation (fig. 8.3).

To draw a perfect circle, hold down Shift while
drawing the ellipse (or use grid lock).

@ g 8@ B—f
I [T
)
m m m ]
& a g B 5 ——lp
Fig. 8.2 - A rectangular  Fig. 8.4 - A straight-
frame. sided irregular frame.
F: — g G B
2 ?
it m 0 m
5 e 4 L
Fig. 8.3 - As elliptical Fig. 8.5 - A curved-
frame. sided irregular frame.
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Irregular Frames

Choose Straight Line Segment or Curved Line
Segment from the toolbox. Click Select where
you want the line to start, then move to the
endpoint and click Select again. You can keep
adding line segments to the path by moving to the
endpoint of each new line and clicking Select.
Alternatively click and drag to each new
endpoint, to allow auto-scrolling at the edge of
the window.

At any time you can change between straight and
curved lines by choosing the required type from
the toolbox. To draw perfectly horizontal or
vertical lines, hold down Shift to constrain pointer
movement to the horizontal or vertical.

Double-click Select or click Adjust to finish the
path. When drawing frames, the path is closed
automatically (figs. 8.4 & 8.5).

The shape of irregular frames can be edited in
Path Edit Mode (see 8.11).

L1
R
Line fool

W

<

&)

Q

—— Rectangle

O Ellipse

A Straight Line Segment
U Curved Line Segment

Fig. 8.6 - The toolbox.
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8.2 Drawing lines

The Line tool in allows you to draw rectangles,
ellipses, straight lines (fig. 8.7) and curved lines
(fig. 8.8). You can draw single lines or sequences
of connected lines. By default lines sequences are
open path, but can be closed (fig. 8.9 & 8.10)
using an option in Path Edit Mode (see 8.11).

To draw a line, choose both the Line tool and the
required shape from the toolbox (fig. 8.6). The
method of drawing lines is identical to that
described on the previous page for frames.

Remember that objects drawn with the line
tool cannot contain text or pictures.

B B &l = = Bl

m m m

L = 2 L} = £

Fig. 8.7 - A straight Fig. 8.9 - An open path

line. line.

) = £] = = £l

m m m m

L5 = g == =

Fig. 8.8 - A curved line.  Fig. 8.10 - A closed
path line.
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8.3 Text Overflow

Once you have drawn a frame, you may type or
import text into it (see 3.1 & 3.3). If you type past
the bottom of the frame or import a story that is
too big, the overflow flag will be displayed in the
bottom right corner of the frame (fig. 8.12). In
this situation, the overflowed text will not be
visible and cannot be edited.

There are a number of things you can do to
remove the overflow flag:

1. Delete some of the text to make space for the
overflowed text.

2. Make the frame big enough to display all of
the text.

3. Link the overflowed frame to another frame,
so that the text will automatically flow into the
second frame.
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Linking Frames

To link two frames, select the Link tool from the
toolbox (fig. 8.11). Now click in the first frame
and drag the pointer to the second frame. During
this operation, the pointer will change to a link
symbol. After linking, the overflow flag will
disappear from the first frame, but may be
displayed in the second frame if there is still not
enough space for the entire text story (fig. 8.13).
If you wish you can then link the second frame to
a third frame. You can link any number of frame
together in this way, even if they are on different
pages.

Editing Text in Linked Frames

Once frames are linked, text will flow
automatically between them, and may be edited
as normal. Caret movement will work correctly
between the frames, and you may select text
across them by clicking or dragging in the usual
way.

[ B
The[nwchanical

typewriter, which

originated in the USA

about a century ago,

[ rrepresented the first majorgy

—x] advance over pen or

Fig. 8.11 - The toolbox.

ly ml pencil. Its two principal
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0 Fig. 8.12 - Frame with overflow flag.
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Fig. 8.13 - Two linked frames with link shown.
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Show Flow

When you choose the Link tool, arrows are drawn
in the document indicating where text flows

(fig. 8.13).

Changing a Link

If you link from a frame that already has an
outward link, the original link is removed and text
flows according to the new link.

Unlinking Frames

To unlink frames, choose the Link tool so that
you can see the arrows that show text flow. To
remove a link, click Select on the appropriate
arrow, so that it is highlighted i.e. shown in black
(fig. 8.14). Now press Delete to remove the link.

Removing a link has the effect of removing the
text from the linked frame (and any subsequently
linked frames) and joining it back to the end of
the previous frame. This will cause the previous
frame to overflow, but no text will be lost.

Frame Break

You can force the caret to the start of the next
linked frame by pressing Ctrl P or Enter, or by
choosing Inserte>New page.

The break character may also be deleted, causing
text that follows to flow back into the previous
frame.

The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or |
\pencil. Its two principal
advantages were that a
competent typist could

legible. It was not

Fig. 8.14 - Two linked frames with highlighted arrow.
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Special Notes

The following points should be considered when

linking frames:

1. You cannot link to or from the Main frame,
since this is already linked.

2. You cannot link picture frames.

3. If a frame contains text, it can only be linked to
an empty frame that doesn’t already have an
inward link.

4. If a frame is empty, it can be linked to any text
frame that doesn’t already have an inward link,

5. You cannot delete linked frames.

6. You cannot cut or copy linked frames to the
clipboard, or copy linked frames using drag
and drop.

write much faster with a

r pencil and that the i
'writing produced was
consistent and clearly

[surprising, then, that the
typewriter heralded an
‘office revolution” in
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8.4 Drawing Aids

There are a number of facilities available to help
you draw and manipulate objects.

Cancelling an Operation

Most operations concerned with manipulating
objects can be cancelled by pressing Esc at any
time. So if you are in the middle of drawing a
frame, pressing Esc will cancel the operation.

Auto Scrolling

The document window will automatically scroll if
you drag close to its edges. The speed of scrolling
is determined by how close the pointer is to the
window edge; the closer it is, the faster it scrolls.

Nudging the Pointer

When drawing, moving and resizing objects you
may position the pointer more accurately by
pressing the cursor keys to ‘nudge’ it one pixel in
the required direction.

-1
1]
&
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Object Snap

When drawing, moving or resizing objects, the
edges of the objects snap into alignment with the
edges of other objects on the same page. Top
edges snap to top edges, bottom edges to bottom
edges etc (fig. 8.15).

Object snap may be disabled on Preferences
(see 14.11), and is automatically disabled if grid
lock is enabled.

Grid

If grid lock is enabled (see 7.4), and an object is
drawn or resized, its edges will snap to the grid. If
an object is moved, it will jump in steps of the
grid spacing.

If grid lock is enabled, the Object<Snap to grid
option will snap the top left corner of the selected
object to the nearest grid point. The size of the
object is not altered.

3 = £
m m
i = £

Fig. 8.15 - The selected frame is dragged in the direction of the arrow so that the
bottom left and bottom edges snap to the larger frame. The right edge of the selected
frame is then dragged to the right until it snaps to the right edge of the larger frame.
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Ruler Guidelines

When rulers are enabled (see 7.3), you can draw
your own vertical or horizontal guidelines across
the page. Edges of object will snap to these
guidelines when dragged close to them.

To draw a vertical guideline, click Select on the
horizontal ruler at the required position.
Alternatively, click Select then drag the guideline
to the required position. To draw a horizontal
guideline, do the same, but on the vertical ruler.

To move a guideline, move the pointer over the
guideline, so that the pointer changes to the
guideline tool (fig. 8.16). Now drag the guideline
to the required position. You can also drag a
number of selected guidelines in a single
operation.

To select guidelines, click Select over the first
one, then click Adjust over other guidelines to
add them to the selection. Selected guidelines are
shown in red.
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To move a selected guideline to an exact position,
choose Object<>Modify and enter a value in the
dialogue box displayed (fig. 8.17).

To delete a guideline drag it to the extreme edge
of the page. Alternatively, to delete selected
guidelines choose Edit>Delete.

To delete all vertical guidelines, click Ctrl Select
on the horizontal ruler. To delete all horizontal
guidelines click Ctrl Select on the horizontal
ruler.

Guidelines are normally drawn over the top of all
frames, but an option on Misc<~Preferences
allows them to be drawn behind instead

(see 14.11). Snap to ruler guidelines may be
disabled on Misc<Preferences (see¢ 14.11), and is
automatically disabled if grid lock is enabled.
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Fig. 8.16 - Document with vertical and horizontal ruler guidelines.

Fig. 8.17 - Modify guideline.
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8.5 Selecting objects

Before you can make changes to an object you
must select it. Ensure that the Select tool is active
(fig. 8.18) then click Select over the object. This
selects the object and deselects any other objects.

When an object is selected, it is enclosed in a red
*bounding box” with 8 blue ‘handles’ located
around its edges. The bounding box is a
rectangular guideline that completely encloses the
object (fig. 8.19 & 8.20). A handle is a small
square which can be dragged to resize the object.

In addition to frames and lines, you may also
select ruler guidelines. When selected they are
shown in red, but do not have handles.

You can select more than one object by clicking
Adjust on each additional object. Clicking Adjust

on an object that is already selected causes it to be

deselected.

ﬁ;— Select tool
:J .

m
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Another way of selecting all the objects in an area
is to construct a select box around the area by
holding down Ctrl Shift and pressing Select at
one corner of the area to be selected and dragging
the box to the opposite corner. Release Select
when all the objects to be selected are wholly
within the select box; the objects will then be
selected.

If the object you want to select is obscured by
another object, hold down Ctrl Shift and double-
click over the top object to select the object
beneath. You may keep doing this to select
progressively deeper objects until you eventually
return to the top object.

If you want to permanently group a number of
objects, use Object~Group (see 9.11).

—h]

s
M & =
2

Fig. 8.18 - The toolbox.

Fig. 8.19 - An active
rectangular frame with
eight handles for resizing.

o) @ _..143— : &

iy i iy

& ! e
Fig. 8.20 - An active

elliptical frame with eight
handles for resizing.
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8.6 Moving Obijects

To move an object, first ensure the Select tool is
selected. Then click Select over the object and
keep it pressed and completely still until the
Move pointer appears (fig. 8.21). Now drag the
object to its destination (which may be anywhere
on the same page) and release Select. If you hold
down Ctrl, you may drag the object immediately,
without holding the pointer.

If you have a number of objects selected, moving
one of them will move the entire selection. You
can move a mixed selection of frames, lines and
ruler guidelines if you wish.

To constrain movement to the vertical or
horizontal, hold down Shift while dragging.

You can position objects precisely using the info
palette or the Modify dialogue box (see 9.1).

Using the Info Palette

X and Y on the info palette (fig 8.22) are the
coordinates of the top left corner of the selected
object or group. Coordinates are measured from
the top left corner of the page. X and Y may be
modified to change the position of the object.
Press Return after modifying the values to update
the document.

If there is a selection of objects, X and Y refer to
first object selected. In this case if X and Y are
modified® the first object is moved to the position
specified and the rest are moved proportionally.

Moving Oslects 95

Drag and Drop

You can move or copy objects using the drag and
drop facility. Unlike the normal move operation
described above, you can drag and drop objects to
any page in the same document or in a different
document.

To drag and drop selected objects, hold down Alt
then drag them to the required position.

If you drag and drop within the same document,
objects are moved,; if you drag and drop to
another document, objects are copied.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, objects are
copied, if you drag and drop to another document,
objects are moved.

If you start a drag operation and wish to cancel it,
press Esc.

Please note that you cannot drag and drop master
objects or linked frames.

0 a a
0 0
%
Textframe  X[2omm | w/[4omm Bl e CH|
5 5 A IR ¥[2omm | H[40mm .B|]|U[@ |2 |m§ﬁ§
Fig. 8.21 - The Move  Fig. 8.22 - The info palette gives the position of the selected object. You can
tool moves objects. reposition it by changing the X and Y values.
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8.7 Resizing Objects

To change the shape or size of an object move the
pointer over one of the 8 handles so that the
Resize pointer appears (fig. 8.23). Now press
Select and drag the mouse until the object is the
size and shape that you want. There are two types
of handles:

* Corner handles will resize the object both
horizontally and vertically.

* Centre handles will make the object either
wider or longer.

If you hold down Ctrl while dragging, the original
shape (aspect ratio) of the object will be
maintained. If you hold down Shift, the object
bounding box shape will be constrained to a
square.

If you have a number of objects selected, resizing
one of them will resize the rest proportionally.

You can resize objects precisely using the info
palette or the ObjectoModify dialogue box
(see 9.2).

[ O g—
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Fig. 8.23 - Move the pointer over a handle
and drag the resize tool to resize the object.

CHaPTER 8

Using the Info Palette

W and H on the info palette (fig. 8.24) are the
width and height of the selected object or group.
W and H can be modified to change the size of
the object. Press Return after modifying the
values to update the document.

If there is a selection of objects, W and H refer to
the first object selected. In this case if W and H
are modified, the first object is resized as
specified and the rest are resized proportionally.

Resizing Picture Frames
If you resize a picture frame using Adjust, the
picture is resized too.

Text frame x| 20mm

11 Y| 20mm

Wamn ] H e
H[40mm HB“]U[EH:]ES@ESﬁ@

Fig. 8.24 - The info palette gives the size of the selected object. You can resize it by
changing the W and H values.
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8.8 Rotating objects

You can rotate text frames, picture frames and
lines. To rotate an object choose the Rotate tool
(fig. 8.23) then click Select and drag on any part
of the object until it is at the desired angle

(fig. 8.24). You may select a number of objects
either before or after choosing the Rotate tool,
and rotate them all by dragging on any object in
the selection.

The centre of rotation for the object or selection is
indicated by a small crosshair which is initially at
the centre of the object or selection, but may be
dragged to another position. Please note that if
you choose the rotate tool when there is no
selected object, the crosshair will not appear until
you select one or more objects.

You can rotate objects precisely using the info
palette or the Object>Modify dialogue box
(see 9.2).
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Using the Info Palette

When the Rotate tool is chosen, the info palette
provides a number of options concerned with
rotating objects (fig. 8.25).

A is the angle of rotation of the selected object or
group. The angle of rotation is in degrees and is
applied anti-clockwise. You may type in a new
value followed by Return to rotate the object to
the desired angle. Alternatively click on the up
and down icons to increase or decrease the angle
by one degree.

If there is a selection of objects A refers to the
first object selected. In this case, if A is changed,
the first object is rotated as specified and the rest
are rotated incrementally.

Clicking on the 3 x 3 grid will position the
crosshair at the same relative position on the
selected object or selection. The 9 points relate to
the centre, the fours corners and the centres of the
four sides.

If Crosshair is selected, objects are rotated about
the crosshair, otherwise they are rotated about
their centres.
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Fig. 8.24 - Use the Rotate tool to rotate the
object around the crosshair.
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Fig. 8.23 - The toolbox.

Fig. 8.25 - When the Rotate tool is chosen, the info palette provides options to set
the angle of rotation precisely and alter the position of the centre of rotation.
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8.9 Editing Objects using the Edit Menu

This section describes the options on the Edit
menu (fig. 8.26) concerned with objects. Some of
these options use the clipboard (fig. 8.27) which
can be viewed using the Clipboard option on the
icon bar menu (see 2.2).

The options Clear, Cut, Copy and Delete apply
to selected objects provided that no text or picture
is selected, otherwise they will apply to the text or
picture.

Clear
Clear deselects all selected objects.

Select All

Select all selects all objects on the current page.
This is only possible if there is no active frame,
otherwise it selects all the text in the active frame.

Cut frame/line/selection
Cut deletes selected objects, and places them on
the clipboard, overwriting the previous contents.

Copy frame/line/selection
Copy copies the selected objects onto the
clipboard, overwriting the previous contents.

Undo Deselect F8
Redo F9

Cut Textframe X
Copy Text frame *C

Paste AV
Delete Text frame *K
Embed object

Select all AMA
Clear 47 4
Find... F4

Fig. 8.26 - The Edit menu.
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Paste frame/line/selection

Paste inserts the object or objects that are on the
clipboard, into the document. After choosing
Paste, move the crosshair to the top left corner of
where the object is to be pasted, and click Select.

An object can be pasted into any Ovation Pro
document, not just the one from which it was cut
or copied. After pasting, the clipboard contents
remain unchanged.

This option is only available if the clipboard
contains an object or selection of objects.

Delete frame/line/guideline/selection
This option deletes the selected object or objects.

Undo/Redo

Undo cancels the last operation performed,
restoring your work to its previous state. Redo
cancels the last undo operation performed.

The Undo and Redo options when applied to
objects are identical to those described previously
for text (see 3.4).

The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or
pencil. Its two principal
advantages were that a
competent typist could

Fig. 8.27 - The clipboard containing a text frame.
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8.10 Embedding Objects

Normally in Ovation Pro objects are anchored to
the page, but Edit>Embed object allows you to
embed an object or group into a text story such
that the object moves with its associated text
when the text reflows.

How to Embed an Object

First draw the object anywhere on the page and
Cut or Copy the object so that it is placed on the
Clipboard. Now position the caret at the required

insertion point in the text (fig. 8.28), and choose
Embed object.

The embedded object is aligned with the text’s
baseline and behaves just like a large character
which moves with its surrounding text when
editing causes text reflow. The text after the caret

is shifted to the right to make space for the object,

and the line of text is shifted down to
accommodate its height (fig. 8.29).

)

The mechanical L“Jtyl:n:\fvritear, Which[j
originated in the USA about a century ago,
represented the first major advance over
pen or ncil. It two principal
advantages| were that a competent typist
could write much faster with a typewriter
than with pen or pencil and that the
gwriting  produced was consistent andm
clearly legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution’ in which typewriter
manufacturers made fortunes. Typing
became part of the school curriculum.
Despite its many advantages, the
mechanical typewriter suffered one major
L} = —H]
Fig. 8.28 - A text frame with the caret
positioned ready for embedding an object.
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Important Points

*« Embed object is only available if the
clipboard contains an object or group of
objects. If the clipboard contains a selection of
objects that are ungrouped, only the first object
in the selection will be embedded.

* You cannot ungroup an embedded group.

* You can resize an embedded object as you
would a normal object, but you cannot move it
except by moving the text in which it is
embedded.

* A text overflow will occur if you try to embed
an object into a frame that is too small to
contain it.

« After embedding, the clipboard contents
remain unchanged.

‘The ‘mechanical t_ypewriler, which |
originated in the USA about a century ago,
represented the first major advance over

pen or pencil. Ms twe principal

m

|advantag g gwere that a
competent typist could write much faster
with a typewriter than with pen or pencil
and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter
heralded an ‘office revolution’ in which

Fig. 8.29 - An embedded frame is aligned to the
text baseline. The text is shifted to the right and the
line moved down to make space for the object.
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Modlfymg an Embedded Object

If the embedded object is a frame, all the
normal operations can be applied to the text or
picture contents of the frame.

* From the Object>Modify dialogue box
(see 9.2) you can apply all options except for
X, Y and Lock.

* From the Object>>Text flow dialogue box you
can only apply Standoff.

* Border and Shape can be applied, but all other
options on the Object menu are not applicable.

* You can select an embedded object just like
normal text and Cut, Copy, Paste and Delete
it using options on the Edit menu.

* An embedded object can be placed in a
paragraph on its own by ensuring there is a
Return character directly before and after it
(fig. 8.30).

* Options on the Format dialogue box such as
Indent, Alignment, Space before and
Space after can be applied to a paragraph that
contains an embedded object. Tabs can also be
applied.

The mechanical typewriter, which ..
originated in the USA about a century ago, |
represented the first major advance over

pen or pencil. Its two principal
advantages o o
] m |
|
& £ £

were that a competent typist could write |
much faster with a typewriter than with |
pen or pencil and that the writing
produced was consistent and clearly
Icglble It was not surpnsmg then, that the
Fig. 8.30 - Embea'd'ed frame in a separate
paragraph with Centre alignment.
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* The bottom of an embedded object is aligned
with the text’s baseline, but you can shift it up
and down vertically using V.Shifton the
Modify text dialogue box. All other options on
this dialogue box are not applicable.

* Relative leading (i.e. that specified as a
percentage) is calculated from the size of the
text in the line and not from the size of the
embedded object.

Embedding Pictures Directly

If you drag a picture directly into a text story, a
picture frame is automatically embedded at the
pointer position, and the picture placed in it. If
there is sufficient space, the picture is imported at
its original size, otherwise it will be scaled
accordingly.
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8.11 Path Edit Mode

The shape of objects drawn using straight and
curved line segments, can be edited in Path Edit
Mode. You cannot edit the shape of rectangles or
ellipses without changing them to polygons first
using Object=>Shape (see 9.9).

To edit a path, choose the Path Edit Mode tool on
the toolbox (fig. 8.31) and click Select on the path
to be edited. This is not necessary if an object is
selected before entering this mode.

The end points of each segment are shown in blue
and may be dragged to reposition them (they will
snap to the grid if grid lock is enabled). You can
constrain movement to horizontal or vertical by
holding down Shift while dragging. When
moving a point you may use the cursor keys to
nudge the pointer in any direction.

Click Select over an end point to select the line
segment. Click Adjust on a point to add or
remove a line segment to or from the selection.
Selected end points and line segments are
displayed in red. If you have a number of end
points selected, moving one of them will move
the entire selection.

Path Edit Mode tool

BORSE>

| oy
|
L

210 OO

Fig. 8.31 - The toolbox.
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If you select the end point of a curved segment
the control point for the Bezier curve is shown in
orange and may be dragged to reposition it

(fig. 8.32). If you hold down Shift while you drag
a control point, the corresponding control point in
the next curve is also moved to keep the angle of
join constant.

To edit another path, click Select over it. If the
object you want to edit is obscured by another
object, holding down Alt and double-clicking
over the top object will select the one underneath.
You can keep doing this to select progressively
deeper objects.

If you find that editing paths is too slow because
surrounding text is continually being redrawn,
you can disable the redraws using an option on
Choices (see 14.5).

When you have finished editing your object,
leave Path edit mode by choosing the Select tool
on the toolbox.

Please note that in Path Edit Mode most of the
usual Ovation Pro operations are unavailable.

Selected
end point

T, . '-! S
Fig. 8.32 - An irregular object in path edit mode

with an endpoint selected. The two control points
may be dragged to change the angle of join.



102 Drawinc anD Epiting Osiects

Path Edit Options

In Path Edit Mode, the info palette provides a
number of options concerned with editing the
selected path (fig. 8.33). All of the options may be
applied to a single selected segment or to a
selection of segments.

The writable icons X and Y are the coordinates of
the selected end point. Coordinates are measured
from the ruler origin (normally the top left corner
of the page). These values may be modified to
change the position of the point. If there is a
selection of points, X and Y refer to first end
point selected. In this case, if X and Y are
modified, the first end point is moved to the
position specified and the rest are moved
incrementally.

Change to straight line changes the selected
curved line segment or move segment into a
straight line.

Change to curve changes the selected straight
line segment or move segment to a curved line.

Change to move changes the selected straight
line segment or curved line segment to a move
segment i.e. an invisible line.

Change to move

Change to curve
Change fo straight line \
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Make horizontal moves the selected end point
either up or down to make the line segment
horizontal (relative to the object rotation).

Make vertical moves the selected end point
either left or right to make the line segment
vertical (relative to the object rotation).

Add point adds a new segment into the selected
segment, of the same type as the selected
segment.

Delete segment deletes the selected segment.

Flatten path straightens the join between two
curved lines or a straight line and a curved line,
so that the tangent is continuous at that point.

Open/close path turns a closed path into an open
one, or an open path into a closed one.

Snap to grid aligns the selected end point to the
grid. The grid or grid lock must be enabled for
this option to work.

Make horizontal

Make vertical
/ Choose curve

| Path ectmode  X[55.31mm _}f‘/"L" ‘|._.|

[ 1.1 V[ 18.63mm| o] =X—|

Add pomr/ /
Delete segment
th

Flatten pa

Fig. 8.33 - The info palette in Path Edit Mode

Snap fo grid
Open/close path
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Secrion 8.11

Editing the Inset and Standoff Curves
The description above explains how to edit the
shape of objects constructed using straight and
curved line segments. However, you may also
edit the ‘curves’ which repel text inside and
outside a frame. This facility only applies to
frames, and not lines which are always
transparent and do not repel text. You cannot edit
the Inset or Standoff curves for rectangles or
ellipses without changing them to polygons first
using the Object<Shape option (see 9.9).
Clicking on Choose curve on the info palette

(fig. 8.33) allows you to toggle through the
following three modes:

Default mode: this allows you to edit
the shape of the object.

IF

Inset mode: this allows you to edit the
Inset curve.

Standoff mode: this allows you to edit
- the Standoff curve.

Both Inset and Standoff curves are attached to the
frame shape and are moved and resized when the
frame is moved and resized.

"he mechanical  typewriter, which'
originated in the USA about a century ago,
represented the first major advance over
pen or pencil. Its two principal advantages
were that a competent typist could write
much faster with a typewriter than with pen
or pencil and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter
heralded an ‘office revolution’ in which
typewriter manufacturers made fortunes.
Typing became part of the school
curriculum. Despite its many advantages,
the mechanical typewriter suffered one
major drawback. As soon as the typist hit‘
x

Fig. 8.34 - The outer line is the frame
guideline and the inner line is the default
Inset curve.
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Editing the Inset Curve

To edit the Inset curve, click on the object you
wish to edit and then toggle the Choose curve
button on the info palette until you are in the Inset
mode.

The Inset curve is positioned around the inside of
the frame and repels the text flowing in the frame.
By default it is the same shape as the frame, but
positioned 1mm in from the edge of the frame
(fig. 8.34). The default inset distance is specified
on the Modify dialogue box (see 9.1).

The frame outline is drawn in grey with the Inset
curve drawn in grey with the end points in blue.
You can now edit the Inset curve using the same
operations described on the previous pages

(fig. 8.35).

If you wish to reset the Inset curve to its original
shape and position, reset the Inset value on the
Modify dialogue box to 1mm.

%he .

mechanical typewriter, which
originated in the USA about a century
ago, represented the first major
advance over pen or pencil. Its two
principal advantages were that a
competent typist could write much
faster with a typewriter than with pen

or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then,
that the typewriter heralded an “office
revolution’ in  which typewriter
manufacturers made &
fortun

®

Fig. 8.35 - The Inset curve has been edited
causing the text to flow inside the new shape.
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Editing the Standoff Curve

To edit the Standoff curve, click on the object you
wish to edit and then toggle the Choose curve
button on the info palette until you are in the
Standoff mode.

The Standoff curve is the positioned around the
outside of the frame and repels text flowing
around the outside of the frame. By default it is
the same shape as the frame, but positioned Imm
out from the edge of the frame (fig. 8.36). The
default standoff distance is specified on the
Objectw Text flow dialogue box (see 9.7).

The frame outline is drawn in grey with the
Standoff curve drawn in grey with the end points
in blue. You can now edit the Standoff curve
using the same operations described on the
previous pages (fig. 8.37).

If you wish to reset the Standoff curve to its
original shape and position, reset the Standoff
value on the Text flow dialogue box to Imm.

The mechanical typewriter, which
nriginatﬁi in the USA about a cegtury ago,

represe nted the
first major
advance over pen
0 r pencil.
Its two principal
advanta ges were
that a compete
nt typist could
write much
faster with a
typewritg &r than

with pen or pencil and that the writing
produced was consistent and clearly

Fig. 8.36 - The inner line is the frame
guideline and the outer line is the default
Standoff curve.
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Editing Picture Runaround

The Picture option on the ObjectoText flow
dialogue box automatically modifies the default
Standoff curve so that it follows the shape of the
picture instead of the frame. Using the facilities
described in this chapter you may edit the
Standoff curve to fine-tune the runaround shape
to your exact requirements.

The mechanical typewriter, which
originated in the USAg about a century

ago, reoresented _Jl the first major
advance over pen or
pencil. Its t w o
principal advantag
es were ""ha! a
compete nt typist
could write
mu c h faster
with a typewriter
than with ® pen or pencil
and that ®he writing

produced was consistent and clearly
legible. It was not surprising, then, that the

Fig. 8.37 - The Standoff curve has been edited
causing the text to flow around the new shape.
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This chapter describes all the options on the Object menu concerned with
manipulating objects.
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9.1 Modify

The Object>Modify option (fig. 9.1) allows you
to alter the properties of selected objects.

The properties that can be altered depend upon
the type of objects selected, so 4 different
dialogue boxes may appear; Modify text frame,
Modify picture frame, Modify line or

Modify object. The latter is displayed if the
selection or group contains mixed types of
objects.

In a selection, the settings shown in the dialogue
box refer to the first object selected. If you alter
X, Y, Width, Height, Angle or Skew the first
object is altered as specified, and all other objects
are altered proportionally.

Only those properties that you change are updated
in the document when you click on OK.

The Modify option can also be used to set the
exact position of ruler guidelines (see 8.4).

CHAPTER 9

Modify text frame

* i - -

Modify...  F7 Origin X
Border... *F ‘ )
Text flow... AT Origin Y
Shape.. fH Width
Duplicate... *TD Height
Group j E] o 7\
Make local

““““““““““ Skew[ 0 o/
Front
Back __JLock
Snap to grid '

‘Radius
Inset [E’
Filcolour[  °H|

Aign [ Top
Columns [ 1] 7\ *H

Canoelll oK |

Fig. 9.2 - The Modify text frame dialogue box allows you

Fig. 9.1 - The Object menu. to alter the properties of fext frames.
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9.2 Modify Text Frame

This dialogue box is displayed if a text frame is
selected or if the selection contains only text
frames (fig. 9.2).

Origin X/Origin Y

These values are the coordinates of the top left
corner of the selected frame. They may be
modified to change the position of the object.
Coordinates are measured from the top left corner
of the page.

Width/Height

These values are the width and height of the
selected frame. They may be modified to change
the size of the frame.

Angle

This is the angle of rotation of the selected frame.
The angle is in degrees, and is applied clockwise
(figs. 9.3 & 9.4). You may type in a new value
followed by Return or use the up and down icons
to increase or decrease the angle by one degree.
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Skew

This is the angle of skew for the selected frame.
You can enter a new value or click on the up and
down icons to change the skew angle one degree
at a time. A positive value skews the frame to the
right (fig. 9.5) and a negative value, to the left
(fig. 9.6). The angle is specified in degrees and
must be within the range -80° to 80°.

If a multi-column frame is skewed, the columns
are also skewed.

Radius

This value is the corner radius of rectangular
frames (fig. 9.7). The radius must be a positive
value smaller than half the length of the shortest
side. This value is ignored if the frame is not
rectangular in shape.

Fig. 9.3 - Frame rotated 60°.

Fig. 9.4 - Frame rotated -45°.

century ago,

represented  the
first major advance

century

=| £1 B =] —8

The] mechanical The{ mechanical Thel mech- .
typewriter, which typewriter, which anical typewriter, |
originated in the originated in the which originated in
USA about a USA about a gthe USA about am

=) L=

Fig. 9.5 - Frame skewed 25°.

ago, century ago, rep-

represented  the resented the first
first major advance | _major advance /
[ =] - = = rd

Fig. 9.6 - Frame skewed -25°.

Fig. 9.7 - Frame with round corners.
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Inset

Inset is the gap between the edge of the frame and
the text flowing inside the frame. It prevents the
text from touching the sides and improves the

appearance of frames that have a frame border
(fig. 9.8 & 9.9). The default inset is 1mm.

The inset normally follows the shape of the the
frame, but it can be made any shape by editing
the Inset curve as described in the previous
chapter. This is useful if you want to have a
different inset on different sides of the frame. If
the inset curve is edited, the value for Inset is
blanked out. Resetting this value will reset the
inset so that it follows the shape of the frame.

Fill colour

This is the current background colour of the
selected frame. To change the background colour
click on the icon to the right of the colour to
display the standard Ovation Pro colour picker.
Frames can be made transparent by choosing
Transparent from the the scrolling window.
Transparent frames are ideal for overlaying text
onto graphics e.g. adding a caption to a picture.

=
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Align

This option specifies how text is aligned
vertically in the frame. The submenu provides
four options:

Top is the default setting and causes text to be
aligned with the top of the frame (fig. 9.10).

Bottom causes text to be aligned with the bottom
of the frame (fig. 9.11).

Centre causes text to be vertically centred in the
frame (fig. 9.12).

Justify inserts additional white space between the
lines of text so that it fills the frame vertically
(fig. 9.13).

Please note that Bottom, Centre and Justify do
not work if the frame is overlapped by another
object that causes the text to reflow. In this case
the text reverts to Top alignment.

= . ) =) B @ = 1]
hel ) mecham.caﬁl The] mechanical
pewriter, which typewriter, which The[ mechanical
iginated in the USA originated in the USA typewriter, which

bout a century ago,

about a century ago,

originated in the USA

resented  the  firsf] Hrepresented  the  firstf fabout a century agofl
jor advance over pen major advance over represented  the  first
pencil. lts two pen or pencil. major advance over
incipal advantages pen or pencil.
B & & & £ i) = £
Fig. 9.8 - Frame with Omm Inset.  Fig. 9.10 - Text aligned Top. Fig. 9.12 - Text aligned Centre.
@ = 8 @ = ) r a -y
Thd mechanical Thﬁl mechanical
l'Yp'EWFi‘ET, which The] mechanical typewriter, which
originated in the USA typewriter, which originated in the USA
gabout a century ago, geriginated in the USAq (hbout a century ago/

represented the first
major advance over
pen or pencil. Its two
principal  advantages
) =

-]

Fig. 9.9 - Frame with 2mm Inset.

about a century ago,
represented  the  first
major advance over

n or pencil.
E:Pe P =]

£
Fig. 9.11 - Text aligned Bottom.

represented the first
major advance over

pen or pencil.
i =

&
Fig. 9.13 - Text fully justified.
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Columns

This option specifies the number of columns in
the text frame. The default gutter (the space
between the columns) is Smm, but this and other
advanced settings can be modified from the
Column specification dialogue box (fig. 9.14)
which is opened by clicking on the icon to the
right of the Columns option.

Gutter width allows you to specify the gap
between the columns.

Column width allows you to specify the width of
the columns.

If Display column guides is selected, a vertical
line is drawn centrally in each gutter (fig. 9.15).

Guide width allows you to specify the thickness
of the column guides (fig. 9.16). You may choose
a standard width from the menu or enter your
own value at the bottom of the menu. The default
width is Thin which is the thinnest line possible
on the output device.

Guide colour allows you to specify the colour for
the column guide using the standard Ovation Pro
colour picker.
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Lock

This option locks the frame so that it cannot be
accidentally moved or resized by dragging. If a
frame is locked it has no handles, and the pointer
changes to the lock symbol if you try to move the
frame.

i 1

Fag 9.14 - Da!'ogue box for setting
column specification.

)
The] mechanical | advance over pen| |L0 £
typewriter, which| | or pencil. Its two Thin
originated in the| Principal ad- 0.25mm
glJSA  about  al | vantages were thatg di%min
century ago, | a competent typist '
represented  the| | could write much| [V 1mm
first ~ajor | faster with a 2mm
& B— & | 4mm
Fig. 9.15 - Frame with two columns and a
column guide.
Fig. 9.16 - Width
menu.
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9.3 Modify Picture Frame

This dialogue box is displayed if a picture frame
is selected or if the selection or group contains
only picture frames (fig. 9.17).

Operation is identical to that described for text
frames above except that the options Align and
Columns are not applicable to picture frames and
do not appear in the dialogue box and Inset
operates slightly differently for picture frames
than for text frames.

Inset

In a picture frame the inset is a border inside the
frame, of the width specified and the colour of the
frame fill colour. If a picture is made to fit a
frame (see 10.4), it will be scaled to fit inside the
inset (fig. 9.18 & 9.19). The default picture frame
inset is Omm, but this may be changed on the
Choices dialogue box (see 14.7).

CHaAPTER 9

The inset normally follows the shape of the the
frame, but it can be made any shape by editing
the Inset curve as described in the previous
section. This is useful if you want to have a
different inset on different sides of the frame. If
the inset curve is edited, the value for Inset is
blanked out. Resetting this value will reset the
inset so that it follows the shape of the frame.

Modify picture frame

ron [z53m
e
wen (2 7]
v [255

Aacus o |
Fill colour | “H|

Cancel'l oK |

Fig. 9.17 - The Modify picture frame dalogue box
provides options for altering the properties of picture frames.

Fig. 9.19 - Picture frame with 1mm Inset.
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9.4 Modify line

This dialogue box is displayed if a line is selected
or if the selection or group contains only lines.

Operation is similar to that described for text
frames above except that the options Radius,
Inset, Align and Columns are not applicable and
Width and Height have a different interpretation
for lines. There are also a number of new options
concerned with line style (fig. 9.20).

Width/Height
These values refer to the width and height of the
bounding box that contains the line.
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Line width

This option allows you to set the line width to any
of the predefined values from the menu or enter
your own value at the bottom of the menu

(fig. 9.21). The default width Thin is the thinnest
line possible on the output device. You can
change the default line width on the Choices
dialogue box (see 14.8).

Line colour
Allows you to set the line colour using the
standard Ovation Pro colour picker.

Pattern
This option displays a menu of dashed and dotted
line patterns that can be applied to lines

(fig. 9.22).

smmw

ley ine v F
0“9‘“ X @m Line width | hin o 0.25mm
. OriginY ; v Line colour - 8l 0.5mm
-:w&am FloolourW _[ 1mm
Height [23.9omm| _ Pattern [ —— 7] e
£k B ] 4m
Angle |I| YA Join [Bevelled. sl

éwanl—_l

Endcapl Butt

Fig. 9.21 - The Line width menu.

"=
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F:g 9.20 - The Modify line dialogue box.

Fig. 9.22 - The Pattern menu.
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Join

Join specifies how lines are joined together and is
only significant on thick lines. There are three
types of joins (figs. 9.23 & 9.24):

Mitred brings the outer edges of lines together to
a point,

Round rounds off the point where the lines join.
The default option Bevelled. cuts off the corner
where the lines join.

Start cap/End cap

These options specify what the end of lines look
like. Caps only apply to open paths and are only
significant on thick lines. The menu provides four
options (figs. 9.25 & 9.26):

The default option Butt, squares off the line at the
end point.

Round adds a solid semicircular to the end of the
line.

Square adds a square to the end of the line. The
square has half the width of the line.

~_Join
Mitred
Round

v Bevelled

7

Fig. 9.23 - The Pattern menu.

Fig. 9.25 - Start caps menu.

>

Fig. 9.24 - Mitred, Round and Bevelled joins.

Start caps |
v Butt

j=—=——
e —— —— —
Saie == <) Width
Triangle » Height >

Fig. 9.26 - Butt, Round,
Square & Triangle caps.
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Triangle adds a triangle to the end of the line,
allowing you to create lines with arrowheads.
This option has its own submenu (fig. 9.27)
allowing you to set the width and height of the
triangle. Choose one of the predefined values or
enter your own value at the bottom of the menu.
The Width and Height values should be
specified as multiples of the width of the main
line.

You can change the default Width and Height
values on the Choices dialogue box (see /4.8).
Please note that you cannot generate arrowheads
of a reasonable size on a line of width Thin; you
must have a line width of at least 0.25mm.

=

Fig. 9.27 - The Caps menu.
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9.5 Modify Object

This dialogue box is displayed if there is a group
selected or if the selection contains mixed types
of objects i.e. text frames, picture frames and
lines (fig. 9.28).

The options provided are those that are common
to all types of objects in the selection or group.
Operation of these options is identical to the that
described for text frames earlier.

 Origin Y [2088mm]
v [Fe57mm]
Angle[ 0 ]/
Skew| 0 [N

Fig. 9.28 - The Modify object dialogue box.
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9.6 Border

Normally the edges of frames are just guidelines,
and are not printed, but you can add a border
around the outside of a frame using the Border
dialogue box (fig. 9.29).

The scrolling window in the top left corner of the
border dialogue box, shows all the border styles
that are available. Use the vertical scroll bar to
scroll through the complete list, and click on the
border you wish to use. The chosen border is then
highlighted. It is possible to add additional simple
border styles (see Appendix F).

The option Border determines whether the border
is applied to the frame. The action of choosing a
border style, automatically selects this option. If
you want to remove a border from a frame, de-
select this option.
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The Colour option allows you to choose a colour
for the border using the standard Ovation Pro
colour picker.

Width allows you to set the border width to any
of the predefined values from the menu or enter
your own value at the bottom of the menu. The
default width Thin is the thinnest line possible on
the output device.

Click on OK to apply the border to the selected
frame or selection of frames. You can add borders

to rectangular, elliptical or even irregular frames
(figs. 9.30 & 9.31).

_ Frame border

[— |

I 1l
| e— |

|7 originated in the USA

|7 advance over pen or

[V Border  Colour I 5| width [ 1mm 5|
| shadow colour I 5| wicth [ 3mm |

The mechanical
typewriter, which

about a century ago,
represented the first major

pencil. Its two principal
advantages were that a
competent typist could

Fig. 9.30 - Border around rectangular frame.

Cancel|| oK |

—
The

Fig. 9.29 - The Border dialogue box.

mechanical
typewriter, which
originated in the USA
about a century ago,
represented  the  first
major advance over
pen or pencil. Its

Fig. 9.31 - Border around circular frame.
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Adding Borders to Specified Sides
You may use the four options in the top right
corner of the dialogue box to determine which
sides of the frame the border is to be applied
(fig. 9.32). By default all four options are
selected, causing the border to be applied to all
four sides.

Please note that these options only have an effect
on rectangular frames. Borders on elliptical and
irregular frames are always applied to the entire
frame outline.
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Drop Shadow

You can add a drop shadow to rectangular frames
by choosing the Shadow option (fig. 9.33). The
best drop shadow effect is obtained by applying a
border and a shadow (fig. 9.34). In this case the
border is always applied to all four sides of the
frame.

You may choose the shadow colour and width
using the options provided.

When Shadow is selected, the four options in the
top right corner of the dialogue box allow you to
choose the corner of the frame to which the
shadow is applied.

You cannot apply a drop shadow to an elliptical
or irregular frame.

T T
The mechanical
typewriter, which
joriginated in the USA
|about a century ago,
represented the first major
\advance over pen or
pencil. Its two principal
advantages were that a

competent typist could

7 sorowr Gats I | oo | i )
[V shadow Colour I ‘5| wiatn [ amm |

Ca'noeljl oK |

L
Fig. 9.32 - Border on top and bottom only.

The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or
pencil. Its two principal
advantages were that a
competent typist could

Fig. 9.33 - The Border dialogue box with Shadow selected.

Fig. 9.34 - Border and drop shadow.



116 Working witH OBIECTS

9.7 Text Flow

If a frame is positioned over another frame
containing text, the text may be repelled and flow
around the frame. Text flow controls how the text
flows around the frame (fig. 9.35).

It only applies to frames, and not lines which are
always transparent and do not repel text.

Runaround
These options control whether text flows around
the obstructing frame or behind it.

CHaPTER @

None causes the text to flow behind the frame
completely ignoring it (fig. 9.36).

Frame causes the text to flow around the frame
shape leaving a gap around the frame of whose
size is specified by Standoff (fig. 9.37).
Picture causes the text to flow around the shape
of the picture in the frame leaving a gap around
the frame specified by Standoff (fig. 9.38). It is
only available if the frame contains a picture.

The mechanical typewriter, which
originated in the USA about a century ago,
L=

represe “e over
pen or vantages
were th: Id write
much f: with pen
or pencil ced was
consiste{) Hvas not
surprisi ewriter
heraldeq n which
typewrit prtunes.
Typing school
curricul ntages,

the mechanical typewriter suffered one
major drawback. As soon as the typist hit

Fig. 9.36 - Runaround set to None.

The mechanical typewriter, which

originatc’__c‘i in the USA about a century ago,

Text flow Freprese

Runaround Text flow nted
the first

) None ) Wider side major
; advanc

@ Frame ) Left side & Tl vane
) Picture ) Right side pen or
: ; pencil.

Standoft e - s two
J Neither side prin-
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| advantages were that a competent typist

Cancel l OK | could write much faster with a typewriter

Fig. 9.35 - Text flow controls how text is repelled.

Fig. 9.37 - Runaround set to Frame.
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Picture Runaround

Choosing Picture runaround causes Ovation Pro
to trace the edge of the picture in the frame and
then generate a Standoff curve of the same shape.
The Standoff curve follows the shape of the
picture but stands off by the distance specified by
the value of Standoff (1mm by default).

You can set picture runaround for Draw files or
bit-image files such as sprites which may have a
mask or a solid background. In the latter case,
Ovation Pro detects the background colour and
ignores it when tracing the sprite outline.
Furthermore, it sets the Inset curve to the exact
shape of the picture thus masking out the
background colour.

Setting Picture runaround automatically sets the
frame to a transparent background so that it does
not obscure the text that flows behind it.

Please note that there is a delay when setting
picture runaround while the picture is traced. The
length of the delay depends upon the size and
complexity of the picture. You can press Esc at
any time to cancel picture runaround.

You can control how accurately Ovation Pro
traces the picture using the Runaround error on
the Choices dialogue box (see 14.7).

iThe mechanical typewriter, whichi

originat?_d in the USA about a century
ago, represented M the firs{ major
advance| over or
|pencil. |ts w o
principal dvantag
es werg hat a‘
‘compet§! ttypist|
could rite
m u c|h fapter with!
a typewfiter thap with
pen or gencil and that the

uced
was consistent and clearly legible. It was
|not surprising, then, that the typewriter

i |

Fig. 9.38 - Runaround set to Picture.
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Editing the Standoff Curve

The standoff normally follows the shape of the
frame or picture, but it can be made any shape by
editing the Standoff curve in path edit mode

(fig. 9.39). This is useful if you want to have a
different standoff on different sides of the frame
or if the text doesn’t flow around the picture
exactly as you require.

If the standoff curve is edited, the value for
Standoff is blanked out. Resetting this value will
reset the text flow so that it follows the shape of
the frame or picture again.

‘The mechanical typewriter, which |
originated in the US bout a century I
|ago, represente the first major
|advance over

|pencil. Its t w o
|principal advantag
|es wer zhat a
'compete- nt typist |
could write
m u c h faster with
|a typewrite® "~ than with
pen or pencil and that the
writin roduced

was consistent and clearly legible. It was‘
not surprising, then, that the typewriler‘

Fig. 9.39 - Editing picture runaround.
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Text flow
These options control how text flows around
frames and pictures. The text can flow around the

Wider, Left, Right, Both or Neither sides.

The mechanical typewriter, which
originated in the USA about a century ago,
AT =) )

represe

nted
the first
major
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pen or
pencil.
Its two
prin-
cipal
advantages were that a competent typist
could write much faster with a typewriter

Fig. 9.40 - Text flow to Left side.
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Fig. 9.41 - Text flow to Right side.

The mechanical typewriter, which
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with a typewriter than with pen or pencil
and that the writing produced was

Fig. 9.42 - Text flow to Both sides.

The mechanical typewriter, which
originalerq in the USA about a cenrlJury ago,

represented the first major advance over
pen or pencil. Its two prin- cipal

Fig. 9.43 - Text flow fo Neither side.
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9.8 Duplicate

Duplicate allows an object or selection to be
copied a number of times at specified horizontal
and vertical offsets (fig. 9.44). It is particularly
useful for creating tables and grids from lines or
frames.

Number of times specifies the number of
duplications to be made.

Vertical offset is the vertical shift made before
each duplication (fig. 9.45). This value should be
positive for a downward shift, negative for an
upward shift or zero for no vertical shift.

Horizontal offset is the horizontal shift made
before each duplication (fig. 9.46). This value
should be positive for a rightwards shift, negative
for an leftwards shift or zero for no horizontal
shift.

Gmcel ||7

Fig. 9.44 - The Dupllcal’e dialogue box.
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Making One Duplication

You can make one duplication of an object or
selection by pressing Ctrl Shift D. The offsets
used are the same as those set on the Duplicate
dialogue box.

Fig. 9.45 - The single line has been duplicated
to form a series of 10 lines, 3mm apart using:
No of times = 9, Vertical offset = 3mm,
Horizontal offset = Omm.

Fig. 9.46 - The single 10mm x 10mm frame has been duplicated to form a series of 8

frames, 5mm apart using:

No of times = 7, Vertical offset = Omm, Horizontal offset = 1 5mm.
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9.9 Shape

Shape opens a dialogue box which indicates the
shape of the selected object, and allows you to
change it (fig. 9.47).

Rectangle changes an ellipse or polygon into a
rectangle. The rectangle will be the same size and
shape as the bounding box of the original object.

Ellipse changes a rectangle or polygon into a
ellipse. The ellipse will have the same size
bounding box as the bounding box of the original
object.

Polygon changes a rectangle or ellipse into a
polygon. The polygon will have the same size
bounding box and shape as the original shape, but
will be constructed from straight and curved line
segments thus allowing a rectangular or elliptical
shape to be edited in path edit mode.

CHAPTER @

Regular polygon changes any object into a
regular polygon with the number of sides
specified (fig. 9.48). The polygon will have the
same size bounding box and shape as the
bounding box of the original object. If you wish
to draw perfect regular shapes such as triangles,
hexagons, octagons etc., your original object must
be perfectly square.

Fig. 9.47 - The Shape dialogue box.
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Fig. 9.48 - Regular polygons.
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9.10 Front/Back

If a number of objects occupy the same area of
the page, the object created last is said to be at the
top of the stack and obscures other objects lower
down the stack. The Front option brings the
selected object to the top of the stack. It is only
available when there is a single object selected
which is not already at the front.

The Back option pushes the selected object to the
bottom of the stack, hiding it behind any other
objects that occupy the same area of the page. It
is only available when there is a single object
selected which is not already at the back.

Grour/Uncrour 121

9.11 Group/Ungroup

Group turns a number of selected objects into a
single group. A group has a single bounding box
enclosing all the objects in the group, and can be
moved, rotated, duplicated, grouped etc. just as
though it were a single object (fig. 9.49). If the
group is resized by dragging, all the objects in the
group are resized by the same relative amount. If
the group contains frames, you may click in a
frame to edit its contents. Group is only available
when there is more than one object selected.

Ungroup breaks down a group into the objects
that make it up. It is only available when there is
a single group selected.

originated in the USA |
about a century ago, |
represented the first major‘
advance over pen or

ncil. Its two principal
advantages were that a‘
competent typist could |

I, = g1
The mechanical | write much faster with a
typewriter, which| |typewriter than with pen

or pencil and that the
writing produced was
consistent and clearly
legible. It was not
surprising, then, that the'!
typewriter heralded an
‘office revolution’ in

L

Three frames in a group.

=) £

Fig. 9.49 - The Group option allows a number of objects

to be grouped

together and manipulated as a single object.
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9.12 Make Local/Make Master

Make local converts a Master object generated
by the Master Pages, into a normal object that can
be edited in the usual way. Make local is only
available when the selected object or objects are
Master objects.

Make master converts a Master object that has
been made local, back into a Master object.
Make master is only available when the selected
object or objects are Master objects that have
been made local. Any changes that were made to
a local object are lost when it is made back into a
Master object.

Refer to Chapter 11 for more details about Master
objects.

CHAPTER @

9.13 Snap to Grid

This option causes the top left corner of the
selected objects to snap to the nearest grid point.
It only applies if either the grid or grid lock is
enabled.
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Working with Pictures
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This chapter describes how to import pictures into frames, and then
manipulate them in various ways.
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10.1 Importing Pictures

To import a picture, drag the picture file into a
frame. You may import standard Acorn Sprite
and Draw files, plus other popular formats
detailed in the Ovation Pro release notes. If you
try and load an unrecognised picture format, the
file will be interpreted as a text file and you will
be asked to confirm whether you wish to proceed
loading it (see 3.3).

A warning is given if there is insufficient memory
to load the picture.

The frame may be any shape, but must be
completely empty or already contain a picture (in
which case the old picture is overwritten). You
cannot import a picture into a frame that already
contains text unless all the text is deleted first,
otherwise the picture is embedded in the text (see
later).

Fig. 10.2 - Fit fo frame with aspect lock.

CHapter 10

The imported picture is centred and scaled to fit
inside the frame but keeping its original aspect
ratio i.e. its original shape. If the frame is
rectangular, the entire picture will be visible
(figs. 10.1 & 10.2), otherwise the the edges of the
picture are cropped to suit the shape of the frame
(figs.10.3 & 10.4),

Fig. 10.4 - Fit picture in irregular frame.
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Importing at a Specified Scale

If you hold down Ctrl when importing a picture,
the picture is imported at the scale specified in
Choices (see 14.7). By default this is 100% i.e.
the original picture size.

Embedding a Picture

If you drag a picture into a text frame, the picture
is imported into an automatically generated
picture frame which is embedded into the text at
the pointer position.

The picture is imported at its original scale, but
scaled down to fit if necessary.

Saving Pictures

If there is an active picture frame, the

Save picture option becomes available on the
File menu. This allows you to save the picture in
the frame to disc, or to another application. The
picture is saved in the same format that it was
loaded in.

Fig. 10.5 - A selected picture.
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10.2 Selecting Pictures

If a picture hasn’t been selected, operations such
as move, rotate, cut, copy etc. apply to the
selected frame and its contents. If the picture has
been selected, these operations apply to the
picture only; the frame remains unchanged.

Choose the Select tool on the toolbox and double-
click on a picture to select it. A three-pronged
resize tool is displayed over the centre of the
picture confirming that it is selected (fig. 10.5).

Click Adjust over a selected picture to deselect it.
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10.3 Moving Pictures

To move a picture within a frame, ensure that the
Select tool is active then double-click over the
picture to select it. Now click Select over the
picture (not over a handle) and drag it using the
Hand tool (fig. 10.6).

You can constrain movement to the vertical or
horizontal direction by holding down Shift before
dragging and keeping it held down while moving
the picture.

You can position the picture precisely using the
info palette or the Modify picture dialogue box
(see 10.7).

i il &
Fig. 10.6 - Use the hand tool to drag
the picture to a new position.
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Using the Info Palette

You may use the info palette (fig. 10.7) to
position the picture in the selected frame (in this
case the picture does not need to be selected). X
and Y are the offsets from the top left corner of
the frame to the top left corner of the picture, and
can be modified to change the position of the
picture. Press Return afterwards to update the
document.

Alternatively, click on the up and down buttons to
move the picture in the appropriate direction.

Note that the X and Y fields towards the left side
of the info palette refer to the picture frame,
whereas X and Y towards the right edge refer to
the picture itself.

Picture frame  X|37.82mm| W|42.33mm| Scale| 36.41

S %[omm  |[SA[ o

sl

1.1 ¥[21.73mm| H[49.11mm| Aspect| 100

< Y |[17.77mm|= . Fit

Fig. 10.7 - The info palette gives the position of the current picture. You can

reposition it by changing the X and Y values.

-
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10.4 Resizing Pictures

To resize a picture, ensure that the Select tool is
active then double-click over the picture to select
it (fig. 10.8). To resize the picture, drag the
handle at the end of the diagonal line on the resize
gadget. If Aspect lock is selected on the
Picture©oModify picture dialogue box, the
picture shape will be retained.

To resize the picture in the horizontal direction
only, drag the handle at the end of the horizontal
line. To resize the picture in the vertical direction
only, drag the handle at the end of the vertical
line.

You can resize the picture precisely by using the
info palette or the Modify picture dialogue box
(see 10.7).

Using the Info Palette

You may use the info palette (fig. 10.9) to resize
the picture in the selected frame (in this case the
picture does not need to be selected).

Scale is the scale of the current picture as a
percentage of its original size. You can enter a
new value or click on the up and down icons to
change the scale one percent at a time. Changing
this value affects scaling in both X and Y
direction, so the picture shape is not changed.

)

m

il

&
Fig. 10.8 - Drag the handles fo scale the picture.
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Aspect is the horizontal scaling of the picture.
You can enter a new value or click on the up and
down icons to change the aspect one percent at a
time. A value of 100% means that the picture is
displayed at its original shape. To stretch a
picture sideways increase this value, and to
squash a picture sideways decrease this value. For
example, to make a picture twice as wide as its
original, set Aspect to 200%.

Resizing Frame & Picture
If you resize a picture frame by dragging its
handle using Adjust, the picture is resized too.

Fit

This option scales the picture so that it fits the
frame. If the Aspect lock option on the
Modify picture dialogue box is selected, the
picture shape will remain unchanged. If

Aspect lock is not selected, the picture may be
stretched to fit the frame exactly.

| Picture rame  X[37.82mm| W[42.30mm|  Scale[ 36.41|= X[omm |=a] 0 |2
1.1 ¥[21.73mm| H 49.11MEW- 100 |3 ¥[17.77mm -}, Fit

Fig. 10.9 - The info palette allows the scale and aspect ratio of the picture in the
selected frame to be altered. The Fit option, fits the picture to the frame..
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10.5 Rotating Pictures

Whenever a picture frame is active, A on the info
palette (fig. 10.9) shows the angle of rotation for
the picture. The angle is in degrees and is applied
anti-clockwise. You may enter a new value and
press Return or click on the up and down icons to
increase or decrease the angle by one degree. The
picture is rotated about the centre of the frame.

Using the Rotate Tool

Ensure that the Select tool is active then double-
click over the picture to select it. Now choose the
Rotate tool (fig. 10.10) then click Select and drag
on any part of the picture until it is at the required
angle (fig. 10.11).

The centre of rotation for the picture is indicated
by a small crosshair, which can be dragged to a
new position if required.

AR R

¥

— Rotate tool
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Using the Info Palette

When a picture is selected and the Rotate tool
chosen, the options on the info palette (fig. 10.12)
apply to the rotation of the picture instead of the
object.

A is the angle of rotation of the picture. The angle
of rotation is in degrees and is applied anti-
clockwise. You may type in a new value followed
by Return to rotate the picture to the desired
angle. Alternatively click on the up and down
icons to increase or decrease the angle by one
degree.

Clicking on the 3 x 3 grid will position the
crosshair at the same relative position on the
frame containing the picture. The 9 points relate
to the centre, the fours corners and the centres of
the four sides.

If Crosshair is selected, the picture is rotated
about the crosshair, otherwise it is rotated about
its centre.

Fig. 10.11 - When a picture is selected you may use the rotate tool to
rotate the picture about the centre of rotation indicated by the crosshair.

Ratate
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. 10.10 - The Rotate tool.
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Fig. 10.12 - When a picture is selected ond rhe Rotate too!' chosen, fhe info pa."e#e
provides options concerned with rotating the picture.



-

Secrion 10.6

10.6 Cropping Pictures

The Crop tool (fig. 10.13) allows you to crop or
cut off unwanted edges of a picture leaving the
part you do want filling the frame.

Position the pointer at the top left corner of the
rectangle you want to retain and drag to the
bottom right corner (fig. 10.14). When you
release Select the part of the picture you have
chosen is ‘fitted’ into the frame (fig. 10.15) as
follows:

» If Aspect lock on the Modify picture dialogue
box is selected (see 10.7), the picture is scaled
to fit the frame without changing shape.

« If Aspect lock is not selected, the picture is
scaled to fit the frame precisely, changing its
shape is necessary.

Please note that you can’t crop a picture if it has
been locked.

Alfal

v

»

Crop tool

Sibdoqm’e] FlelF

Fig. 10.13 - The Crop fool.

@
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Fig. 10.15 - The cropped picture.
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10.7 Modify Picture

The Picture~>Modify picture dialogue box
(fig. 10.16 & 10.17) is available from the main
menu when a picture frame is active.

It can also be displayed by triple-clicking over a
picture.

Scale

This is the scale of the current picture as a
percentage of its original size. You can enter a
new value or click on the up and down icons to
change the scale one percent at a time. Changing
this value affects scaling in both X and Y
direction, so the picture shape is not changed.

CHapter 10

Aspect

This is the horizontal scaling of the picture. You
can enter a new value or click on the up and down
icons to change the aspect one percent at a time.
A value of 100% means that the picture is
displayed at its original shape. To stretch a
picture sideways increase this value, and to
squash a picture sideways decrease this value. For
example, to make a picture twice as wide as its
original, set Aspect to 200%.

Angle

This is the angle of rotation of the picture in the
frame. You can enter a new value or click on the
up and down icons to change the angle one
degree at a time. The angle is specified in
degrees, and a positive angle is applied anti-
clockwise.

Modify picture

. Scle 768 [% /.
Aspeat[ 100 ] % /.
Ange[ 0 | ¢

(i‘Notodc

I_Aspactiock _[Aubscale __|i-idep|cture

X[4tmm ] /5
y[ tom J s
/A Sew 0 |% /N

Q{:entre lock ) Lock

Fit | Cancel || OK

——

Nbdrfy pcture F6

Fig. 10.16 - The Picture menu.

Fig. 10.17 - The Modify
picture box provides
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XY
These show the offsets from the top left corner of
the frame to the top left corner of the picture. You
can enter a new value or click on the up and down
icons.

Skew

This is the angle of skew for the picture. You can
enter a new value or click on the up and down
icons to change the angle of skew one degree at a
time. A positive value skews the picture to the
right (fig. 10.18) and a negative value, to the left
(fig. 10.19). The angle is specified in degrees and
must be within the range -80° to 80°.

No Lock

No lock is the default setting and allows the
picture to be moved, resized or rotated from the
dialogue box, info palette or by dragging.

Centre Lock

If Centre lock is selected, the picture is locked to
the centre of the frame. The X and Y values
cannot be changed, nor can the picture be moved
from the info palette or by dragging.

Lock

This option locks the picture so that it cannot be
moved, resized or rotated from the info palette or
by dragging.

Fig. 10.18 - Picture skewed 25°
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Aspect Lock

If Aspect lock is selected, the Auto scale, Fit and
crop options will scale the picture to fit the frame
retaining its original shape. If Aspect lock is not
selected, the Auto scale, Fit and crop options will
stretch the picture to fit the frame precisely.

The diagonal scale gadget is also affected by this
option.

Auto scale

If Auto scale is selected, then re-sizing a picture
frame with Select causes the picture to be re-sized
too. This normally only happens if you re-size a
picture frame with Adjust.

Hide picture

If Hide picture is selected, the picture in the
frame is hidden and replaced by a cross. this may
be useful if the picture is slow to redraw.

Fig. 10.19 - Picture skewed -25°
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10.8 Options on the Edit Menu

The Edit menu (fig. 10.20) contains a number of
operations that you can apply to a selected
picture. If you do not have a selected picture, the
operations on this menu will apply to the frame.

To select a picture double-click on it so that the
resize gadget is displayed (fig. 10.21). Click
Adjust to de-select a picture.

Cut picture

Cut deletes the selected picture and places it on
the clipboard. The previous contents of the
clipboard are overwritten by this operation.

Copy picture

Copy copies the selected picture onto the
clipboard. The previous contents of the clipboard
are overwritten by this operation,

Paste picture

Paste inserts the picture that is on the clipboard,
into the active picture frame. A picture can be
pasted into any Ovation Pro document, not just
the one from which it was cut or copied. After

pasting, the clipboard contents remain unchanged.

This option is only available if the clipboard
contains a picture and there is a picture frame or
empty frame active.

SR A T e e
Undo Select picture F8
Redo F9
Cut Picture AX
Copy Picture rC
Paste AV
Delete Picture AK
Embed object
Select all ATA
Clear ’Zz
Find... F4

Fig. 10.20 - The Edit menu.
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Delete picture
This option deletes the selected picture.

Clear
Clear de-selects the selected picture.

Fig. 10.21 - A selected picture.
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Drag & Drop

Instead of using Cut, Copy and Paste to move or
copy a picture via the clipboard, you can use the
drag and drop facility to do this directly.

To use drag and drop, first select the picture you
wish to move or copy. Now press Alt and click
Select over the picture so that the drag and drop
tool is displayed. Now drag until the pointer is
over the required frame and release Select to
insert the picture. The destination frame must be
empty or contain a picture (in which case the
original picture is overwritten).

If you drag and drop within the same document,
the picture is moved, if you drag and drop to
another document, the picture is copied.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, the picture is
copied, if you drag and drop to another document,
the picture is moved.

If you drag and drop to something that isn’t an
Ovation Pro document, such as a directory
display or another application such as Draw, the
picture is exported to it.

If you start a drag operation and wish to cancel it,
press Esc.

Or1iONS ON THE EpIT MENU
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10.9 Object, Linking & Embedding (OLE)

The OLE facility allows you to transfer a picture
directly to another application for editing. Once
the editing is complete, the picture is
automatically transferred back to Ovation Pro.

To use OLE, press Ctrl and double-click on the
picture. Typically the picture might be a sprite or
Draw file, but can be any type of picture provided
a suitable editor is available. A suitable editor is
an application that can load and edit that type of
picture format. If an editor is available, it is
loaded and the picture transferred into it ready for
editing.

If no suitable editor for that type of picture is
available, the message No run action
specified for this filetypeis
displayed.

Once you have finished editing the picture, use
the standard save option in the editing package to
automatically transfer the picture back into
Ovation Pro.

CHarter 10
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This chapter describes how to create new documents, insert chapters,
insert and delefe pages, and edit master pages.
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11.1 Overview

Ovation Pro documents consist of one or more
chapters, each containing one or more pages.
Initially a new document consists of one chapter
containing one page, but new chapters and pages
may be inserted as required.

Pages are normally displayed one on top of the
other, with page and chapter breaks indicated by
broad grey lines.

Master Pages

Each chapter has a master page (2 master pages
in double-sided documents) which controls the
format of all the pages in the chapter such as the
paper size, margins, headers and footers. Master
pages enable you to create a template for the
pages in your document, ensuring a consistent
appearance is obtained throughout.

CHarter 11

Each page added to the chapter is based on the
master page for that chapter.

Master pages in Ovation Pro are dynamic. This
means that if the master page is changed, all the
pages in the chapter are instantly updated from
the master pages.

Master pages can be displayed and edited just like
other pages.

Master Objects

Frames or lines drawn on the master pages are
called master frames or master lines, and are
automatically inserted on all the pages in the
chapter. Normally, master objects can only be
modified on the master pages. If you want to
modify a master object on the document page,
you must make it local first (see 11.3).
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Default master frame

eelome

-4 e e 3 = TR e e

Textframe  X|10mm |W/[190mm
| 1.1 Y|1omm | H|277mm

N Bl 7|Y|

Fig. 11.1 - The active document window.
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Default Master Frame

Each master page normally has a default master
frame (fig. 11.1). This frame is used for the body
of the text in a document. It is automatically
linked to the master frame on the following page.

If you type or import text so that it flows over the
end of the default master frame, a new page is
inserted at the end of the chapter and the text
flows onto it. This process is called automatic
page insertion.

If you delete all the text from the default master
frame on the last page of a chapter, that page is
deleted. This process is called automatic page
deletion. The page is not deleted if there are any
additional objects on it i.e. if the page doesn’t
match its master page.

Current Page & Chapter

The current chapter and page number is shown in
the icon in the bottom left corner of the info
palette. The number is in the form c.p, where c is
the chapter number and p is the page number.

If there is more than one page visible in the
document window, the current chapter/page is the
one in the centre of the window.

Fig 11.2 - The Goto page dialogue box.
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Goto Page

You can go directly to any page in the document
by choosing Goto page on the Page menu. Enter
the required page number then press Return or
click OK (fig. 11.2).

Ovation Pro finds the page by searching from the
beginning of the document until the page number
is found. If you have a multi-chapter document
with duplicate page numbers, you should enter
the full chapter and page number in the form c.p.
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11.2 Creating New Documents

If you click on the Ovation Pro icon on the icon
bar, a new document is opened based on the
default master page. The default master page
defines an A4 page containing a default master
frame with 10mm margins all round.

If you wish to create a document with a different
layout, choose New on the icon bar menu

(fig. 11.3). This opens a dialogue box which
allows you to specify the format of the default
master pages for a new document (fig. /1.4). All
the settings for the default master page can easily
be changed at a later stage.

Page

Page is the page size, which is set to A4 by
default. You may choose another standard size
from the menu, or choose Other to specify a non-
standard size using the H and W options.

Please note that this option just sets the page size
in Ovation Pro, and does not set the paper size
for printing (which is done using the printer
drivers).
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Sideways

If Sideways is selected, the paper will be turned
on its side. So if you want to use A5 paper with
landscape orientation, choose A5 from the Paper
menu and choose Sideways.

Sideways swaps the paper width and height
dimensions, so it affects both standard and non-
standard paper sizes.

Sideways automatically enables sideways
printing, but this may be disabled if required on
the Print dialogue box (see 12.3).

Colour

Colour allows the paper background colour to be
specified using the standard Ovation Pro colour
picker.

If Bleed is enabled on the Print dialogue box
(see 12.3), the paper background colour will
extend 3mm over the paper edges.

New document

Ovation Pro

Page| A4 g H
Colour[ ‘Bl W
[ Default master frame
Columns [ 1| 7.\ ]

Top[ fomm ] teft[ fomm | Header| omm |

__|Sideways

Info P~
New...
Clipboard...
Choices...
Quit

Bottom | 10mm | Right [ 10mm | Foota'r"l
=1 |

__|Double sided

Gl || oK |

Fig 11.3 - The icon bar menu.

Fig 11.4 - The New dialogue box defines the default master pages.
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Default Master Frame

If Default master frame is selected, the master
pages will be created with a default master frame
which has the margins specified.

If Default master frame is not selected, the
master pages will be created without a default
master frame i.e. completely blank. In this case
you will have to draw all your own frames either
on the master pages or directly on the document
pages.

Columns is the number of columns in the default
master frame. Advanced options may be specified
on the dialogue box that is obtained by clicking
on the icon to the right of the Columns option
(see 9.2).

Top, Bottom, Left and Right specify the margins

around the default master frame i.e. they
determine the size and position of the frame

(fig 11.5).

Top margin

Header

Left Main Right

margin Frame margm

Footer

Bottom margin

Fig 11.5 - The page margins.
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Header and Footer specify the space reserved at
the top and bottom of the default frame into
which header and footer information may placed.
The header space is measured from the top of the
frame; the footer space is measured from the
bottom (fig 11.5).
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Double sided

If Double sided is selected, two master pages are
created; one for left-hand pages and one for right-
hand pages.

Typically this enables you to have a bigger inside
margin for binding, or to alternate the position of
page numbering so that it is always on the outer
edge (like the page numbering for this user
guide).

If Left is selected, the settings for Colour,
Columns and all the margins refer to the left-
hand master page only.

If Right is selected, the settings for Colour,
Columns and all the margins refer to the right-
hand master page only.

If Mirror is selected, the left and right master
pages use the same settings, except that Left and
Right margins change to Outer and Inner
margins (fig. 11.6).

Please note that Paper, H, W and Sideways must
be the same for both left and right master pages.

Quter Left Inner | Inndr Right
margin side miargin | margin side

3

Dutet
argin

Fig 11.6 - The page margins for a double-sided document.
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11.3 Editing the Master Pages

Choose Page~Edit master page (fig. 11.7)to
edit the master pages. A new document window is
opened showing the master page or pages for the
current chapter. The title bar of the new window
confirms that you are viewing the master pages.
You may use the vertical scroll bar to look at the
master pages for any other chapters that exist. The
chapter number for the currently displayed master
page is shown in the icon in the bottom left corner
of the info palette. If the document is double-
sided, there will be two master pages for each
chapter identified by and L or R after the chapter
number in the info palette.

The master pages may be edited just like normal
pages. You can type directly into the header or
footer spaces or draw other objects anywhere on
the page. When the master pages are closed, this
information will be automatically updated
throughout the chapter.

You can alter the size, shape and attributes of the
default master frame, but you cannot type or
import anything into it - the contents of the
default master frame can only be edited in the
document.

S B v B
Edit master pages “E
Page guidelines..

New chapter [
Modify chapter...
Delete chapter

Insert page...
Delete page...
Goto page... F5

Fig 11.7 - The Page menu.
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Frame Handling

If you draw a frame on the master pages and
leave it empty, the frame contents can be edited in
the document. Do this if you wish to put empty
guide frames on each page of the chapter.

If you draw a frame on the master pages and put
some text or a picture in it, the contents of that
frame cannot be edited in the document i.e. the
contents are determined by the frame on the
master page. This is useful if you want the same
text or picture to appear on each page of the
chapter.

Header and Footers
The same rules given above for frames also apply
to the headers and footers.

e [f they are blank in the master pages, they may
be edited in the document.

e If you enter text into them in the master pages,
they cannot be edited in the document.

Please note that you cannot import pictures
directly into the header or footer space, but you
can draw additional frames for pictures if
required.
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Page Guidelines

When you are viewing the master pages, the
Guidelines option on the Page menu becomes
available. This option opens a dialogue box
allowing you to change the paper size, colour and
margins for the current chapter (fig. 11.8).

The options available are identical to those on the
New dialogue box (see 11.4).

Closing the Master Pages

Click on the close icon to close the master pages
and update the document with the changes you
have made.

CHarter 11

Master Objects

Any objects drawn on the master pages will
appear on each page in the document. Objects
drawn on the left-hand master pages will only
appear on left-hand document pages and likewise
for right-hand pages. These objects are referred to
as master objects.

Master objects can be selected, but do not have
handles and cannot be modified in any way unless
they are made /ocal. To make a selected object
local, choose Make local from the Object menu
(fig. 11.9). Once an object has been made local, it
can be modified in any way and is not updated by
the master pages.

A master object that has been made local can be
changed back to a master object by choosing
Make master from the Object menu.

Page guidelines for chapter 2

PagelTﬂ H
Colour[  Hw

[V Default master frame

| Columns [ 1] | 7.\ 7

__|Double sided 10 Rightid (@ |

Top[ fomm |  Left[ 0mm | Header [ onm |
Botom | 1omm ] Right | tomm | Footer|_omm |

Modify... F7
Border... *F
Text flow... T
Shape... *MH
Duplicate... *TD
Group
Make local
i : Front
Back
Canoelj| oK | Sl

Fig 11.8 - The Guidelines box allows you to alter the master pages.

Fig 11.9 - The Object menu.
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11.4 Adding New Chapters

To insert a chapter, choose Before current
chapter or After current chapter from the
Page<New chapter menu (fig. /1.10).

The new chapter inherits the master pages from
the current chapter, but of course these may be
edited as described earlier.

When you insert a chapter, the Modify chapter
dialogue box is displayed (fig. 11.11).

Start on left and Start on right determine
whether the first page of the chapter starts on a
left-hand or right-hand page.

Start number is the page number for the first
page in the chapter.

Numeric, Roman upper and Roman lower are
the three page number styles available. They are
used whenever you insert a page number using
Page number on the Insert menu.

Omit header on first page and Omit footer on
first page allow you to omit the header or footer
on the first page of the chapter.

Click on OK to insert the chapter.

M)dl_l'! chapter 1
) Startonleft \)Stanonright_'
r Pam wmlv s el _..:._ . e
Start number : :

) Numeric ._) Roman upper . ) Roman lower

__| Omit header on first page
__| Omit footer on first page

Before current chapter... ; P [m
After current chapter...

Fig 11.10 - The Insert chapter menu. Fig 11.11 - The Modify chapter dialogue box.
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11.5 Deleting Chapters

Choose PageDelete chapter to delete the
current chapter.

Please note that you cannot delete a chapter if it is
the only chapter in the document.
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11.6 Modifying Chapters

You can use the Modify chapter option at any
time to change various aspects of the current
chapter (see 11.4).
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11.7 Page Insertion & Deletion

When editing text in the default master frame,
pages are automatically inserted when text
overflows at the end of the chapter. If text is
deleted leaving pages at the end of the chapter
empty, these pages are automatically deleted.

However, it is possible to manually insert or
delete pages.

Inserting Pages

To insert a page based on the master pages,
choose Page<Insert page. This opens a dialogue
box allowing you to specify the number of pages
to insert and where they should be inserted

(fig. 11.12).

Click on OK to insert the pages.

Please note that inserted pages are automatically
linked into the text flow. This causes text in the
default master frames of subsequent pages to flow
back into the inserted pages, and any blank pages
that are left at the end of the chapter are deleted.

This means that in some cases your document
will be unchanged after inserting pages. For
example, import 10 pages of text into the default
master frame of a new document. Now if you
insert 5 pages before page 1, you will create a 15
page document. However, the last 5 pages will be
blank and therefore automatically deleted. So the
final document will be the same as the original!

Note that if the last 5 pages had contained any
additional objects, they would not be deleted.

_ Insert page
o 1w
@ Before ) After
. page |I|
cance [_ox |

Fig 11.12 - The Insert page dialogue box.
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Deleting Pages

To delete a page, choose Page“Delete page. This
opens a dialogue box allowing you to specify the
range of pages to delete (fig. 11.13).

Click on OK to delete the pages.

This option deletes pages and any objects on
those pages, but it does not delete any text in the
default master frame. This text will flow onto the
next page and new pages will be automatically
inserted at the end of the the chapter to
accommodate the overflow.

This means that in some cases your document
will be unchanged after deleting pages. For
example, import 10 pages of text into the default
master frame of a new document. Now if you
delete all 10 pages, 10 new pages will be
automatically re-inserted to accommodate the
text.

Of course, if there were objects on the original
pages, they would be lost.

" Deletorompage | 1|

- cancel[| ok |

Fig 11.13 - The Delete page dialogue box.
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11.8 Examples

Examples of how to set up two typical types of
documents are given below.

Example 1

This is a single-sided document with just one
chapter. It has a header containing the document
name and a footer containing the page number.
Both name and number are centred (fig. 11.14).

1. Choose New from the icon bar menu and set
Header and Footer to 10mm.

2. Click on OK to close the dialogue box and
create the document.

3. Choose Page<~Edit master pages.

4. Type the document name in the header, and
align it to the centre using the appropriate icon
on the info palette.

5. Put the caret in the footer and insert the page
number using Insert©Page number (or press
Ctrl N). The page number is indicated by a #
on master pages. Align the page number to the
centre.

Document Name

Fig 11.14 - Example 1.
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6. Close the master pages using the normal close
icon on the title bar.

Now type or import the text for the document. As
each page is filled, a new page is inserted with the
name in the header and the correct page number
in the footer.
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Example 2

This is a double-sided document with multiple
chapters, and a wider inside margin to
accommodate the binding. It has a header
containing the chapter number and a footer
containing the page number. Both name and
number are positioned on the outside edges of the
pages (fig. 11.15).

1.

Choose New from the icon bar menu and set
Header and Footer to 10mm.

. Choose Double-sided and Mirror, then set the

Inside margin to 15mm

. Click on OK to close the dialogue box and

create the document.

. Choose Page>Edit master pages. Ensure that

you are viewing the left-hand master page,
which is indicated by 1L in the bottom left
corner of the info palette.

. Type Chapter 1 in the header of the left-

hand master page, and insert the page number
in the footer (as described above in Example

1).
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6. Use the vertical scroll bar to scroll down to the
right-hand master page. The icon in the bottom
left corner of the info palette will show 1R.

7. Type Chapter 1 in the header of the right-
hand master page, and align it to the right edge
using the appropriate icon on the info palette.
Insert the page number in the footer and align
it to the right edge.

8. Close the master pages using the normal close
icon on the title bar.

Now type or import the text for the document. As
each page is filled, a new left or right hand page
is correctly inserted.

To add another chapter, use the New chapter
option on the Page menu (see. 11.4). Ensure that
you set the correct starting side for the new
chapter, so that it follows on from the previous
chapter.

Chapter 1

Chapter 1

Fig 11.15 - Example 2.
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Ovation Pro uses RISC OS printer drivers to print documents exactly as
they appear on the screen, at any resolution that your printer can deliver.
To print a document, you must have a printer driver installed that is
suitable for your printer. A wide range of printer drivers are supplied with
your computer, and others are available separately from other suppliers.

The Mail Merge facility allows a document to be printed a number of times
merging different data into each printout. Typically this feature could be
used to print a standard letter to a number of different names and
addresses.
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12.1 Printers & Printer Drivers

Ovation Pro can print on any printer, provided a
suitable printer driver has been installed in the
printer manager, ! Printers. It is essential that
you choose the correct driver for your printer,
otherwise it will at best produce a poor quality
printout, or at worst deliver pure rubbish! Each
printer driver has a default configuration, such as
resolution and quality, and you may need to
change this to produce the results you require.

Connection

You should configure the printer driver to use the
correct interface for your printer. Normally this
will be the parallel interface, but you may also
print to the serial port, to the network or to file.

Resolution

Most printer drivers support a range of print
resolutions, so you must make a trade-off
between print quality and speed. Higher
resolutions give better print quality, but take
longer to print.

Quality

You can configure most drivers to print in mono
(black and white), grey scales or colour (if it is a
colour printer). The quickest results will generally
be obtained by printing in mono.

Please refer to your RISC OS 3 user guide for
details of how to install and configure printer
definition files.
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Page Size and Paper Size

The page size is the size of the page set in
Ovation Pro. The paper size is the size of the
paper that is fed into the printer.

It is very important that printer driver is set
up to have the same paper size as the paper
being fed into the printer.

Usually the paper size should be set to the same
page size used in Ovation Pro, but in some cases
they may be different. For example, you may
wish to print an A5 page on A4 paper, or printing
two A5 pages side-by-side on A4 paper.

Printing on Fan-fold Paper

A problem that often occurs on dot-matrix
printers is unexpected blank pages that appear
when printing on fan-fold or continuous paper.
This happens because the default page size in
Ovation Pro is A4, and this is larger than the
standard fan-fold paper length of 11 inches. So
the very bottom of the A4 page has to be printed
on an additional sheet of fan-fold paper.

The solution is to set the Ovation Pro page size
and the printer driver paper size to 11 inches long.
Also ensure that the printer dip-switch is set to 11
inch paper and no perforation-skip.

Landscape Pages

Normally, Ovation Pro prints each page of the
document upright on the paper. However, if the
page was set to be Sideways, it is printed
sideways on the paper i.e. the print option
Sideways is automatically selected (see 12.3).
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Print Margins

Most printers cannot print right up to the edges of
the paper i.e. there is a margin around the paper
on which the printer cannot print. You can view
this margin by selecting the Print margin option
on the ViewoOptions dialogue box. The print
margin is shown as a grey margin around the
page (fig. 7.5). The area inside the print margins
is the printable area. If the page size is bigger
than the paper size, the print margin will show the
area that cannot be printed.

If any objects on the page extend into the print
margin, they will not be printed. There are a
number of solutions to this problem:

e Redesign the page so that all objects fit wholly
within the printable area.

e If there is space at the opposite edge of the
paper, shift the page across when printing.
Options X and Y on the Print dialogue box
allow you to do this (see 12.3).

e Scale the page down when printing so that all
objects fit in the printable area. Any easy way to
do this is using the Fit option on the Print
dialogue box (see 12.3).

Note that the print margin is read from the printer
driver, so a printer driver must be loaded for it to
be displayed.

PrinTERS & PrinTER Drivers 151

PostScript Printing

When printing on PostScript printers, it is
important to be aware of how fonts are mapped
and downloaded.

e The ! FontPrint application allows Acorn
font names to be mapped to equivalent
PostScript font names. So if you print a font for
which there is a PostScript equivalent, the in-
built PostScript font will be used. This often
results in quicker and higher quality printing.

e If you print a font for which there is no mapping
to a PostScript equivalent, the Acorn font is
downloaded to the printer and retained for the
duration of that print job.

e You may use ! FontPrint to indicate that
certain fonts are to be downloaded to the printer
whenever ! Printers is started. The
downloaded font is retained until the printer is
reset. Use this option with care because
downloaded fonts take up large amounts of
memory in the printer.

Please refer to your computer user guide for more
details about font mapping and downloading to
PostScript printers.
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Print Speed & Memory Requirements
The time taken to print a page depends upon the
type of printer you are using and the complexity
of the page. PostScript and other laser printers are
usually the quickest printers. Inkjet and in
particular dot-matrix printers tend to be the
slowest.

You can normally speed up printing in a number
of ways:

e Reduce the print resolution. You could use a
lower resolution for draft printouts, then switch
to the highest resolution for the final copy.

e Reduce the print quality. If you are only
printing in black and white, ensure that your
printer driver is configured to mono (dot-matrix
and inkjet printers only).

e Free more memory before printing.

Most printer drivers print pages by ‘redrawing’
them at the printer resolution into the System
sprite area of RAM. That area is then dumped to
the printer. If there is insufficient memory to hold
the entire page in the system sprite area, the page
is printed in strips. Clearly the greater free
memory available, the fewer strips will be needed
and the faster the page will be printed.

The above description is not true for PostScript
printers, which generally need less free memory.
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If required, you can make extra memory available
in the following ways:

e Quit any other unneeded applications before
printing.

e Having configured ! Printers, quit it from
the icon bar to free memory used by the
application. The actual printing is done by a
module that remains active even after
! Printers has been removed.

e Change to a lower screen mode before printing.
Although the screen display may look poor, the
print quality will be unaffected.

Other ways of saving memory are described in
Appendix A.
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12.2 Basic Printing

To print a document, first ensure that the correct
printer driver has been loaded and configured.

Now choose File<Print to open the Print
dialogue box (fig. 12.1) which provides all the
basic print options.

The name of the current printer driver is
displayed in the title bar.

Print Setup

If you click on Print setup, the dialogue box
expands to display the advanced print setup
options (see 12.3).

Copies

Copies is the number of copies of each page that
you want to print. For a multi-page document,
each page in turn is printed the specified number
of times i.e. in the order 1,1,1, 2,2,2, 3,3,3 etc.

You may use the Collate option if you want
pages to be sorted into order automatically i.e. in
the order 1,2,3, 1,2,3, 1,2,3 etc.

Some printers, such as PostScript and other laser
printers, retain a copy of the printed image in
their memory, so printing multiple copies of the
same page takes only slightly longer than printing
one copy.
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Format
Choose the format of the printed pages from the
Print format menu (fig. 12.2).

Normal

Normal is the default format, and prints pages in
the order they appear in the document. Each page
is printed upright at 100% scale, and centred on
the paper. However, you may change the scaling,
orientation etc. using the advanced print options
(see 12.3).

_ Print (LBP4) _
Copies | 1] | Format| Normal i
® All pages JFrom ] to o
@ All sides U Left D Right
_|Pause _|Reverse _|Colate
Mo picturesi: . — Pamphiet
_ |Print setup . Set | Cancel || ’fmt Galley

Fig. 12.1 - Basic options on the Print dialogue box

Fig. 12.2 - The Print format menu.
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Pamphlet

Pamphlet prints 2 pages side-by-side on each
sheet of paper (fig. 12.3). The pages are printed in
such an order that when folded they create a
pamphlet with correctly ordered pages (fig. 12.4).
Typically this option is used to produce small A5
booklets printed sideways on A4 paper, although
other sizes may be used too.

By default each page is printed sideways at 71%
scale, and the pair of pages are centred on the
paper. These settings are suitable for printing an
A4 document on A4 paper, producing an A5
pamphlet. However, you may change the scaling,
orientation etc. using advanced print options

(see 12.3). For example if your document is AS,
the scaling should be set to 100%.

Your document may have any number of pages,
but the number of pages in the booklet will be
rounded up to a multiple of 4 pages. So if you
print 7 pages, you will get an 8-page booklet with
the last page blank. To obtain sensible results,
pamphlets should always start on a right-hand
page.

Fig. 12.3 - A 4-page document Pamphlet printed.

3
1

Fig. 12.4 - A folded 4-page pamphlet.
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To print the pamphlet, choose Front to print the
front side of the paper only, then turn the paper
over and choose Back to print the back side. So if
you have an 8-page document, choose Front to
print pages 8/1 on the first sheet and 6/3 on the
second. Turn the paper over and select Back and
Reverse to print pages 2/7 on the back of 8/1, and
pages 4/5 on the back of 6/3. You should now be
able to fold the sheets in half for a correctly
ordered booklet.

You may need to experiment to find the correct
way to turn the paper over, so that the back side is
printed correctly.

If you print the pamphlet with All sides selected,
it will all be printed on one side of the paper only.
This may be useful if you wish to print multiple
copies of the pamphlet on a photocopier.

Please note that when pamphlet printing you may
find that the edges of the document are not
printed because they fall in the print margin. In
this case you should select the Fit option, or
reduce the scale manually (see 12.3).
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Galley

Galley prints 2 pages side-by-side on each sheet
of paper (fig. 12.5). Galley printing is useful for

producing draft copies of documents at a smaller
scale and thus using less paper.

Pages are printed in the order they appear in the
document. By default each page is printed
sideways at 71% scale, and the pair of pages are
centred on the paper. These settings are suitable
for printing an A4 document on A4 paper,
producing an A5 pamphlet. However, you may
change the scaling, orientation etc. using
advanced print options (see 12.3). For example if
your document is A5, the scaling should be set to
100%.

Notice that pages are printed on the same sides as
they appear in the document. So if a document
starts on a right-hand page, the first page printed
will be a blank left-hand page. If you want to
avoid this blank page (fig. 12.6), you should set
the document to start on a left hand page using
Start on left on the Page~Modify chapter
dialogue box.
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If All sides on the Print dialogue box is selected,
each sheet is printed in turn on one side of the
paper.

You may print on both sides of the paper by using
the Front and Back options on the Print dialogue
box. Choose Front to print the front side of the
paper only, then turn the paper over and select
Back and Reverse to print the back side. So if
you have an 8-page document that starts on a left-
hand page, choose Front to print pages 1/2 on the
first sheet, and 5/6 on the second. Turn the paper
over and choose Back to print pages 3/4 on the
back of 1/2, and pages 7/8 on the back of 5/6.

You may need to experiment to find the correct
way to turn the paper over, so that the back side is
printed correctly. You may need to use the
Reverse option to reverse the order of printing
the back side.

Please note that when galley printing you may
find that the edges of the document are not
printed because they fall in the print margin. In
this case you should select the Fit option, or
reduce the scale manually (see 12.3).

Fig. 12.5 - A 4-page document Galley printed. Document starts on

right-hand page

1 2 3 4

Fig. 12.6 - A 4-page document Galley printed.
Document starts on left-hand page
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All pages
Select All pages to print all pages in the
document.

Select From to print the range of consecutive
pages specified in the two writable icons. Page
numbers specified should be the same as those
shown in the document. So if you have a
document whose start page is 8, you may print the
first 4 pages by specifying the range 8 to 11.

The page number of the current page (the one in
the centre of the document window) is shown on
the info palette and the File<Info dialogue box.

If your document has more than one chapter and
the page numbering is not contiguous, the page
number format must be specified in the form ¢ .n
where c is the chapter number and n is the page
number. So for example, if you have a document
with 2 chapters each starting at page 1, and you
wish to print the first 4 pages from chapter 2, you
should use the range 2.1 to 2.4.

All sides

All sides causes both left-hand and right-hand
pages to be printed.

Left and Right allow you to print either the left-
hand or right-hand pages. This enables you to
print double-sided documents by printing one
side, then turning the paper over and printing the
other.

If you are pamphlet or galley printing, All sides
causes both sides of each sheet to be printed. The
Left and Right options change to Front and
Back, and allow you to print either the front or
back of the sheets. This enables you to print
double-sided pamphlets or galleys (see the earlier
description of Pamphlet and Galley).

Pause

If Pause is selected, printing will pause between
each page printed until you click on Continue on
the Printing dialogue box.
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Reverse
If Reverse is selected, printing starts with the last
page instead of the first.

If your printer stacks pages face-up they will be
incorrectly order after printing. In this case you
can use Reverse to correct the page ordering.
You may also need to use this option when
printing the back side of double-sided documents.

Collate

If Collate is not selected, Ovation Pro prints
multiple copies of each page, so pages are printed
in the order 1,1,1, 2,2,2, 3,3.3.

If Collate is selected when printing multiple
copies, Ovation Pro prints multiple copies of the
document, so pages are printed in the order 1,2,3,
1,2,3, 1,2,3.

Some printers such as dot-matrix, take the same
amount of time to print each copy of a page. In
this case Collate may be used to stack the pages
in the correct order.

However, other printers such as PostScript, can
keep an image of the last page, and print multiple
copies of it very quickly without any further
reprocessing. In this case it is faster to leave
Collate not selected, so that multiple copies of
each page are printed consecutively.

No pictures

If No pictures is selected, Ovation Pro will
ignore pictures and just print text. Only the
picture frame guideline is printed. On some
printers such as PostScript, printing pictures is
very slow, so this option may be useful for
quickly printing draft copies.
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Set

All the options on the Print dialogue box are
stored in the document when it is saved. Click on
Set to set the values without actually printing
anything.

Print

Click on Print to print the document. The pointer
changes to an hourglass and the Printing
dialogue box is displayed (fig /2.7). It shows the
Page and Copy being printed, and if you are mail
merging, the current Record.

The green slider gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Click on Cancel to terminate printing. There is
only a limited amount of multi-tasking possible
when printing i.e. when the hourglass
occasionally turns back to the standard pointer, so
there may be a delay before Cancel takes effect.
Usually it is quicker to press Esc instead.

Click on Pause to pause printing. Again, there
may be a delay before Pause takes effect. When
paused, the Pause option changes to Continue
which you should click on to continue printing.

Fig. 12.7 - The Printing dialogue box.
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Printing Multiple Documents

You can print multiple documents by dragging a
selection directly from disc to the printer driver
icon on the icon bar.
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12.3 Advanced Print Setup Options

Select Print setup to expand the Print dialogue
box to display the advanced setup options

(fig. 12.8).

Fit

If Fit is selected, Scale is automatically set so that
the entire page fits inside the printable area. The

consequence of this is that your printed output
may become smaller, but all of it will be printed.

X and Y are automatically set so that the page is
centred within the printable area. However, if
Centre is also selected, the page will be centred
on the paper. This may result in the scale being
reduced further.

When Fit is selected, Scale, X and Y are shaded
and cannot be manually altered.

When calculating the scale, Fit takes Bleed and
Printers marks into account i.e. it ensures the are
within the printable area.
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Scale

Scale allows you to set how big the page is
printed on the paper. At 100%, the page is printed
at exactly the size specified in the document. So a
frame that is 100mm square in the document is
printed exactly 100mm square on the paper. To
print the page at half size, set the scale to 50%. If
you want to print an A4 page at AS size, set the
scale to 71%.

Aspect

Aspect allows you to set the horizontal scale of
the printed page. A value of 100% means that the
page is printed the same shape that it appears in
the document. To stretch the printed page
sideways, increase this value, or to squash it
sideways, decrease this value. So to print the page
10% wider, set Aspect to 110%.

Print (LBP4)

Copies [ 1] | Format| Normal *Hl
(@ All pages ) From to
@ All sides U Left ) Right
__|Pause __|Reverse ~_|colate
__|No pictures '
[V Print setup _
s [ w0 ] e[ 00 ]
[ centre X Y n |
_|sideways _ |Bleed __|Printers marks

| set | CancelJl Print |

Fig. 12.8 - The extended Print dialogue box.
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Centre

If Centre is selected, X and Y are automatically
set so that pages are printed in the centre of the
paper.

When Centre is selected, X and Y are shaded and
cannot be manually altered.

XY

X and Y are the offsets from the bottom left
corner of the paper to the bottom left corner of the
page (fig. 12.9). They allow you to accurately
position printed pages on the paper.

Bleed and Printers marks are taken into account
if they are selected.

Sideways

If Sideways is not selected, pages are printed
upright on the paper. This is often called portrait
printing.

If Sideways is selected, pages are rotated through
90° and printed sideways. This is often called
landscape printing. Sideways is automatically
selected if the page format in the document is
defined to be Sideways in the New or

Page guidelines dialogue boxes.

Paper

Page

X

Fig. 12.9 - X and Y specify the position of the
printed page on the paper.
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Bleed

If Bleed is not selected, the exact page area is
printed on the paper.

If Bleed is selected, the page area plus an extra
3mm margin all around the page, is printed.

If you want an object to go to the edge of the
paper, you must print the page on a bigger piece
of paper and trim it afterwards. Unfortunately
inaccuracies in trimming may result in a gap
along the edge of the paper. The solution is to
bleed the object off the page, then use the Bleed
option to print a slightly larger page. Trimming
the paper to the page size should then give perfect
results (fig. 12.10).

The amount of bleed may be changed in
AutoRun. !Choices (see 17.6).
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Printers marks

If Printers marks is selected, crop marks are
printed around the edges of the page (fig. 12.10).
These are used to trim a page to size when it has
been printed on a larger piece of paper. In
addition, registration marks are printed at the
centres of each side of the page. These are used to
help align separated film (for future use).

The thickness of the printers marks may be
changed in AutoRun. ! Choices (see 17.6).

Crop marks

Registration marks ——

Fig. 12.10 - Page showing Printers marks and
object bleeding off the edge of the page.
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Print Sheet

When the print format is set to Pamphlet or
Galley, the Print sheet option becomes available
and allows you to easily print individual sheets.
The Print sheet dialogue box shows the pages
that will be printed on the front and back of each
sheet of paper (fig. 12.11).

Sheet shows the sheet number that is currently
being displayed followed by the total number of
sheets required for the document. Click on the up
and down icons to step to other sheets.

Print sheet prints the current sheet. The options
Front and Back allow you to choose whether to
print the front or back of the current sheet.

Please note that the number of copies, scaling etc.
are all set on the normal Print dialogue box.

(@ Front ) Back

sheet[ 1 /A off 1

Cancel || Print sheet |

Fig. 12.11 - The Print sheet dialogue box allows

you to print individual sheefs.
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12.4 Background Printing

The standard mode of printing described above,
does not allow you to use the computer while
printing takes place. This is suitable when
printing has high priority and must be immediate
and fast. However, for less urgent print jobs, you
may wish to use background printing. In this
mode, printing will take longer, but you will be
able to continue doing other things while printing.
When printing in this way, printing progress and
options to pause and quit are provided by the
Printer queue window in the printer driver.

To use background printing you must configure
the printer driver for background printing. This is
done by selecting the Print in background
option on the printer driver Connection dialogue
box.

You must also configure Ovation Pro to use
queuing. This is done as follows:

e Load into a text editor such as Edit, ! Choices
from directory ! OvPro.AutoRun.

e Locate the following line:
printchoices(0,8505,250,0);
The first parameter is the print mode. By default
this is 0 which means normal printing. Change
it to 1 for queuing.

e Save !Choices.

e Double-click on ! Choices to make it take
effect.

BackcrounD PRINTING
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12.5 Mail Merge

The mail merge facility allows you to print a
document a number of times, merging different
data into each printout. You insert merge tags
into the text at the required places, and specify a
comma separate value (CSV) file which contains
suitable data. When you print, the merge tags are
replaced by the data. This process continues until
all the data has been exhausted.

Typically mail merge could be used to print a
standard letter a number of times, merging
different names and address into each copy.

CSV File Format

The data used for mail merge must be in CSV
format. Many applications output data in this
format, or if you wish you can create your own
CSV file.

A CSV file comprises a number of records
separated by a carriage return or line feed. Each
record comprises a number of fields each
separated by a comma.

field 1,field 2,field 3<CR>
field 1,field 2,field 3<CR>
field 1,field 2,field 3<CR>
field 1,field 2,field 3

The example above has four records each
containing three fields. Notice that a carriage
return is not needed after the last record.

If data in a field contains a comma, the entire
field must be enclosed in double quotes:

"field 1,2",field 3,field 4<CR>

The filetype of the CSV file may be set to Text or
CSV.
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A simple CSV file containing people’s names,
might look like this:

Smith,John,Mr,34567<CR>
Jones, Sue,Miss, 34985<CR>
Clarke,Ian,Mr,33450<CR>
Simpson, Linda,Mrs, 33986

Creating CSV Files

You may create your own CSV file by typing the
data in the format described above, in a text editor
such as Edit. Press Return at the end of each
record, and only insert spaces where they are
needed as part of the text in each field. Once the
data has been prepared it should be saved to disc.

Creating CSV Files in Ovation Pro
You may create CSV files using Ovation Pro in a
similar manner. However, when you save the file,

you must use File2>Save story to save the file as
plain ASCII text.

If you later reload the CSV file into Ovation Pro
for editing, you must ensure that any quotation
marks in the file are not converted to smart quotes
using the Smart quotes facility. If the CSV file
contains quotations marks, you should disable
Smart quotes on Choices (see 14.6).



Section 12.5

Inserting Merge Tags

Once you have prepared the CSV file, you should
create the Ovation Pro document inserting merge
tags where you want to insert data.

To insert a merge tag, position the caret at the
required position and press Ctrl Shift M to display
the Mail merge tag dialogue box (fig. 12.12).
Now enter the number of the field to be inserted
and click on OK. Fields are numbered from 1
upwards. A tag of the form [Merge n] is
inserted in the text, where n is the field number.
when the mail merge is started, the merge tag will
be replaced by the field whose number is
specified. This will happen for each record in the
CSV file.

The merge tag [Merge n], can be edited just
like normal text, but it behaves just like a single
character. You may apply effects and styles to the
merge tag, and these will be applied to the data
when it is merged.

Fig. 12.12 - The Mail merge tag dialogue box.
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Example CSV File & Document
A simple CSV file might look like this:

Smith,John,Mr,34567<CR>
Jones, Sue,Miss, 34985<CR>
Clarke, Ian,Mr,33450<CR>
Simpson, Linda,Mrs, 33986

The Ovation Pro document might look like this:

To: [Merge 3] [Merge 1]
Dear [Merge 2]
Thanks you for your valuable

order, ref. [Merge 4].

When you use mail merge, the first record printed
will look like this:

To: Mr Smith

Dear John

Thanks you for your valuable
order, ref. 34567.

The second record will be:

To: Miss Jones

Dear Sue

Thanks vou for your wvaluable
order, ref. 34985.

Notice the use of spaces between the merge tags,
and the last tag which is highlighted in bold.
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Starting the Mail Merge

To start the mail merge, first open the File“Print
dialogue box and set the number of copies and the
print format that you require. Once this has been
done, click on Set to set the options without
printing the document.

Now choose File>Mail merge to open the

Mail merge dialogue box (fig. 12.13). The name
of the CSV file to be merged should be entered
into the icon labelled CSV file. The easiest way
to do this is to just drag the CSV file into this
icon.

To perform the mail merge click on Print.
Ovation Pro will now print the document once
for each record in the CSV file. The current
record being printed is indicated in the Printing
dialogue box.

Before printing each page, the merge tags are
replaced by the data from the CSV file and the
text reflowed. If the fields in the data file are
longer than the merge tags, the text may overflow
its frame. To reduce the possibility of this
happening always ensure there is some blank
space at the bottom of text frames containing
merge commands.

The example CSV file and document shown on
the previous page are supplied with Ovation Pro.
Please refer to the release notes for more details.

Mq_jrl merge

. CSVfile [$ Software.Ovation.Documents.CSV|

oancec” Print |

Fig. 12.13 - The Mail merge dialogue box.
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The Ovation Pro spelling checker checks the spelling of words in the
document and identifies those that have been misspelt or mistyped. To help
you make corrections, it can suggest the correct speﬂing or allow you fo
browse through a dictionary for the correct word.

The spelling checker cannot identify correctly spelt words that are used in

the wrong context, so you should u|wqys read your documents carefu"y
after spellchecking.

This section also describes how fo create and maintain user dictionaries
and how to add words to the hyphenation exceptions dictionary.
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13.1 Dictionaries

The spelling checker works by checking the
words in a document against the words in the
currently loaded dictionaries. If a word can be
found in a dictionary, it is assumed that it is spelt
correctly.

Main Dictionary

The main dictionary !MainDict, contains over
67,000 UK English words covering basic
vocabulary. Each word ending is treated as a
separate word, so there are entries for walk,
walks, walker,walking, walkedetc. It
also contains many real names such as country
and city names. These names are capitalised in
the dictionary, so the spelling checker will insist
that they are correctly capitalised in the
document.

You may add any words to the main dictionary,
but it is recommended that any personal words
such as names of people, towns and roads, or any
specialist terms are put into user dictionaries.
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User Dictionaries

You may supplement the main dictionary with
any number of user dictionaries. These may
contain personal names, foreign words or
technical terms for use with specific documents.

For your convenience an empty user dictionary
called ! UserDict is supplied by default.

A special user dictionary called ! HyphDict is
also supplied. This contains hyphenation
exceptions and is used by the hyphenator, not the
spelling checker. However, it is maintained in the
same way as other user dictionaries (see 13.7).
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Rules for Capitalisation

When the spelling checker compares words in the
document against those in the dictionaries, it
takes the capitalisation of the words into account
i.e.whether the letters are in lower-case, upper-
case or a mixture of both.

The rules for capitalisation are as follows:

e A word in the document in all upper-case will
match with the same word in the dictionary,
regardless of the upper-case/lower-case format
of the word in the dictionary.

So the word introduction in the
dictionary will match with INTRODUCTION
in the document.

e A word in the dictionary in all lower-case will
match with the same word in all lower-case or
in lower-case with an initial capital.

So the word march in the dictionary will
match with march or March in the
document.

e A word in the dictionary in mixed lower-case
and upper-case will only match with the same
word in exactly the same format (or in all
upper-case as permitted by the first rule
above).

So the word PostScript in the dictionary
will only match with PostScript or
POSTSCRIPT in the document.

The general rule is that words that are valid in all
lower-case, must appear thus in the dictionary.

Check document...
Check from caret...
Check as you type

13.1 - The Spellcheck menu.
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Please note that dictionaries cannot contain more
than one copy of the same word, even if each
copy has a different lower-case/upper-case
format.

Loading & Attaching Dictionaries

If you spellcheck a document without loading any
dictionaries first, the ! MainDict and
!UserDict dictionaries are automatically
loaded. This arrangement should be suitable for
most applications.

Alternatively you may explicitly load the
dictionaries required using the option
Spellcheck<Dictionary (fig 13.1).

The process of loading a dictionary involves two
stages:

e The dictionary is physically loaded into
memory if it is not already in memory.

e The dictionary is attached to the current
document. This means that it will be used
when the document is spellchecked.

The names of the dictionaries attached to a
document are saved with the document. So when
the document is reloaded and spellchecked, the
appropriate dictionaries are automatically loaded
from disc.
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13.2 Check Story/From Caret

Choose Spellcheck<Check story to check all the
words in the current story against the words in the
currently loaded dictionaries. The check starts at
the beginning of the story and continues to the
end of it, irrespective of the position of the caret
or of selected text.

Alternatively, Spellcheck® Check from caret
will check the spelling of all the words from the
word containing the caret to the end of the story
or from the start of a selection.

Remember that if you have not explicitly loaded
any dictionaries, the !MainDict and
!UserDict dictionaries will be automatically
loaded for you.

If there are no spelling errors, the message

No spelling errors is displayed.
Otherwise the word is highlighted and the
Spellcheck dialogue box is displayed with the
queried word in the writable icon (fig. 13.2).
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Ignore

If you consider that the queried word, despite its
omission from the loaded dictionaries, is correct
as it stands, you may click on the Ignore option.
The spell check will then resume at the following
word.

Words that are ignored are placed in a special
dictionary embedded in the document called

! Ignore. If you spellcheck a document more
than once in the same session, words ignored in
the first spell check will not be queried again in
subsequent spell checks. This feature can save
considerable time.

Each loaded document that has been spell
checked may have its own ignore dictionary.

An ignore dictionary remains resident until the
document is closed or until the dictionary is
deleted using the Spellcheck<Dictionary
dialogue box. Alternatively you may use an
option on the Choices dialogue box (see 14.6),
which causes the ignore dictionary to be saved
with the document. The means that ignored words
will not be queried next time the document is
loaded and spell checked.

Spelicheck

| commission
omission
omitting

(@ Guess ) Browse
Browse | MainDict Fj|
-_Mdto| UserDict  “ff|

Replace | Add |

ommission|

ignore | _Cancel |

13.2 - The Spellcheck dialogue box.



Section 13.2

Guess

If Guess is selected, the window above the
queried word shows the words that the spelling
checker suggests may be the correct spelling. The
guesses are made on the assumption that one of

the following simple typing errors has been made:

e There is a single typing error.

e A pair of letters have been transposed.
e There is one missing letter.

e There is one extra letter

In the example dialogue box shown, the queried
word is omission, and one of the guesses is
correctly shown as omission.

If the queried word is incorrect and the intended
word is listed in the guess window, you can
replace the misspelt word in the document by
double-clicking over the intended word in the
guess window. The new word will replace the
misspelt word, taking the same upper-case and
lower-case format. The spell check will then
resume at the following word.

Browse

If Browse is selected, the window above the
queried word lists the words in !MainDict that
are adjacent to the queried word in the dictionary.
The default dictionary being browsed is
!MainDict, but this may be changed by
choosing any loaded dictionary from the Browse
menu.

Use the vertical scroll bar to browse through the
list of words. If the queried word is incorrect and
the intended word is listed in the browse window,
you can replace the misspelt word in the
document by double-clicking over the intended
word in the browse window. The new word will
replace the misspelt word, taking the same upper-
case and lower-case format. The spell check will
then resume at the following word.
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Replace

If the queried word is incorrect and the intended
word is not listed in the guess or browse window,
you may correct the misspelt word directly in the
writable icon. Alternatively click select over the
closest word in the guess or browse window to
transfer that word to the writable icon, where it
may be edited.

Notice that if Browse is selected, the browse
window is continually updated to show the words
adjacent to the queried word as it is edited.

When you have corrected the queried word, click
on Replace to replace it in the document and
continue the spellcheck.

Add

If you consider that the queried word is not only
correct but also sufficiently important to merit a
place in a dictionary, click on Add. The spell
check will then resume at the following word.

The dictionary to which the word is added is
shown in the icon to the right of the words

Add to. If you have not explicitly loaded any
dictionaries, the default dictionary to which
words are added is ! UserDict. This may be
changed by choosing another dictionary from the
menu. Please note that words are not physically
inserted into dictionaries until the spell check has
completed.

If the queried word is a capitalised word, its
initial capital is changed to lower case before the
word is added to the dictionary. This will allow it
to match with both lower case and capitalised
words in future spellchecks. Otherwise, the
queried word is added to the dictionary exactly as
it appears in the document.
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Cancel

You may cancel the spell check at any time by
clicking on Cancel. If any words have been
added to any dictionaries (except the ignore
dictionary) during the spellcheck, you will be
asked if you wish to retain the changes (fig. 13.3).

The End of the Spell Check

When the spell check has finished, you will be
asked if you wish to retain the changes made to
the dictionaries (fig. 13.3).
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13.3 Check Word

Choose Spellcheck®Check word to check the
spelling of just the word at the caret. If the word
is present in one of the loaded dictionaries you
will hear a beep, and no further action is taken.

If the word is not present in any of the loaded
dictionaries, the Spellcheck dialogue box is
displayed with the queried word in the writable
icon. The procedure for correcting the queried
word is the same as for Check story described
earlier.

When the queried word has been corrected or
ignored, the dialogue box is closed and the spell
check stops.

el

& L

X 7
a ¥

13.3 - Click on Yes to retain the changes made fo any

dictionaries during the spellcheck.
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13.4 Check Document

Choose Spellcheck=Check document to check
the spelling of all the word in all stories in the
document. The procedure for correcting queried
words is the same as for Check story described
earlier.
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13.5 Check as You Type

This checks the spelling of each word after you
have typed it. The word ends when you type a
space, tab, carriage return or punctuation mark.

If the typed word is absent from the dictionaries

currently loaded, a beep will be heard. At this

point you can:

e Ignore the warning if you consider the word to
be correct.

e Correct the spelling in the document.

e Choose Check word to use the facilities on the
Spellcheck dialogue box to correct the word.

Words are not checked if you move the caret off
the word before you have finished typing it, nor
are words created as a result of the insertion or
deletion of characters.
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13.6 Creating & Editing Dictionaries

The Spelicheck<Dictionary option opens the
Dictionary dialogue box (fig. 13.4). This allows
you to load, remove, create, delete and edit
dictionaries.

The small window lists all the dictionaries that
currently exist. Those that are loaded and attached
to the current document are ticked. Apart from
!MainDict, !UserDict and any other user
dictionaries you have created, this window will
often list two further dictionaries, ! HyphDict
and ! Ignore.

'HyphDict contains a list of words that are
hyphenated in a special way by the automatic
hyphenator (see 13.7). | HyphDict is
automatically loaded and attached to the current
document, but may be edited, deleted and re-
created just like any other dictionary.

The embedded dictionary ! Tgnore contains a
list of words that were ignored during previous
spellcheck operations on the current document.

! Tgnore may be edited and deleted just like
other dictionaries. Unlike other dictionaries,

! Ignore is normally deleted when the
document is closed, unless you choose to save it
with the document (see 13.2).

e, cre TR
|4 H}.i:d‘an:t By Load |R0!TIDVBJ
v MainDict Edit I Delote|

v UserDict
v lignore

~ Create | Cancel [ oK |
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Selecting a Dictionary

Most of the operations described below apply to a
selected dictionary. To select a dictionary, click
Select over its name so that it becomes
highlighted. You may only select one dictionary
at a time.

13.4 - The Dictionary dialogue box allows you to load,

remove, create, delete and edit dictionaries.
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Load

The Load option loads the selected dictionary (if
it is not already loaded), and attaches it to the
current document. A tick next to the dictionary
name indicates that it is attached, and will be
checked against next time the document is
spellchecked.

Remove

Remove, detaches the selected dictionary from
the current document, and if it is not attached to
any other loaded documents, removes it from
memory. This means that the selected dictionary
will not be checked against next time the
document is spell checked.

Please note that Remove does not actually delete
the dictionary.

P

13.5 - The Create dictionary dialogue box.
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Create

The Create option opens the Create dictionary
box (fig. 13.5), which allows you to create a
dictionary with the name specified.

A warning is given if you attempt to create a
dictionary with the same name as an existing
dictionary.

Delete

The Delete option deletes the selected dictionary.

Since this action is irreversible, you will be asked
for confirmation before the deletion takes place.
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Edit

Dictionary files cannot be edited directly in a text
editor since they are in a special compressed
format. Compression is essential to allow a
dictionary such as !MainDict to hold over
67,000 words in a file that is of manageable
length. The Edit option allows you to examine
and edit the contents of a dictionary.

Remember that most words in the dictionaries
should be in lower-case letters so that they will
match with all lower-case words or words with
initial capitals. If words in the dictionary have
capitals, the spelling checker will insist that
queried words are capitalised.

Click on Edit to open the Edit dialogue box for
the selected dictionary (fig. 13.6). Alternatively,
double-click on the dictionary name in the
scrolling window. The name of the dictionary
being edited is confirmed in the title bar.

The window in the dialogue box lists the words in
the dictionary in alphabetical order. You may use
the scroll bar to scroll through the list of words.
The number of words in the dictionary is shown
in an icon to the right of the window.

— |
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Add

To add a new word to the dictionary, simple type
it into the icon below the word list, and press
Return or click on Add. Your new word is
inserted into the dictionary in the correct place,
and highlighted in the word list. If you are adding
a number of words to the dictionary, remember to
clear the writable icon using Ctrl U, before typing
each new word.

Notice that as you type into the writable icon, the
word list continually updates, showing you the
words adjacent to it in the dictionary. This feature
may be used at any time to locate words in the
dictionary.

To add a word based on a word in the word list,
click Select over the word in the word list to
transfer it to the writable icon. Now edit the word
as required, then press Return or click on Add to
add it to the dictionary.

Delete

To delete a word, click Select on it so that it is
highlighted, then click on Delete.
Saving the Dictionary

Click on OK to save the dictionary with all the
changes you have made. Click on Cancel to close
the dialogue box without updating the dictionary.

13.6 - The Edit dialogue box allows you to edit dictionaries.
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Import & Export

In addition to adding words individually into a
dictionary, you may import words in bulk from
file. To do this, prepare an ASCII text file of
words, with each word separated by a carriage
return or line feed character. Now drag the file of
words to the Edit dialogue box, where it will be
merged into the existing dictionary. Please note
that with large dictionaries, this process may take
some time to complete.

To export all words from the current dictionary,
click Menu over the Edit dialogue box to open
the standard save box. Now drag the icon to disc
or to a suitable editor. The file will contain each
word separated by a line feed character.
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13.7 Hyphenation Exceptions

The special dictionary called ! HyphDict is
used by the automatic hyphenator to deal with
words that do not hyphenate correctly using the
standard algorithm. So if you find that a word is
regularly hyphenated incorrectly, you may add it
to ! HyphDict. This may be done in one of two
ways:

e If the word is added to ! HyphDict without
any hyphens, then it will be ignored by the
automatic hyphenation algorithm i.e. it will not
be hyphenated

e If the word added ! HyphDict contains one
or more hyphens, it will only be hyphenated at
one of the hyphens. So if you add the word
auto-matic, it will only be hyphenated
between auto and matic.

Please note that ! HypDict is only used when
automatic hyphenation has been enabled
(see 5.7).
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13.8 Relocating Spellcheck Dictionaries

Dictionaries are stored in the sub-directory called

Dictionary of the directory ! Words. The

location of ! Words depends upon how you have

installed Ovation Pro:

e If you have installed Ovation Pro to hard disc,
! Words is hidden away inside ! OvnPro.

e If you have installed Ovation Pro to floppy
disc, !Words will located on the second
floppy disc (since it is too big to fit on the first
one).

Relocating !Words

You can store ! Words in any location by moving
it from inside ! OvnPro and dragging it to the
required place. You must double-click on
!Words after moving it, to reset the path to the
new location.

CHapter 13

Spell Checking on a Network

A common requirement when running

Ovation Pro on a network is to allow users to
share !MainDict, but have their own user
dictionaries.

To do this, copy ! UserWords from the
Ovation Pro Program Disc 2, into the root
directory of each user, and double-click on each
copy to make them active. Whereas ! Words
contains dictionaries that are shared by all users,
!UserWords contains user dictionaries that are
local to individual users.

When Ovation Pro is re-run, each user can
browse the same shared version of |MainDict,
and add words to their own local copy of
!UserDict. Any new dictionaries created, are
saved locally in ! UserWords, and override any
other dictionaries in ! Words with the same name

If |MainDict is edited, it is automatically saved
locally in ! UserWords and overrides the
original shared version.
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This chapter describes the ways in which can customise Ovation Pro for
general use or for specific applications.

Stylesheets fully describe the format and style of documents. You can save
the stylesheet from a document and use it as a template for creating other
similar documents. You may also save a stylesheet so that it is used as
default for each new document opened.

Application Choices allow you to configure the application in various
ways. There is just one set of Choices that affects all documents.

Document Preferences allow you configure individual documents.

In addition to the above options, you may also customise the button bar
(see Chapter 16) and the menus (see Chapter 17).
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14.1 Stylesheets

The File<>Save stylesheet option opens a
dialogue box (fig 14.1), which allows you to save
a stylesheet for the current document. The
procedure for saving a stylesheet is identical to
that described previously for saving documents
(see 3.9).

The stylesheet describes the format and style of
the document from which it is saved, but it
doesn't have any actual contents. Whenever you
save a document, its stylesheet is automatically
saved with it. However, if you want to use the
same layout for other documents, you can save
the stylesheet separately.

A stylesheet may be re-loaded just like any other
document i.e. by double-clicking on it, or
dragging it to the Ovation Pro icon on the icon
bar.

So if you want to create a new document based on
the style of an existing document, save the
stylesheet from the document, then double-click
on the stylesheet to create a new document. Every
time you need to create a new document having
the same layout, just load the stylesheet from
disc.

Save as

[Dooumeno] oK

Fig. 14.1 - The Save stylesheet box.

—
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The following information is saved in stylesheets:
e Defined styles =
e Defined colours

e Master pages

e
e Objects on the master pages.
e View options, Grid and Zoom
e Toolbox and info palette position =
e Preferences
Please note that objects, text and pictures in the ™
document pages are NOT saved in stylesheets.
=3
=
-,
~
N
-
—
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14.2 Changing the Default Document

The File>Save as default option allows you to
overwrite the default document with the current
document. The default document is the blank
document that appears when you click on the
Ovation Pro icon on the icon bar.

To change the default document:

1. Click on the Ovation Pro icon on the icon bar
to open a blank document (or load any other
document whose layout you want to use).

2. Modify the document as required. Ovation Pro
uses a stylesheet to define the default
document, so you may change any of the
attributes that are saved in stylesheets
(see 14.1). Typically you might want to change
the page margins, document zoom, defined
styles or colours.

Note that the default document cannot contain
objects, text or pictures, except those on the
master pages.

3. Click on Save as default to save the current
document as the default document. You will be
prompted for confirmation before the old
default document is overwritten (fig. 14.2).

4. Click on the Ovation Pro icon on the icon bar
to open a new default document.

Fig. 14.2 - Confirmation box when using Save as default.
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14.3 Choices

Choose Choices from the icon bar menu to open
a dialogue box that allows the Ovation Pro
application to be configured (fig. 14.3).

Note that choices are attached to the application,
and affect all the documents that you create or
load i.e there is one set of choices for all
documents.

There are five groups of choices: General, View,
Text, Picture and Line. Click on the appropriate
icon in the scrolling pane at the left of the
dialogue box to display all the associated choices.
The choices are described on the following pages
of this user guide.

Once you are happy with the choices, click on
OK to apply them for the current session only.

Alternatively, click on Save to apply the choices
and save them so that they will be used by default
next time Ovation Pro is run. You will be
prompted for confirmation before the old choices
are overwritten.

In addition to the settings in the choices dialogue
box, clicking on Save also saves the order of the
tools in the toolbox.

Application choices

General choices

 Date format | %ZDY%ST %MO %CE%YR| |

Time format | %Z12:%MI%AM

' _|Load interactive help
|7 Give warnings

' _|save buffer Buffer size [ 8 |K |

Save |0ancel|| oK |

Fig. 14.3 - The Choices dialogue box.
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14.4 General Choices

General choices are associated with the general
operation of Ovation Pro (fig. 14.4).

Date Format

Date format sets the format of the date string
inserted by the Misc&Insert>Date option
(see 3.2). A full explanation of this format is
given in Appendix D.

Time Format

Time format sets the format of the time string
inserted by the MiscInsert>Time option

(see 3.2). A full explantion of this format is given
in Appendix D.

Save Buffer

If Save buffer is not selected, the undo buffer is
flushed whenever documents are saved.

If Save buffer is selected, the undo buffer is
saved with documents (see 3.4). This means that
when you reload the document, you can undo
operations that were performed in a previous
session. Another advantage is that when you
reload a document, the caret will be at the
position it was when the document was saved.

The drawback with this facility, is that documents
become longer in size than necessary.

Date format | %ZDY%ST %MO %CE%YR| |

Time format [ %ZI12%MI%AM |
__|save buffer Buffer size [ 8 |k
__|Load interactive help i

|V Give wamings =

Fig. 14.4 - General choices.

¥
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Buffer Size

Buffer size is the size of the undo buffer. The
larger the buffer size, the more operations can be
undone. Note that different types of operations
use different amounts of memory in the buffer, so
the the buffer size cannot be directly related to the
actual number of steps.

Please refer to Appendix I for more details about
the operation of the undo/redo facility.

Load Interactive Help

If Load interactive help is selected, interactive
help data is loaded when Ovation Pro is run.
Since the interactive help data is very large, by
default this option is not selected.

Please note that this option only takes effect when
Ovation Pro is run, so for it to take effect you
must remember to save the choices and re-run
Ovation Pro.

Give Warnings

Give warnings allows you to enable or disable
various warning prompts that are displayed in
certain circumstances.
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14.5 View Choices

View choices are associated with the way
Ovation Pro documents look on the screen

(fig. 14.5).
Flashing Caret

Flashing caret allows you to have a flashing
caret, making it easier to locate in the document.

Period

Period in the time in centi-seconds that the
flashing caret is switched on/switched off.
Attach Toolbox

If Attach toolbox is selected, the toolbox is
attached to the document window (see 2.6). If the
document window is moved, the toolbox moves
with it.

If Attach toolbox is not selected, the toolbox
becomes attached to the screen and doesn't move
with the document window. If the choices are
saved, the position of the detached toolbox is also
saved.

View choices
[ Fiashing caret
[V Attach toolbox
[V Attach info palette
[7 Instant updates on path edit

Fig. 14.5 - View choices.
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Attach Info Palette

If Attach info palette is selected, the info palette
is attached to the document window (see 2.7). If
the document window is moved, the info palette
moves with it.

If Attach info palette is not selected, the info
palette becomes attached to the screen and doesn't
move with the document window. If the choices
are saved, the position of the detached info palette
is also saved.

Instant Updates on Path Edit

If Instant updates on path edit is selected,
surrounding text is continually updated as paths
are edited in Path Edit Mode (see 8.11).

If Instant updates on path edit is not selected,
surrounding text is not updated until Path Edit
Mode is exited. This may be useful if path editing
becomes very slow due to the text reflows.
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14.6 Text Choices

Text choices are associated with text editing, text
styles and text frames (fig. 14.6).

Single Shift Font

Single Shift Font specifies the font used by the
single shift font facility (see 3.2).

Text Frame Inset

Text frame inset is the default inset used by text
frames (see 9.2). If you don't want text frames to
have an inset by default, set this value to 0.

Rename Styles

Rename styles controls what happens when text
containing defined styles is transferred to another
document containing the same style names, but
with different attributes.

If Rename styles is selected, a clashing style
name in the transferred text is renamed by adding
a number to the end of the name.

If Rename styles is not selected, a clashing style
name in the transferred text is discarded, and the
style in the destination document is used.

 Text handiing choices - T S
rSthesrlﬂfont| S s
b2 Textfmmemsetm *
[V Rename styles I_Flaname colours
[V Smart quotes - _]Save-gmredm'
_|PCstyledelete: -
‘[_ Overtype 5

Fig. 14.6 - Text choices.
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PC-style Delete

If PC-style delete is selected, the Delete key
behaves as the Copy key i.e. it deletes the
character to the right of the caret.

The Copy key then behaves as THome i.e. it
moves you to the start of the last page in the
document.

The Backspace key can be used as Delete.

Overtype

Overtype controls what happens when you type
while there is some text selected (see 3.6).

If Overtype is selected, the selected text is
deleted and replaced by the typed text.

If Overtype is not selected, the selected text is
de-selected and the typed text is inserted before it.

Rename Colours

Rename colours controls what happens when
text containing defined colours is transferred to
another document containing the same colour
names, but with different colours.

If Rename colours is selected, colours names are
renamed, otherwise they are discarded (operation
is the same as Rename styles above).
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Smart Quotes

If Smart quotes is selected, plain quotation
marks in imported text are converted to fancy
quotes (see 3.3), otherwise they remain
unchanged.

Save Ignored Words

If Save ignored words is selected, the dictionary
of ignored words generated by the spelling
checker ! Tgnore, is saved with the document
whenever it is saved. This means that when the
document is re-loaded, previously ignored words
are ignored when the document is spellchecked.
The drawback with this facility is that documents
become bigger in size.

If Save ignored words is not selected, the
dictionary of ignored words is not saved with the
document.
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14.7 Picture Choices

Picture choices are associated with picture
handling (fig. 14.7).

Picture Frame Inset

Picture frame inset is the default inset used by
picture frames (see 9.3).

Runaround Error

Runaround error controls how accurately
Ovation Pro traces the picture when using
Picture runaround (see 9.7). The value entered is
the average error for each pixel traced. Smaller
values will give more accurately traced pictures,
although the trace will then take longer to
complete.

Picture Import with Cirl

If you import a picture into a picture frame while
pressing Ctrl, the picture is imported at a pre-
defined scale (see 10.1). Picture import with
Ctrl specifies that scale. So, for example, if you
want to ensure that imported pictures are always
scaled to 75% of their original size, set Picture
import with Ctrl to 75%.

Fig. 14.7 - Picture choices.
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Centre Lock

If Centre lock is selected, the Centre lock option
in the Modify picture dialogue box will be
selected by default (see 10.7).

Aspect Lock

If Aspect lock is selected, the Aspect lock option
in the Modify picture dialogue box will be
selected by default (see 10.7).

Auto Scale

If Auto scale is selected, the Auto scale option in
the Modify picture dialogue box will be selected
by default (see 10.7).
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14.8 Line Choices

Line choices are associated with line drawing
(fig. 14.8).
Default Line Width

Default line width sets the default width for all
lines drawn in Ovation Pro. Choose a predefined
width from the menu, or enter your own value in
the field at the bottom of the menu (see 9.4).

Default Triangle Width

Default triangle width is the default width of the
triangle for lines with arrowheads. Choose a
predefined width from the menu, or enter your
own value in the field at the bottom of the menu.
The width is specified as a multiple of the line
width (see 9.4).

Default Triangle Height

Default triangle height is the default height of
the triangle for lines with arrowheads. Choose a
predefined height from the menu, or enter your
own value in the field at the bottom of the menu.
The height is specified as a multiple of the line
width (see 9.4).

B i R Rt TR
' Defautlinewidth [ Thn H |
Defaulttiangle wicth [ 2  H| |
Defautt riangle heignt [ x4 0|

el

Fig. 14.8 - Line choices.
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14.9 Preferences

Choose Misc<Preferences to open a dialogue
box that allows Ovation Pre document
preferences to be configured (fig. 14.9).

Preferences are attached to documents, so you
may have different settings for different
documents. When a document is saved, its
preferences are saved with it.

There are three categories of preferences:
General, View and Text. Click on the appropriate
icon in the scrolling pane at the left of the
dialogue box, to display all the associated
Preferences. The Preferences are described on the
following pages of this user guide.

Once you are happy with the preferences, click on
OK to apply them to the current document.

Alternatively, click on Save to apply the
preferences and save them so that they will be
used by default each time a new document is
opened. You will be prompted for confirmation
before the old preferences are overwritten.

Fig. 14.9 - The Preferences dialogue box.

PREFERENCES
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14.10 General Preferences

General preferences are associated with the
general setup of the document (fig. 14.10).

Document Units

Document units specifies the default units for the
document. You may choose millimetres (mm),
inches (in) or points (pt) from the menu

(fig. 14.11). The chosen units are used whenever a
measurement is entered into a dialogue box or
menu. They are also used for the page rulers and
tab ruler.

Start Chapter Number

Start chapter number is the chapter number for
the first chapter in the document. If you split a
document into a number of separate files, you
may need to use this option to ensure that each
section starts with the correct chapter number.

Chapter/Page Separator

Chapter/page separator is the character used to
separate the chapter number and page number.
This option is for future expansion only, and has
no effect in this release.

. Document units Wﬂ {
Startchapmf number El
aw_apterfpag_g_ggpamtor Ll
__|Auto save s every-mms = }

| _lProlmtfcrautosavs TR Ay

oo SO S N e ) S S T R

Fig. 14.10 - General preferences.
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Auto Save

If Auto save is selected, the document will be
automatically saved at the interval specified.

If Prompt for auto saved is not selected, the
document will be saved without any user
intervention required.

If Prompt for auto save is selected, the normal
Save box will be displayed before the document
is saved. Click on OK to save the document, or
click outside the Save box to cancel.

Please note that Auto save does not operate if the
document as never been saved, or if it has not
been modified since it was last saved.

Fig. 14.11 - The Units menu.
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14.11 View Preferences

View preferences are associated with the way the
document looks on the screen (fig. 14.12).
Pasteboard Width

This is the width of pasteboard added to each side
of each page. The width of the pasteboard above
and below each page is fixed at 10mm.

This option does not enable the pasteboard, which
is done using an option on the View©>Options
dialogue box (see 7.3).

Ruler Origin X/Y

The ruler origin is normally at X =0, Y =0 i.e. in
the top left corner of the page. You may change
the ruler origin by modifying these values. All
object coordinates in Ovation Pro are measured
from the ruler origin.

Snap to Ruler Guidelines

If this option is selected, the edges of objects that
are moved or resized will snap to ruler guidelines
(see 8.4).

This option is automatically disabled if grid lock
is selected.

- View preferences
Pasteboard width 1

: Ruierongm)(
| PRuleroriginy [ omm_]
[V Snap to ruler guidelines
-.[—Snaptoobiecis'
'(‘chmanesmfront

1o back

Fig. 14.12 - View preferences.
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Snap to Objects

If this option is selected, the edges of objects that
are moved or resized will snap to the edges of
other objects (see 8.4).

This option is automatically disabled if grid lock
is selected.

Guidelines to Front/Back

This option determines whether ruler guidelines
are drawn in front of all objects or behind all
objects (see 8.4).
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14.12 Text Preferences

Text preferences are associated with text styles
and formatting (fig. 14.13).

Baseline Grid Spacing

This specifies the spacing of the baseline grid
(see 5.4).

Baseline Grid Origin

This specifies the origin of the baseline grid,
measured from the top of the page (see 5.4).

Superscript Size

This specifies the superscript size, as a percentage
of the normal character size (see 4.4).

Subscript Size
This specifies the subscript size, as a percentage
of the normal character size (see 4.4).

Small Caps Size

This specifies the size of small caps, as a
percentage of the normal character size (see 4.6).

Decimal Tab Character

This option specifies the character that is aligned
to decimal tabs (see 5.5).

Text handling preferences

Baseline grid spacing
Baseline grid origin
Superscript size @%
Subscript size [ 65 |%
Small caps size %
Decimal tab character | . |

Fig. 14.13 - Text preferences.
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Defined Colours

15.1 Overview

15.2 Editing Colours
15.3 Colour Models
15.4 Colour Charts

This chapter describes how to define your own colours, and add them to
the standard Ovation Pro colour picker.
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193
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198
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15.1 Overview

Whenever a colour is chosen in Ovation Pro, it is
chosen from the standard colour picker (fig. 15.1).
The colour picker allows a colour to be chosen
from the default set of colours, and an optional
tint applied (see 4.5).

There are two main advantages of using named
colours:

e They can be applied quickly and consistently
throughout the document by choosi % their
names. Without a name, a colour would have
to be applied by setting its RGB value, which
is slow and prone to error.

e If you're not happy with a colour used
throughout the document, you can just edit the
definition in one place and all occurrences of
the colour are updated throughout the
document.

This chapter describes how to add, remove or edit
colours on the colour picker.

L Colourpicker |

[l Black

[ Jwhite

Transparent

W Red

B
[l Blue

W cyan

[l Magenta

[]Yellow

/

Current colour—

Previous colour —|

Tint [100 % /_\ “EN

N\
Cancél ]I oK |

10

70

80

90
v 100

Fig. 15.1 - The standard Ovation Pro colour picker.

Tint menu
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15.2 Editing Colours

Choose Misc=Edit colour to display the
Edit colour dialogue box (fig. 15.2). This box
displays the colours available in the scrollable
window,

Editing operations apply to the selected colour,
which is highlighted in the window. To select a
colour, click Select over it.

/) Transparent
[l Red
[l Green
Hl Biue
{ll Cyan
[l Magenta
[] Yellow

New | Rename| Delets | Cancel [ 0K |

Fig. 15.2 - The Edit colour dialogue box.
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New

To create a new colour, choose New and type the
name of the colour into the New colour dialogue
box (fig. 15.3). The name must not be the same as
any existing colour name.

If there is a colour selected when you choose
New, the new colour will be based on the selected
colour. However, you may base the new colour on
any existing colour, by choosing the colour name
from the menu (fig. 15.4).

Click on OK to create the new colour and close
the dialogue box. The colour you have created is
added to the list of colours in the window, and
automatically selected ready for editing.

Basedon | Black

Fig. 15.3 - The New colour dialogue box.

2
I

Cyan
Magenta
Yellow
Registration

Fig. 15.4 - Base new colour on colour from menu.
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To rename the selected colour, click on Rename
to open the Rename colour dialogue box

(fig. 15.5). Type in a new name and click on OK.

Please note that you cannot rename the colours
the colours Black, White, Transparent or
Registration or those that were created from the
colour chart.

Delete
Click on Delete to delete the selected colour.

Please note that you cannot delete the colours
Black, White, Transparent or Registration.

Rename colour
Old name | Green
New name [ | |

Canoelll oK ||

Fig. 15.5 - The Rename colour dialogue box.
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Chart

To create a new colour based on a colour from
one of the standard Ovation Pro colour charts,
click on Chart (see 15.4).

Edit
To edit the selected colour, click on Edit.

If the colour was created using New, the colour
model dialogue box will be displayed (see 15.3).

If the colour was created using Chart, the colour
chart dialogue box will be displayed (see 15.4).
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15.3 Colour Models

When you click on Edit, the Colour choice
dialogue box is displayed (fig. 15.6). This allows
you to specify a colour from one of three colour
models: RGB, CMYK or HSV.

Please note that if the selected colour was
originally chosen from the colour chart, the
Colour chart dialogue box is displayed instead
(see 15.4).

RGB Colour Model

This colour model specifies colours by mixing
Red, Green and Blue light (fig. 15.6). This is the
default model used for new colours.

There are 6 ways of choosing a colour in the RGB
model.

e Drag the Red, Green or Blue sliders. As you
move a slider the resulting colour is shown in
the box at the bottom left of the window. At the
same time, the numeric values change to show
you the percentages of the colours chosen.

e Click anywhere in the colour slice, or drag
continuously around it.
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e Type in the Red, Green and Blue values
directly. After typing a value you must enter it
by press Return, Tab or the up/down cursor
keys. Pressing Return in the Blue field, is the
same as clicking on OK.

e Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,
changes the values by 0.1%.

e Click on a standard desktop colour directly.
e Click on None to create a transparent colour.

In the RGB model, the Colour slice is a plane
through the RGB colour cube. The slice is taken
with a single constant colour. In the example
shown, the constant colour is Blue at 100%.

The colour slice shows all the colours available
by varying the Red and Green components, but
keeping the Blue component constant.

Click on OK to apply the colour and close the
dialogue box.

Click here to
choose RGB Ty

Colour slice — |

Drag on sliders to=—_|
change values \

Result of co."ourh_\ ..:

mix

- Click to change
values

| Constant
component

——t—Type values in

irectly

: ,‘\ Click to choose a
‘| standard colour
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CMYK Colour Model

This colour model is often used when you want to
create colour separations for four-colour process
printing. Click on CMYK to choose this model

(fig. 15.7).

There are 5 ways of choosing a colour in the RGB
model.

Drag the Cyan, Magenta, Yellow and Black
sliders. As you move a slider the resulting
colour is shown in the box at the bottom left of
the window. At the same time, the numeric
values change to show you the percentages of
the colours chosen.

Type in the Cyan, Magenta, Yellow and
Black values directly. After typing a value you
must enter it by press Return, Tab or the
up/down cursor keys. Pressing Return in the
Blue field, is the same as clicking on OK.

Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,
changes the values by 0.1%.

Click on a standard desktop colour directly.

Click on None to create a transparent colour.

Click on OK to apply the colour and close the
dialogue box.

Click here to— =

choose CMYK
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Fig. 15.7 - The CMYK colour model.
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HSV Colour Model

This colour model is often used by artists

(fig. 15.8). You start with the basic colour, and
then add elements of white and black to get the
exact colour. Hue is the basic colour. Saturation is
the amount of white added to the colour. Value is
the amount of black added to the colour i.e. the
brightness.

There are 6 ways of choosing a colour in the RGB
model.

e Drag the Hue, Saturation or Value sliders. As
you move a slider the resulting colour is shown
in the box at the bottom left of the window. At
the same time, the numeric values change to
show you the percentages of the colours
chosen.

e Click anywhere in the colour slice, or drag
continuously around it.

e Type in the Hue, Saturation or Value values
directly. After typing a value you must enter it
by press Return, Tab or the up/down cursor
keys. Pressing Return in the Value field, is the
same as clicking on OK.
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e Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,
changes the values by 0.1%.

e Click on a standard desktop colour directly.
e Click on None to create a transparent colour.

In the HSV model, the Colour slice is a surface
through a colour cone. The slice is taken with one
of the components constant. In the example
shown, the constant component is Value at 100%.

The colour slice shows all the colours available
by varying the Saturation and Hue components,
but keeping the Value component constant.

Click on OK to apply the colour and close the
dialogue box.

Click here to —
choose HSV

Colour slice — |

=1
==l

N

Result of col'our-._,_\ e

mix

Drag on sliders to
change values

Click to change
values

| Constant
component

) *—-Lype values in
irectly

™ Click to choose a
standard colour

Fig. 15.8 - The HSV colour model.
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15.4 Colour Charts

The Ovation Pro Colour chart dialogue box
(fig. 15.9) is displayed if you create a new colour
by clicking on Chart or edit an existing chart
colour by clicking on Edit.

This facility allows you to choose colours from
pre-defined colour charts, a number of which are
supplied by default. The icon labelled Model
shows the current chart name, but you may
choose another chart from the menu (fig. /5.10).
The colours in the chart are displayed in the main
window. Use the horizontal scroll bar to view all
the colours in the chart.

There are three ways of choosing a colour from
the chart.

e Click on the colour or its name, then click on
OK to close the dialogue box and add the
colour to the list of available colours.

CHapTER 15

e If you want to choose a number of colours,
double-click on each name then finally click
on OK to close the dialogue box and add all
the colours to the list of available colours.

e Type in the name of the colour in the writable
icon provided. As you type each character,
Ovation Pro will attempt to find and highlight
a matching colour name in the chart. Now
double-click on the colour to choose it, or click
on OK to choose the colour and close the
dialogue box.

After choosing a colour and closing the

Colour chart dialogue box, the chosen colour is
added to the list of available colours. The chart
name and colour name are combined to create a
full name. For example, if you choose Mustard
from the Rainbow chart, the full colour name is
Rainbow Mustard.

You can easily create your own colour charts
(see Appendix G).

Colour chart

Pale Pink
ST

Pale Orange Pale Yellow

Fig. 15.9 - The Colour chart dialogue box.

Fig. 15.10 - Colour charts.

—
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This chapter describes the macros facility which allows three types of
macros to be defined:

Button macros represent buttons that appear on the button bar. You can
add buttons to the button bar that type in strings, execute keypresses for
common options or call functions directly in Ovation Pro.

Key macros represent keys on the keyboard allowing them to be redefined.
Virtually all the keys may be redefined including special key combinations
using Cirl, Shift etc.

User macros allow common constants to be given simple textual names.
They are useful for defining constants that you may wish to use several
times in other macro definitions.
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16.1 The Macros Dialogue Box
Choose Misc=>Macros to display the Macros
dialogue box (fig. 16.1). Each row in the table
represents a single macro, and comprises:

e The macro name.

e An optional sprite used to represent the macro
on the button bar (button macros only).

e The actual macro definition.

e An option which determines whether the
button will appear on the button bar (button
macros only).

The options Button, Key and User control the
type of macros being displayed. By default
Button is selected, causing the dialogue box to
display all the button macros.

L {picktool(1.0) &
frame  .*| {picktool(3,0)} _}
oate ()| {pickool(2,0)} g

magny Q) {picktook(9,0)} i

info ﬂ {open_menu(info_box(1))} =

_ new Q] {opennewbox ()} __[
'_']'R'ecord @ Button Q Koy on) Usaess, i

_Edt... |New |Oopy |Delsto| Save|canco|||

=i

Fig. 16.1 - The Macros dialogue box showing the buttons that have been defined.
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16.2 Creating Button Macros

Choose Button on the Macros dialogue box to
display the button macros, then click on New to
display the New button dialogue box (fig. 16.2).

Type in a name for the button you require
(maximum 12 characters). The button name must
not be the same as any other macro already
defined or the name of any keyboard character.
So you cannot define buttons called A, h, F3,
Print etc.

The width of the button displayed on the button
bar is determined by the width of the text you
type, so choose short names if you want to fit lots
of buttons on the button bar. The button name
doesn’t have any significance if you choose to use
a sprite to represent the button.

If you wish to assign a sprite to your button, click
on the icon to the right of the Sprite option to
display the button box (fig. 16.3).

The button box is a palette of sprites that may be
used for button legends. Use the vertical scroll
bar to scroll through the entire list, and choose the
sprite you require by clicking on it. The button
box will then be closed and the sprite name
displayed in the New dialogue box. If you should
then decide not to use the sprite, you can deselect
the Sprite option.
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Click on Insert gap before if you want to insert a
small gap before the button on the button bar.
This may be useful if you wish to separate groups
of similar buttons on the button bar.

When you have completed the dialogue box, click
on OK to create the button.

The new button name will appear in the first
column at the bottom of the macro list, but at this
stage doesn’t yet appear on the button bar. If you
have assigned a sprite to the button, this will be
displayed in the second column.

The icon in the third column contains the actual
definition, which at this stage is blank. If you type
some text into this icon, choosing the button on
the button bar will type the text into the
document. Full details of how to define macros
are given later in this chapter.

The final column is an option which determines if
the button appears on the button bar. Ovation Pro
is supplied with a wide range of predefined
buttons, but only a small selection are actually
enabled (see 16.7).

Fig. 16.2 - The New button box.

Fig. 16.3 - The button box.
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16.3 Cregﬁng Key Macros The new key macro name is displayed in the first
column at the bottom of the key macro list

(fig. 16.5). The icon in the second column is for
the actual definition, which at this stage is blank.

o If you type some text into this icon, it will be
Now press the key or key combination that you typed into the document when the keypress is

wish to define. You may define any key on the invoked. Full details of how to define the key

main keyboard or keypad except for Escape, macros are given later in this chapter.
Break and Return. In addition you may also

define key combinations using Ctrl, Shift or Ctrl
Shift. You cannot define key combinations using
the Alt key since this is reserved for accessing
international characters.

Choose Key on the Macros dialogue box to
display the key macros, then click on New to
display the New key dialogue box (fig. 16.4).

The key name you have chosen is displayed in the
New key dialogue box.

When you have correctly chosen the key you
wish to define, click on OK to close the dialogue
box.

3 Naw key
- key| Ot ShiftFo

Cancel[[_ok |

Fig. 16.4 - The New key dialogue box.

_Wecros

‘!_[Hsoord QBulton @Key Qmm :
|Now |Oopy ]nem|Save|0anes||| '

Fig. 16.5 - The Macros dialogue box showing the keys that have been defined.

[
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16.4 Creating User Macros

Choose User on the Macros dialogue box to
display the user macros, then click on New to
display the New macro dialogue box (fig. 16.6).

Type in a name for the macro you require
(maximum 12 characters). The name must not be
the same as any other macro already defined or
the name of any keyboard character. So you
cannot define buttons called A, h, F3, Print etc.

If you intend to use this macro in other
definitions, it will be an advantage to keep the
name as short as possible.

When you have correctly typed the user macro
name, click on OK to close the New macro
dialogue box.

Fig. 16.6 - The New macro dialogue box.
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The new user macro name will be displayed in
the first column at the bottom of the macro list
(fig. 16.7). The icon in the second column is for
the actual definition, which at this stage is blank.
Full details of how to define the key macro are
given overleaf.

Fig. 16.7 - The Macros dialogue box showing the user macros that have been defined.
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16.5 Defining Macros

To define a macro, click Select in the definition
icon to the right of the macro name, and type in a
string. The string may contain all the usual ASCII
characters, but must not begin with { or <.

In addition to the normal printable characters, you
can introduce any ASCII characters in the range 0
to 31 or 127 to 255 using special escape
sequences.

If you wish to start the string with { or <, you
must use the alternative sequences | { or | <.

John types John

Regards|M types Regards followed by CR
1tio types * (ASCII code 143)

l<6> types the string <6>

Key expansions

If the definition string corresponds to the name of
a key enclosed in braces { }, that key will be
invoked. All the keys on the keyboard may be
used except Return, Escape and Break. Keys may
also be prefixed by the following sequences:

g Shift plus key
C._ Ctrl plus key
CS_ Ctrl Shift plus key

If a key in a definition has already been redefined
using a key macro, the new definition will be
used unless the key name is preceded by a single
quote character. In that case, the original
operation of the key is invoked i.e. the one
predefined in Ovation Pro.

{F1} invoke the keypress F1

{C_V} invoke keypress Ctrl V

{S_F3} invoke the keypress Shift F3
{CRight} invoke the keypress Cursor Right
{F3} invoke the keypress F3

{"F3} invoke the original keypress F3
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Macro expansions
If the definition string is a macro name enclosed
in braces { } it will be evaluated.

{dtp}
{mcl}{mc2}

expands the user macro dtp
expands mc1 and mc2

Function expansions

If the definition string enclosed in braces { }
doesn’t match a macro name or keypress, it is
passed to the script language and executed as a
function.

{setalign(1)} calls setalign()

System expansions

If the definition string is enclosed in angle
brackets <> then it is evaluated as a system
variable (using OS_ReadVarVal or
OS_ReadUnsigned).

<SyssTime>
<&FF>
<2_10111010>

expands variable Sys$Time
expands hex number &FF
expands binary 10111010
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16.6 Other Macro Operations

Recording Macro Definitions

The previous pages describe how to type in macro
definitions, but it is possible to record definitions
directly from the document. It is useful if you
wish to program a button, key or macro with a
complicated key sequence.

First, choose the macro you wish to define by
clicking Select in it’s definition icon. Select the
Record option, and click in the document
window without closing the Macros window.
Now anything typed into the document will be
recorded in the macro definition, including any
special keypresses. Switch off recording when
you have finished by deselecting the Record
option.

Expanding Macros
Double-click on the macro name to expand it.

Editing a Button Macro

Click on Edit to display the Edit button dialogue
box (fig. 16.8). You may use this dialogue box to
change the sprite assigned to the button or to
enable/disable the gap inserted before it on the
button bar.

Please note that the Edit option is only available
for button macros.

Fig. 16.8 - The Edit button dialogue box.
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Copying a Macro

This option copies the macro definition that
contains the caret. The Copy dialogue box allows
you to type in a different name for the new copy.
Operation of this dialogue box is identical to that
for the New option described previously.

Deleting a Macro

This option deletes the macro definition that
contains the caret. The macro is not completely
deleted until OK is clicked, so if you wish to
restore the deleted macro, click on Cancel and
then reopen the Macros dialogue box.

Saving the Macros

Click on Save to save all the macro definitions so
that they will be loaded automatically each time
Ovation Pro is run.

Click Menu to display a standard save box,
allowing you to save macros in a named file. To
reload the macros, double-click on the file or drag
it to the Ovation Pro icon on the icon bar.
Loading a macros file in this way overwrites any
macros currently loaded.
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16.7 Summary of Pre-defined buttons

The following pages list all the predefined
buttons available in Ovation Pro. By default only
a selection of these are enabled (see 2.8), but you
may enable the buttons that you require or add
your own buttons. Many of the buttons may be
used as templates for your own buttons. So for
example, the button Corpus sets the font to
Corpus but you may copy the button and edit its
definition to set another font. To do this you will
need some knowledge of the Ovation Pro script
language and functions, which are described in
detail in the next chapter.

Remember to click on Save to save any changes
you make.

Tools

Select tool.
Frame tool.

Rotate tool

LI [

Magnify tool.

lcon Bar menu
Ovation Pro Info dialogue box (see 2.2).

New document (see 11.2).

O

Choices dialogue box (see 14.3).
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File Menu
(2| Fite info dialogue box (see 3.1).

Save (see 3.9).

Eﬂ Save (without prompt).

@J Save story/picture (see 3.9 & 10.2).
ﬂ Save stylesheet (see 14.1).

@l Revert to saved (see 3.4).

Print dialogue box (see 3.10).

Mail merge dialogue box (see 12.5).

Edit Menu
il Select all (see 3.5).

| Clear selection (see 3.5).

Cut selection (see 3.6).

ﬂl Copy selection (see 3.6).

_B_l Paste selection (see 3.6).

._x Delete selection (see 3.6).

(1] showrnide Clipboard (see 3.6).

(9] Embed object from clipboard (see 8.10).
H Undo (see 3.4).

S| Redo (see 3.4).

Find dialogue box (see 3.8).
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View Menu

New view (see 7.2).

Options dialogue box (see 7.3).
Show/hide Toolbox (see 7.3).
Show/hide Info palette (see 7.3).
Show/hide Rulers (see 7.3).
Show/hide Pasteboard (see 7.3).
Show/hide Pictures (see 7.3).
Show/hide Guidelines (see 7.3).

Show/hide Print margins (see 7.3).

Enable/disable Facing pages (see 7.3).

Show/hide Invisibles (see 7.3).
Grid dialogue box (see 7.4).
Enable/disable grid (see 7.4).

Zoom dialogue box (see 7.5).
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125% |125% zoom (see 7.5).

E&

&
=]

Zoom to Fit window (see 7.5).

Zoom to Fit screen (see 7.5).

&

SuMMARY OF PRre-DEFINED ButTONS

Text/Picture Menu
Modify text dialogue box (see 4.6).

Font menu (see 4.2).

| Corpus | Set font to Corpus.

@Eiﬁlﬁlﬁhﬂ;mlﬁlﬂlﬁl&lﬂ_tlﬂlﬁblﬂl&l@@@

Size menu (see 4.3).

Set type size to 13pt

Effect menu (see 4.4).

Set text to Normal (see 4.4).

Set text to Bold (see 4.4).

Set text to Italic (see 4.4).
Underline text (see 4.4).

Reverse out text (see 4.4).

Set text to Superscript (see 4.4).
Set text to Subscript (see 4.4).

Text Colour dialogue box (see 4.5).
Text Format dialogue box (see 5.4).
Alignment menu.

Left align text (see 5.2).

Centre align text (see 5.2).

Right align text (see 5.2).

Fully Justify text (see 5.2).

Single space line spacing (see 5.3).
Double space line spacing (see 5.3).
Set 14pt absolute leading (see 5.3).
Display Tabs ruler (see 5.5).
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Style Menu
Style menu (see 6.6).

Edit style dialogue box (see 6.2).
Apply Style#1 to text (see 6.6).

Remove Local effects (see 4.1).

Object Menu

Modify object dialogue box (see 9.1).

Border dialogue box (see 9.6).
Text flow dialogue box (see 9.7).
Duplicate dialogue box (see 9.8).
Shape dialogue box (see 9.9).
Bring to Front (see 9.10).

Put to Back (see 9.10).

Group/Ungroup objects (see 9.11).

Make local/master (see 9.12).
Snap to grid (see 9.13).
Page Menu

Edit master pages (see 11.3).
Insert New chapter (see 11.4).
Edit Page guidelines (see 11.3).
Modify chapter (see 11.6).
Delete chapter (see 11.5).
Insert page (see 11.7).

Delete page (see 11.7).

Goto page (see 11.1).
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Misc Menu
Zl Check word (see 13.0).

ZI Check story (see 13.0).

%I Check document (see 13.0).

ZI Check from caret (see 13.0).
Check as you type (see 13.0).
Dictionary dialogue box (see 13.0).
E Characters box (see 3.2).

E_I Insert menu (see 3.2).

@l Insert Chapter number (see 3.2).
@l Insert Page number (see 3.2).

@ Insert Date (see 3.2).

ﬂl Insert Active date (see 3.2).

Insert Time (see 3.2).

Start New page (see 3.2).

ﬂ Start New line (see 3.2).

L’%‘ Insert Hard space (see 3.2).

@ Insert Hard hyphen (see 3.2).

L?,’ Insert Soft hyphen (see 3.2).

Insert Merge tag (see 3.2).

@J Preferences dialogue box (see 14.9).
g Edit colour dialogue box (see 15.2).
El Macros dialogue box (see 16.1).

g
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Ovation Pro Script Language
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Ovation Pro contains an integrated script language that may be used to
control many aspects of its operation, such as the menu organisation,
macros and configuration. The script language is an advanced feature of
the Ovation Pro, and you do not need to understand it to make full use
of the software.
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17.1 Overview

The integrated script language in Ovation Pro is
based on a simple subset of the C programming
language. This chapter outlines the script
language, but does not teach you programming. It
also describes the library of resident functions
that may be called from scripts, and explains how
to add your own functions to the library.

If you are familiar with C programming, then the
language details given on the following pages
should be sufficient to allow you to start using
scripts. If you are not familiar with C, then it is
recommended that you obtain one of the many
beginners books on the C that are available.

The important point to note about the script
language, is that you do not need to use it or
understand it to make full use of Ovation Pro.
However, you may wish to use the script
language for the following reasons:

e The entire Ovation Pro menu structure is
controlled by the script language. By editing
the menu scripts you may re-organise the
menus, add menu entries or change the
function of menu options. You may also add
menus to the button bar.

e The macros system which allows you to define
button bar buttons and re-define keys, is based
around the script language. An understanding
of the script language will allow you to
generate your own advanced button and key
macros.

e Ovation Pro choices and preferences are saved
in script files. Creating script files of this type
allow you to configure the software for
different applications.

e Script programs can write text to the caret or
read text from the caret, so it is possible to
write scripts that generate or modify
documents.
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17.2 Writing & Executing Scripts

Scripts should be plain ASCII text files with the
filetype OvScript (&D65).

You may write scripts using a text editor such as
Edit, or using Ovation Pro itself. In the latter case
you must save the script as ASCII text and not in
Ovation Pro or DDL format (see 3.9).

Executing a Script

A script may be executed by doubling-clicking on
it from the desktop, or by dragging it to the
Ovation Pro icon on the icon bar.

After execution, the script and all its functions,
variables etc. are discarded. Scripts may call
resident Ovation Pro functions, or functions
defined in library scripts.

Autorun Scripts

If you put a script file in the directory
|OvnPro.AutoRun, then on running
Ovation Pro, it is loaded and its main ()
function is executed.

After execution, the script and all it’s functions,
variables etc. are discarded. Typically, auto-run
scripts are used to configure Ovation Pro on start-

up.

Library Scripts

If you put a script file in the directory
!OvnPro.Library, then on running
Ovation Pro, it is loaded and its main ()
function is executed.

After execution, any functions or global
declarations in that file are added to the resident
library of functions. Library functions of this type
may be called by other scripts, or assigned to a
macro and executed from a button or key press.
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Multitasking scripts

In order to make scripts multi-task with other
RISC OS programs you have to place the
pause () function in the main loop of your
program. When this function is executed, a
WIMP poll occurs.

Escaping from programs
You can escape from a script at any time by
pressing Ctrl Esc.

Error Handling
Any errors in a script are reported in a standard
error box.

Ovation Pro is also compatible with throwback
error handling, supported by many text editors.

Example Scripts

A number of example scripts are supplied on the
Ovation Pro release discs. Please refer to the
release notes for details.
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17.3 Script Language Details

This section gives a brief outline of the script
language syntax.

Comments
The characters / * introduce a comment, which
terminates with the characters * /. The C++ form
// may also be used to introduce a comment
which is terminated at the end of the line.
/* this is a C style comment

which may extend across any

number of lines */
// this is a single line comment

Identifiers

An identifier is a sequence of letters and digits.
The first character must be a letter or underscore
_. Upper and lower case identifiers are different.
Identifiers may be any length, and all characters
are significant.

Keywords
The following identifiers are reserved for use as
keywords:

break else string
case for switch
continue T void
default int while
do return
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Integer constants

An integer constant consisting of a sequence of
digits is taken to be decimal. A sequence preceded
by 0 (zero) is taken to be octal. Octal constants do
not contain the digits 8 or 9. A sequence of digits
preceded by 0x or 0X (zero, X) is taken to be a
hexadecimal integer. The hexadecimal digits
include a or A through to £ or F representing
values 10 through to 15.

For example, decimal 127 can be written as
follows:

a = 127; // decimal constant
b = 0177; // octal constant

c = 0x7f; // hexadecimal constant
d = 0X7F; // hexadecimal constant

Character constants

A character constant is a character enclosed in
single quotes, as in ‘x’. The value of the
character constant is the ASCII value of the
character. In addition, the following escape
sequences may be used to represent special
characters.

carriage return CR ASCII 13 Wi

newline LF ASCII 10 \n
horizontal tab HT ASCII 9 \E
double quote " ASCIT 34 X*

backslash \ ASCII 92 A
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String constants
A string constant is a sequence of characters
surrounded by double quotes. A null byte is
appended to strings so that programs that scan the
string can find the end.
“ABC”";

s = // set s to ABC

In order to represent string constants the character
constant escape sequences listed above may be
used.

s = "Hello\r”; // set s to HelloCR
s = "Hi\n"; // set s to HiLF

8 = #ENERS // set s to *HT*

s = “\"DEF\"”"; // set s to "DEF”

s = "A\\"; // set s to \

Non printable characters can be introduced using
escape sequences commencing with |

(see Appendix B). Use | | to represent |.

8 = “|1="

s = *l1211"

// set s to ¥
// set s to 12|

Strings may expand macros enclosed in braces
{}.Use {{ torepresent {.

s = “{MAC}";
g & *ET;

Strings may expand system variables enclosed in
angle brackets <>, Use << to represent <.

// set s to MAC
// set s to {3}

"<SysSTime>"
fe<ds”

// set p to Sys&Time
// set q to <4>

P =
g =
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Variable declarations

Variables may be Global or Automatic. Global
variables are declared outside of functions and
retain their value throughout the program.
Automatic variables may be function parameters
or declared inside compound statements, and only
exist whilst execution is taking place within their
scope.

Global and automatic variables may have the
same identifiers.

Three types of variables are supported:

e void

e int (32-bit signed integers)

e string (variable length character strings).

int nul = 0; // global declaration

void main(void)

{

// automatic

// declarations

IE 8 De 0
int x44 = 99;
string s;
string str =
int d = 2;

“Ovation Pro”;
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Function declarations

Functions can be of type void, int or string,
and arguments may be int or string. Parameters
are normally ‘call by value’, which means that the
called function cannot directly alter a variable in
the calling function; it can only alter its private,
temporary copy. If an ampersand & is placed
before a string parameter in a function definition,
‘call by reference’ is used. In this case the address
of the string variable is passed to the called
function, which may modify the variable in the
calling function. ‘Call by reference’ may only be
used with string parameters.

Like normal C programs, each program must
have a function main () which is executed first.
This implementation does not support function
prototypes, so function definitions must appear
before they are called in the source file.

int length(string s)

{
int 1i;
for (i = 0; schar(s, 1) != 0; i++);
return 1i;

}

void main(void)
{

tprinti (length(”hello”));
}

In the example above, the value that length
computes is returned to main () by the return
statement.
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Operator Precedence
The table below gives the order of precedence

and associativity of functions.
Operators Associativity
() left to right T
! ~ ++ == + - & right to left
L% left to right
+ - left to right =
<< >> left to right
< <= > >= left to right
== l= left to right i
& left to right
A left to right
I left to right ™
&& left to right
I left to right
?: right to left o
= 4= == *= [= $= &= M= |= <<= 33= I'lght to left
7 left to right
The unary - and + operator has higher
precedence than the binary form.
-
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List of Operators

The operators available are similar to those in C,
but in this implementation many operators may
also be applied to strings.

1l +r

Addition operator. If 1 and r are ints, returns the
arithmetic sum.

If 1 and r are strings, returns result of
concatenating r to 1.

l=r

Subtraction operator. 1 and r must be ints, in
which case returns r subtracted from 1.

T "® g

Multiplication operator. If 1 and r are ints,
returns the product.

If 1 is a string and r an int, returns 1
concatenated to itself, r times.

If r is a string and 1 an int, returns r
concatenated to itself, 1 times.

1l /«r
Division operator. If 1 and r are ints, returns the
quotient.

If 1 and r are strings, returns position of r in 1.
1l % r

Modulus operator. If 1 and r are ints, returns the
remainder.

If 1 and r are strings, returns strspn(l, r).

l &r
Bitwise AND operator. If 1 and r are ints, returns
bitwise AND.

= AR i -

Bitwise OR operator. If 1 and r are ints, returns
bitwise OR.

1 4

Bitwise XOR operator. If 1 and r are ints, returns
bitwise XOR.
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l << r
Left shift operator. If 1 and r are ints, returns 1
shifted left r bits.

If 1 is a string and r an int, returns 1 shifted left
r characters.

1 5% ¥
Right shift operator. If 1 and r are ints, returns 1
shifted right r bits.

If 1 is a string and r an int, returns 1 shifted right
r characters.

+1

Upper case operator. If 1 is a string, forces it to
upper case.

-1

Unary minus operator. If 1 is an int, does Unary -.
If 1 is a string, forces it to lower case.

~1

One’s complement operator. If 1 is an int, does
One’s Complement.

If 1 is a string, swops case.

11

Logical NOT operator. 1 must be an int, in which
case TRUE (!=0) becomes FALSE (0), and vice
versa.

l && r

Logical AND operator. 1 and r must be ints.
Expression evaluates left to right, and terminates
as soon as falsehood is known.

I s

Logical OR operator. 1 and r must be ints.
Expression evaluates left to right, and terminates
as soon as truth is known.

1 % x
Comma operator. 1 is evaluated then r.
l ?2xr 3 rl

Conditional expression. If 1 is TRUE, returns r
else returns rl.
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]l ==

Equality operator. 1 and r must be either ints or
strings.

1l 4=k

Inequality operator. 1 and r must be either ints or
strings.

1. = %
Greater than operator. 1 and r must be either ints
or strings.

l ¥
Less than operator. 1 and r must be either ints or
strings.

] =

Greater or equal operator. 1 and r must be either
ints or strings.

l <= r

Less or equal operator. 1 and r must be either ints
or strings.

++1, l++
Increment operators. 1 must be an int, and an
lvalue.

R
Decrement operator. 1 must be an int, and an
lvalue.

l = 3
Assignment operator. 1 and r must be of the
same type. 1 must be an lvalue.

1 += r

Assign 1 + rto 1.1 and r must be of the same
type. 1 must be an lvalue.

1l == ¥

Assign 1 - rtol.1 and r must be ints. 1
must be an lvalue.

1. *5 #

Assign 1 * rto 1.1 and r must be ints. 1 must
be an lvalue.

L = ¥
Assign 1 / rto 1.1 and r must be ints. 1 must
be an lvalue.
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1l %= r
Assign 1 % rtol.1 and r mustbeints. 1
must be an lvalue.

1l I=r
Assign 1 | rtol.1 and r must be ints. 1
must be an lvalue.

l &= r

Assign 1 & rto 1.1 and r must be ints. 1 must
be an Ivalue.

1l & G

Assign 1 # rtol.1 and r must be ints. 1
must be an lvalue.

l <<= 1
Assign 1 << rtol.1 and r must be ints. 1
must be an Ivalue.

1l »»= r
Assign 1 >>rto 1. 1 and r must be ints. 1 must
be an lvalue.

.
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Statements

In a while loop, the statement is executed
repeatedly as long as the value of the expression
remains true (!= 0). The test occurs before
execution of the statement.

while ( expression ) statement;

In a do loop, the sub-statement is executed
repeatedly so long as the value of the expression
remains true (!= 0). The test occurs following
each iteration.

do statement while ( expression )

In a for loop the first expression is evaluated
once, and thus initialises the loop. The second
expression is evaluated before each iteration, and
if it becomes false (0) the loop terminates. The
third expression is evaluated after each iteration.

for (exprl ; expr2 ; expr3 ) statement;

In the i f statement the expression is evaluated,
and if it is true (!=0), the first statement is
executed, otherwise the second statement is
executed. An else is always connected with the
last else-less if at the same block level nesting.

1f (expression ) statement; el se statement;

The swi tch statement causes control to be
transferred to the case statement which matches
the value of the expression. There may be one
default statement to which control is
transferred if no case constant matches the
expression.

switch ( expression )

{
case int constant : statement;
break;
default: statement,
break;
}

The break statement causes an immediate exit
from a loop.

The continue statement causes control to pass
to the start of a loop.
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17.4 The Resident Function Library

The remainder of this chapter describes the
resident functions that may be accessed from the
script language. These functions are split into two
groups, and are summarised below.

System Functions

These functions are mainly concerned with
accessing RISC OS.

e RISC OS functions
e String functions
e File input/output functions

Ovation Pro Functions

These functions carry out operations in
Ovation Pro.

e Macro functions

e Menu control functions
e Icon bar menu functions
e File menu functions

e Edit menu functions

e View menu functions

e Text/Picture menu functions
e Style menu functions

e Object menu functions
e Page menu functions

e Misc menu functions

e Miscellaneous functions

e Macros

CHapter 17
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17.5 System Functions

RISC OS Functions

bbc_adval()

int bbc_adval (int n);

If n > 0, returns data from the analogue port. If n
< 0, returns information about various buffers.

bbc_get ()

int bbc_get (void) ;

Waits for a key to be pressed and returns its
ASCII value.

bbc_inkey()

int bbc_inkey(int c);

If ¢ > 0, waits c centi-seconds for a key to be
pressed, and returns its ASCII value or -1 if no
key was pressed within the time. If ¢ is a negative
key number, return -1 if the specified key is being
pressed at that instant, otherwise return 0.

bbc_vdu()
void bbc_vdu(int c);
Outputs character c to the vdu stream.

clock()

int clock(void) ;

Returns the time in centi-seconds since
Ovation Pro was run.

messagebox ()

int messagebox(string &s);

Displays a message box containing the message s
and a Continue icon. Returns 1.

confirm()

int confirm(string &s);

Displays a confirmation box containing the
message s and Yes/No icons. Returns 1 for Yes 0
for No or -1 for Esc (or if the user clicks on the
background).

errorbox()

void errorbox(string &s);

Raises an error, displays a standard error box
containing the message s. and terminates the
script.
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exit()

void exit(int status);

Terminates script execution. The argument
status is included for compatibility with C.

£x()
void fx(int a, int x,
Performs an os_byte call.

int y):

getenvs ()

int getenvs(string &s);

Gets the value of the system variable specified by
s. If the variable exists, returns 1 with the value
in s, otherwise returns 0.

startscan()
void startscan(void) ;
Initialises the function nextobject ().

nextobject()

int nextobject(string &dir,

string &wildcard, string &name) ;
Searches directory dir for the next object which
matches the wildcarded name wildcard, and
returns its name in the string name. Returns 1 if
the object is found, 2 if it is a directory or 0 if
there are no more objects. This function should be
initialised once before use, using
startscan().

objectexists()

int objectexists(string &name);
Returns 1 if name is a file, 2 if it is a directory or
0 if it does not exist.

swil3 ()

int swil3(int swi,
int rl, int ¥2);
Performs the SWI instruction specified by swi,
setting registers 0, r1, r2. Returns the contents
of register r1.

int r0,

osclis()

int osclis(string &s);

Passes string s to the command line interpreter
for execution as a command. Returns 0 if
successful, otherwise returns 1 and an error
message in s.
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systems ()

int systems(string &s);

Passes string s to the command line interpreter
for execution as a command. If s is prefixed by
the string call:, the calling application is
copied to the top of memory first. When the
called application terminates, the calling
application is restored. Returns 0 if successful,
otherwise returns -2.

printi()

void printi(int i);

Prints integer i to the vdu. You will need to use
bbc_vdu (4) before using this function, and
bbe_vdu(5) afterwards.

prints()

void prints(string &s);

Prints string s to the vdu. You will need to use
bbc_vdu (4) before using this function, and
bbc_vdu (5) afterwards.
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String Functions

chars()

string chars(int c);

Returns a string consisting of the character
equivalent of the ASCII code c.

itos()
string itos{int 1i);
Returns the integer 1 converted to a string.

itoxs ()

string itoxs(int 1i);

Returns the integer i converted to a hexadecimal
string.

mids ()

string mids(string &string,

int from, int len);

Returns a segment of string s, 1en characters in
length commencing at character fxrom.

schar ()

int schar(string &s, int n);
Returns the ASCII code for character n of string
s.

slen()
int slen(string &s);
Returns the length of string s.

stoi()
int stoi(string &s);
Returns the string s converted to an integer.

=,
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File Input/Output Functions
fileopen()

int fileopen(string &name,

string &mode) ;

Opens the file name and returns a handle
associated with the file, otherwise returns 0 if the
operation fails. The string mode should be one of
the following sequences:

r open text file for reading

w create text file for writing

a append; open or create text file for writing at
end of file

r+ open text file for update i.e. reading and
writing

w+ create text file for update

a+ append; open or create text file for update,
writing at end

If mode includes a b after the initial letter (e.g.
rb), it indicates a binary file instead of a text file.

fileclose()

int fileclose(int handle);

Closes the file handle. Return non-zero if the
operation fails.

filegetc()

int filegetc(int handle);

Returns the next character from the file handle
(converted to an int), or -1 if an error occurs.

fileputc()

int fileputc(int char,

int handle) ;

‘Writes character c (converted to an int) to file
handle. Returns the character written, otherwise
return -1 if an error occurs.

filereadi()

int filereadi (int handle) ;

Returns the next int from the file handle, or -1
if an error occurs.
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filewritei()

int filewritei(int i,

int handle) ;

Writes integer 1 to file handle, or returns non-
zero if an error occurs.

filereads()

int filereads(string &s,

int handle) ;

Reads the next string terminated by a Newline
from the file handle into the string s. The
Newline character is included in the string, which
is terminated by a null character. Returns non-
zero if an error occurs.

filewrites()

int filewrites(string &s,

int handle) ;

Writes string s to file handle, or returns non-
zero if an error occurs.

fileeof ()

int fileeof (int handle);

Returns non-zero if the end-of-file indicator for
the file handle, is set.

fileerror()

int fileerror (int handle);

Returns non-zero if the error indicator for the file
handle, is set.

fileseek()

int fileseek(int offset,

int handle) ;

Sets the file position for the file handle to the
position of fset characters from the start of the
file. Returns non-zero on an error.

filetell()

int filetell(int handle);
Returns the current file position for the file
handle, or -1 on an error.
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17.6 Ovation Pro Functions

Macro Functions
delallmacros()

void delallmacros (void) ;
Deletes all macros.

delmacro()
volid delmacro(string &name) ;
Deletes the macro name.

defmacro()

void defmacro(int type,

string &name, string &defn,
string &button);

Defines the macro called name with the
definition specified by de fn. The macro type is
determined by the parameter type:

0  The macro is a Button macro

1 The macro is a Key macro

2 The macro is a User macro

4 The button is displayed on the button bar
8

A gap is inserted before the button on the
button bar, but the button is not displayed

12 A gap is inserted before the button on the
button bar, and the button is displayed on the
button bar

The parameter but ton is the name of the sprite
used to represent the button on the button bar. If
button is a null string, the macro name will be
used instead of a sprite.
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Menu Control Functions
create_menu()

int create_menu(string &name) ;
Creates a new menu called name, and returns a
handle associated with the menu.

delete_menu()
void delete_menu(int handle);
Deletes the menu identified by handle.

rementry_menu()

void rementry_menu({int handle,
int entry);

Removes the entry identified by entry from the
menu identified by handle.

open_menu ()
void open_menu(int handle);
Displays the menu identified by handle.

string _menu()

string string_menu{int handle,
int entry);

Returns the text string for the entry identified by
entry from the menu identified by handle.

content_name ()

string content_name (void) ;

This function is used by Ovation Pro to toggle an
option on the main menu between Text and
Picture, depending upon the active object type.

content_menu()

int content_menu(int entry);

This function is used by Ovation Pro to open the
correct menu when the user clicks on Text or
Picture on the main menu.

—



Section 17.6

addentry_menu ()

int addentry_menu(int handle,
string &entry, string &flags,
string &submenu, string &key,
string &name) ;

Add an entry called name to the menu identified
by handle.

The parameter £1ags specifies the name of a
function that is executed when the menu is
opened. The number of the entry chosen is passed
as an int to the function. The name of the entry
is passed as a string to the function, and can
be changed in the function if required.

Typically, the function should be of the form:

int main_flags(int n, string &s)

{

int bits;
switch(n)
{
case 0:
// change entry 1
if(...) text = "Ungroup"
break;
case 1:
// dotted line after
bits |= DOTTED;
break;

}

return(bits) ;
}

Bits set in the return value control the flags for
the menu entry:

Bit Macro name Function when set

1 TICKED Tick entry

2 DOTTED Dotted line below entry
3 WRITEABLE Make entry writable

4  SHADED Shade entry
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The parameter entry specifies the name of the
function that is executed when an entry on the
menu is chosen. The number of the entry chosen
is passed as an int to the function. Typically, the
function should be of the form:

int main_entry(int n, int subcode)

{
switch(n)
{
case 0:
// deal with entry 1
break;
case 1:
// deal with entry 2
break;

}
return subcode;

}

If submenu is a null string, the menu entry will
not have a sub-menu, otherwise submenu is the
name of a function that returns the handle of the
sub-menu. Typically, the function should be of the
form given below, but it may actually create or
alter the menu if required.

int main_menu({int state)

{

return main_handle;

}

If key is a null string, the entry will not have a
keyboard short-cut, otherwise key specifies the
keyboard short-cut for the entry. Key names are
the same as those used for macro definitions e.g.
Cc_v for Ctrl V (see 16.5 & Appendix C).
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Icon Bar Menu Functions

info_box()

int info_box(int state);

Returns the handle of the Info dialogue box. If
state is non-zero, the dialogue box is created,
otherwise it is destroyed.

opennewbox ()
void opennewbox (void) ;
Opens the New dialogue box.

getnewpagesize ()

int getnewpagesize(int
widthorheight) ;

For use on the New and Page guidelines dialogue
boxes.

setnewpagesize ()

void setnewpagesize(int width,

int height, string &name,

int user);

For use on the New and Page guidelines dialogue
boxes.

getclipboard()

int getclipboard(void) ;
Returns non-zero if the clipboard is open,
otherwise zero if it is closed.

setclipboard()

void setclipboard(int state);

If state is zero close the clipboard, otherwise

open the clipboard. To toggle the clipboard open

and closed, use:
setclipboard(!getclipboard());

quit()

void quit(void) ;

Quits Ovation Pro.

openchoicesbox ()

void openchoicesbox(void) ;
Opens the Choices dialogue box.
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generalchoices ()

void generalchoices(string
&timeformat, string &dateformat,
int warnings, int help);

Controls the General choices on the Choices
dialogue box (see 14.4).

The strings timeformat and stringformat
specify Date format and Time format.

If warnings is non-zero, Warnings is selected.

If help is non-zero, Load interactive help is
selected.

undochoices ()

void undochoices(int save,
int buffsize);

Controls the Undo choices on the Choices
dialogue box (see 14.4).

If save is non-zero, Save buffer is selected. The
parameter buf fsize is the Buffer size in bytes.

viewchoicesl()

void viewchoicesl (int update,
int flash, int period, int rate,
int notused) ;

Controls the View choices on the Choices
dialogue box (see 14.5).

If update is non-zero, Instant updates on path
edit is selected.

If £1ash is non-zero, Flashing caret is selected.
The parameter period is the Period in centi-
seconds for a complete flash cycle, and rate is
the fraction of the flash period that the caret is on
for (where 0x10000 == unity).
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viewchoices2 ()

void viewchoices2 (int
toolboxattached, int toolboxx,
int toolboxy,

int infopalattached,

int infopalx, int infopaly);
Controls the View choices on the Choices
dialogue box (see 14.5).

If toolboxattached is non-zero, Attach
toolbox is selected, and parameters toolboxx
and toolboxy specify the absolute screen
position of the toolbox.

If infopalattached is non-zero, Attach info
palette is selected, and parameters infopalx
and infopaly specify the absolute screen
position of the info palette.

textchoices ()

void textchoices (string
&fontname, int renamestyle,
int guotes, int inset,

int overtype, int pcdelete,
int renamecolour, int unused);
Controls the Text choices on the Choices
dialogue box (see 14.6).

The parameter fontname is the Single shift
font name.

If renamestyle is non-zero, Rename styles is
selected.

If quotes is non-zero, Smart quotes is selected.

The parameter inset is the Text frame insetin
1/1000 pt.

If overtype is non-zero, Overtype is selected.

If pcdelete is non-zero, PC-style delete is
selected.

If renamecolour is non-zero, Rename
colours is selected.
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picturechoices()

void picturechoices(int import,
int aspect, int autoscale,

int centre, int inset,

int runaround) ;

Controls the Picture choices on the Choices
dialogue box (see 14.7).

The parameter import is the Picture import
with Ctrl percentage.

If aspect is non-zero, Aspect lock is selected.

If autoscale is non-zero, Auto scale is
selected.

If centre is non-zero, Centre lock is selected.

The parameter inseft is the Picture frame inset
in 1/1000 pt.

The parameter runaround is the Runaround
error (where 0x10000 == unity).

linechoices()

void linechoices(int width,
int capwidth, int capheight);
Controls the Line choices on the Choices
dialogue box (see 14.8).

The parameter width is the Default line width
in 1/1000 pt. A value of 0 means ‘thin’ i.e. the
thinnest line width possible on the output device.

The parameter capwidth is the Default
triangle width specified as a multiple of the line
width (where 0x10000 == unity).

The parameter capheight is the Default
triangle height specified as a multiple of the line
width (where 0x10000 == unity).
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printchoices()

void printchoices(int mode,

int bleed, int thickness,

int unused)

Controls miscellaneous printing defaults. If mode
is zero, polling occurs during printing so that the
Printing dialogue box is displayed. If mode is
non-zero, no polling occurs and queueing is used.
This latter setting may be used for background
printing with a suitable printer driver.

The parameter bleed is the amount of page
bleed used when printing with the Bleed option
selected (see 12.3). The units are 1/1000 pt.

The parameter thickness is the thickness of
the printers marks when printed with the
Printers marks option selected (see 12.3). The
units are 1/1000 pt.

toolchoices ()

void toolchoices(int xn, int yn,
int sparel, int spare2);

If the toolbox is not attached, the parameters xn
and yn specify the size of the toolbox.

toolrank()

void toolrank(int toolnumber, int
rank, int bits, int sparel);
Specifies the position of the tool toolnumber
on the toolbox. Parameter rank is the position
number. If bit O of parameter bi t s is set, the tool
is preselected. If bit 1 of parameter bits is set,
the tool is not displayed on the toolbox.
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File Menu Functions

fileinfo_box()

int fileinfo_box(int state);
Returns the handle of the File info dialogue box.
If state is non-zero, the dialogue box is created,
otherwise it is destroyed.

savedocument_box ()

int savedocument_box(int state);
Returns the handle of the Save dialogue box. If
state is non-zero, the dialogue box is created,
otherwise it is destroyed.

savedocument ()

void savedocument (string &name) ;
Saves the document with name specified. If name
is a null string, uses the current name if it has
been saved before, otherwise reports an error.

export_box()

int export_box(int state);

Returns the handle of the Save story/Save
selection/Save picture dialogue box. If state is
non-zero, the dialogue box is created, otherwise it
is destroyed.

export_name ()

int export_name(string &name) ;
Returns non-zero and the name of the type of
object that may be saved, in string name. This
function is used by Ovation Pro to display the
correct menu text on the File menu.

savestylesheet_box()

int savestylesheet_box(int

state) ;

Returns the handle of the Save stylesheet
dialogue box. If state is non-zero, the dialogue
box is created, otherwise it is destroyed.

reverttosaved()

void reverttosaved(void);

Restores the document to the most recently saved
version. Equivalent to the Revert to saved
option.
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issaved()
int issaved(void);

Returns non-zero if the document has been saved.

This function is used by Ovation Pro to shade
FileoRevert to saved if it is unavailable.

ischanged()

int ischanged(void) ;

Returns non-zero if the document has been
modified since it was last saved. This function is
used by Ovation Pro to shade File>Revert to
saved if it is unavailable.

openprintbox ()
void openprintbox(void) ;
Opens the Print dialogue box.

getprintmode ()
int getprintmode (void) ;
Returns the current print mode.

0 PRNORM
1 PRPAM
2 PRGAL

Normal printing
Pamphlet printing
Galley printing

setprintmode()
void setprintmode (int mode) ;
Sets the current print mode (see above).

openprintmergebox()
void openprintmergebox(void);
Opens the Mail merge dialogue box.

saveasdefault()

void saveasdefault (void);

Saves the current document as the default
document. Equivalent to the Save as default
option.
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Edit Menu Functions

selectall()

void selectall (void) ;

Selects story if text frame active, otherwise
selects all objects. Equivalent to the Select all
option.

clearselection()

void clearselection(void);
Deselects selected text or objects. Equivalent to
the Clear option.

cutselection()

void cutselection(void);

Deletes selected text, picture or object and
transfers it to the clipboard. Equivalent to the Cut
option.

cancopy ()

int cancopy(void) ;

Returns non-zero if the selected object may be
copied. For use on the Edit menu.

copyselection()

void copyselection(void);
Copies selected text, picture or object to the
clipboard. Equivalent to the Copy option.

candelete()

int candelete (void) ;

Returns non-zero if the selected object may be
deleted. For use on the Edit menu.

deleteselection()

void deleteselection(void) ;

Deletes selected text, picture or object. Equivalent
to the Delete option.

selection_name()

string selection_name (void) ;
Returns the type of object currently selected.
This function is used by Ovation Pro to display
the correct object type after Cut, Copy and
Delete on the Edit menu.

nselected()

int nselected(void);

Returns the number of objects selected. This
function is used by Ovation Pro to shade the Cut,
Copy and Delete options when there is nothing
selected.
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pasteselection()

void pasteselection(void);
Pastes contents of the clipboard into the
document. Equivalent to the Paste option.

paste_name/()

string paste_name (void) ;

Returns the type of object currently selected.
This function is used by Ovation Pro to display
the correct object type after Cut, Copy and
Delete on the Edit menu.

embedobject ()

void embedobject (void) ;

Embeds the object on the clipboard into the text
at the caret. Equivalent to the Embed object
option.

cliptype()

int cliptype (void) ;

Returns the type of object on the clipboard:

-1 Clipboard is empty

0 Clipboard contains an object

>0  Clipboard contains some text or a picture

This function is used by Ovation Pro to shade the
Paste and Embed object options when the
clipboard is empty.

undo ()

void undo(void) ;

Undo the last operation. Equivalent to the Undo
option.

canundo ()

int canundo(void) ;

Returns non-zero if there is an operation that can
be undone. This function is used by Ovation Pro
to shade the Undo option when it is unavailable.

undostring()

string undostring (void) ;

Returns the name of the operation that can be
undone. This string is displayed after the Undo
option on the Edit menu.

CHapTer 17

redo()

void redo(void);

Redo the last operation. Equivalent to the Redo
option.

canredo ()

int canredo(void) ;

Returns non-zero if there is an operation that can
be re-done. This function is used by Ovation Pro
to shade the Redo option when it is unavailable.

redostring()

string redostring(void);

Returns the name of the operation that can be re-
done. This string is displayed after the Redo
option on the Edit menu.

openfindbox

void openfindbox(void) ;

Opens the Find dialogue box. Equivalent to the
Find option.
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View menu functions

newview()

void newview(int master);
Opens a new view on the active document.
Equivalent to the New view option.

view _box()

int view_box(int state);

Returns the handle of the Options dialogue box
on the View menu. If state is non-zero, the
dialogue box is created, otherwise it is destroyed.

gettools()

int gettools();

Returns non-zero if the toolbox is open, otherwise
zero if it is closed.

settools()

void settools(int state);
If state is non-zero, open the toolbox,
otherwise close the toolbox.

getbuttons ()

int getbuttons();

Returns non-zero if the button bar is open,
otherwise zero if it is closed.

setbuttons ()

void setbuttons(int state);
If state is non-zero, open the button bar,
otherwise close the button bar.

getinfopal()

int getinfopal (void) ;

Returns non-zero if the info palette is open,
otherwise zero if it is closed.

setinfopal()

void setinfopal (int state);

If state is non-zero, open the info palette,
otherwise close the info palette.
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getrulers()

int getrulers(void);

Returns non-zero if the page rulers are displayed,
otherwise zero if they are hidden.

setrulers()

void setrulers(int state);

If state is non-zero, display the page rulers,
otherwise hide the page rulers.

getpasteboard(void) ;
getpasteboard()

Returns non-zero if the pasteboard is displayed,
otherwise zero if it is closed.

setpasteboard()

void setpasteboard(int state);
If state is non-zero, open the pasteboard,
otherwise close the pasteboard.

getpictures()

int getpictures(void) ;

Returns non-zero if pictures are displayed,
otherwise zero if they are hidden.

setpictures

void setpictures(int state);

If state is non-zero, display pictures, otherwise
hide pictures.

getguides()

int getguides(void);

Returns non-zero if guidelines are displayed,
otherwise zero if they are hidden.

setguides ()

vold setguides(int state);
If state is non-zero, display guidelines,
otherwise hide guidelines.
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getmargins()

int getmargins (void) ;

Returns non-zero if print margins are displayed,
otherwise zero if they are hidden.

setmargins()

void setmargins(int state);

If state is non-zero display print margins,
otherwise hide print margins.

getfacingpages()

int getfacingpages(void);
Returns non-zero if the facing pages are
displayed, otherwise zero if they are hidden.

setfacingpages()

void setfacingpages(int state);
If state is non-zero display facing pages,
otherwise hide facing pages.

getinvisibles()

int getinvisibles (void);

Returns non-zero if the invisibles are displayed,
otherwise zero if they are hidden.

setinvisibles()

void setinvisibles(int state);
If state is non-zero display invisibles,
otherwise hide invisibles.

grid_box()

int grid_box(int state);

Returns the handle of the Grid dialogue box on
the View menu. If state is non-zero, the

dialogue box is created, otherwise it is destroyed.

getgrid()

int getgrid(void);

Returns non-zero if the grid is displayed,
otherwise zero if it is hidden.

setgrid()

void setgrid(int state);

If state is non-zero display the grid, otherwise
hide the grid.
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getgridlock()

int getgridlock(void) ;

Returns non-zero if the grid is locked, otherwise
zero if it is unlocked.

gsetgridlock()

void setgridlock(int state);

If state is non-zero lock the grid, otherwise
unlock the grid.

zoom_box ()

int zoom_box(int state);

Returns the handle of the Zoom dialogue box on
the View menu. If state is non-zero, the
dialogue box is created, otherwise it is destroyed.

setzoom()

void setzoom(int opt, int mul,
int div);

Sets the document zoom. The parameter opt
should be one of the following options which are
equivalent to options on the Zoom dialogue box.

0 ZOOMFIT  Fit window

1 ZOOM50 50% zoom

2 ZOOM100  100% zoom

3 ZOOM200  200% zoom

4 ZOOMDEF  User defined variable zoom
5 ZOOMSCR  Fit screen

6 Z0O0OM75 75% zoom

7 ZOOM150  150% zoom

8 ZOOM400  400% zoom

If opt is set to ZOOMDEF, parameters mul and
div should be set to the required zoom ratio,
otherwise these parameters are not used.

=
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Text menu functions
openobjectcontentsbox

void openobjectcontentsbox(void) ;
Opens the Modify text or Modify picture
dialogue boxes. The actual box opened depends
upon the currently active object.

getfont ()

int getfont (void);

Returns the handle of the font at the caret or
throughout the selection.

setfont ()
void setfont(int handle);
Changes text to the font identified by handle.

getfontname ()

int getfontname (int handle,
string &name) ;

Returns in string name, the name of the font
identified by handle. Returns zon-zero if a font
with that handle exists, otherwise returns zero.
Font handles are numbered from 0 upwards.

fontschanged()

int fontschanged(void) ;

Returns non-zero if the list of available fonts has
changed i.e. one or more fonts have been added
or removed from the system. Ovation Pro uses
this function to update the Font menu.

getfontsize()

int getfontsize(void);

Returns the size of the font at the caret or
throughout the selection. Value returned is in
1/1000 pt.

setfontsize()

vold setfontsize(int size);

Change text to font size specified by size. Value
should be in 1/1000 pt.
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geteffect()

int geteffect (void);

Returns an int whose bits specify which text
effects are active at the caret or throughout the
selection:

0x1 NORMAL
0x2 BOLD

0x4 ITALIC
0x8 UNDERLINE

0x10 REVERSE
0x20 SUPERSCRIPT
0x40 SUBSCRIPT

seteffect()

void seteffect(int effect);

Set text effect. The bits of parameter ef fect
should be set according to the table given above.

getcase()

int getcase(void);

Returns the case of the text at the caret or
throughout the selection:

0 Normal
1 Title
2 All caps

setcase()

void setcase(int case);

Set the case of text. The parameter case should
be set according to the table above.

opencolourbox ()
void opencolourbox(void) ;
Opens the text Colour dialogue box.
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getulwidth()
void getulwidth(string &width) ;

Returns in the string width, the underline width.

For use on the underline Width menu.

setulwidth()

void setulwidth(string &width) ;
Sets the underline width to the value specified by
width.

For use on the underline Width menu.

gettint ()
int gettint(void) ;
Returns the current tint.

For use on the colour picker Tint menu.

settint ()
void settint (int tint);
Sets the tint to the value specified by tint.

For use on the colour picker Tint menu.

openformatbox ()
void openformatbox(void) ;
Opens the Format dialogue box.

getalign()
int getalign(void) ;
Returns the alignment of selected paragraphs:

0 Left aligned

1 Centred

2 Right aligned

3 Fully justified

setalign()

void setalign(int align);

Sets the alignment of selected paragraphs. The
parameter align should be set according to the
table above.
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getleading()

void getleading(string &leading) ;
Returns in string 1eading, the leading of
selected paragraphs. Typically the returned string
will be of the form 20%, 14pt or +6pt.

setleading()

vold setleading(string &leading);
Sets the leading of selected paragraphs. The
parameter 1eading should be of the form 20%,
ldpt or +6pt.

opetabsbox ()
void opentabsbox(void) ;
Opens the Tabs dialogue box.
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Style menu functions
openstylebox ()

void openstylebox(void) ;
Opens the Edit style dialogue box.

getscope()
int getscope(void) ;
For internal use by Edit style dialogue box only.

setscope()
void setscope(int scope);
For internal use by Edit style dialogue box only.

getuserstyle()

int getuserstyle(int handle,
string &name, int mode) ;

Returns in string name, the name of the style
identified by handle . Returns zon-zero if a style
with that handle exists, otherwise returns zero.
Style handles are numbered from O upwards. for
the Style menu, mode should be 1.

addstyle()

void addstyle(int handle) ;
Applies the style identified by handle to the
text.

iscurrentstyle()

int iscurrentstyle(int handle);
Returns non-zero if the style identified by
handle is current at the caret or throughout the
selection.
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cleareffects ()
void cleareffects(void);
Clears all local effects from the caret or selection.

getcurrentstyle()

int getcurrentstyle(int handle,
string &name, int excluding);
Returns in string name, the name of the current
style identified by handle . Returns zon-zero if a
style with that handle exists, otherwise returns
zero. Current style handles are numbered from 0
upwards, The parameter excluding may have
one of the following values:

0 Include BodyText
1 Exclude BodyText
2 Exclude BodyText if it is the bottom style

remstyle()

void remstyle(int handle) ;
Removes the style identified by handle, from
the caret or selection.
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Object menu functions

activetype()

int activetype(int objecttype);
Returns information about the type of object
specified by objecttype. This should be set to
TEXTFRAME or PICTFRAME. It returns:

0 If no objects of this type are selected
1 If an object of this type is selected
>1 If the contents of the object are selected

canmodify ()

int canmodify(void) ;

Returns non-zero if the selected object may be
modified. For use on the Object menu.

opencbjectbox ()
void openocobjectbox(void) ;
Opens the Modify dialogue box.

getguidewidth()
int getguidewidth(void) ;
Returns the column guide width.

For use on the column guide Width menu.

setguidewidth()
void setguidewidth(int width) ;
Sets the column guide width.

For use on the column guide Width menu.

getvalign()
int getvalign(void) ;
Returns the vertical alignment:

For use on the frame Alignment menu.

setvalign()
vold setvalign(int align);
Sets the vertical alignment.

For use on the frame Alignment menu.

getlinewidth()
int getlinewidth (void) ;
Returns the line width.

For use on the line Width menu.

setlinewidth()
void setlinewidth(int width) ;
Sets the line width.

For use on the line Width menu.
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getlinepattern()
int getlinepattern(void);
Returns the line pattern.

For use on the line Pattern menu.

setlinepattern()

void setlinepattern(int style,
int scale);

Sets the line pattern.

For use on the line Pattern menu.

getlinejoin()
int getlinejoin(void) ;
Returns the line join.

For use on the line Join menu.

setlinejoin()
void setlinejoin(int join);
Sets the line join.

For use on the line Join menu.

getlinecaps ()
int getlinecaps(int start);
Returns the line caps style.

For use on the line Start caps and End caps
menus.

setlinecaps()

void setlinecaps(int start,
int style);

Sets the line caps style.

For use on the line Start caps and End caps
menus.

getlinetriangle()

int getlinetriangle(int start,
int height);

Returns the line triangle caps size.

For use on the line caps Width and Height
menus.

setlinetriangle()

void setlinetriangle(int start,
int height, int size);

Sets the line triangle caps size.

For use on the line caps Width and Height
menus.
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getlinewindingrule()
int getlinewindingrule (void) ;
For internal use only.

setlinewindingrule()

void setlinewindingrule (int
rule) ;

For internal use only.

openborderbox ()
void openborderbox (void) ;
Opens the Border dialogue box.

opentextflowbox()
void opentextflowbox(void) ;
Opens the Text flow dialogue box.

openduplicatebox()
void openduplicatebox(void);
Opens the Duplicate dialogue box.

canduplicate()

int canduplicate(void) ;

Returns non-zero if the selected object may be
duplicated. For use on the Object menu.

duplicateselection()

void duplicateselection(int n,
int hshift, int wvshift);

Duplicates the current object. If n <0, does n
duplications using dialogue shifts. If n == 0, sets
dialogue box offsets to hshift and vshift.If
n > 0, does n duplications with offsets hshift
and vshift.

canshape ()

int canshape (void) ;

Returns non-zero if the selected object may be re-
shaped. For use on the Object menu.

openshapebox ()
void openshapebox (void) ;
Opens the Shape dialogue box.

cangofront ()

int cangofront (void) ;

Returns non-zero if the selected object can be
brought to the front. This function is used to
shade the Front option when it is unavailable.
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objectfront ()

void objectfront (void) ;

Brings the selected object to the front. Equivalent
to the Front option.

cangoback()

int cangoback(void) ;

Returns non-zero if the selected object can be sent
to the back. This function is used to shade the
Back option when it is unavailable.

objectback()

void objectback(void) ;

Sends the selected object to the back. Equivalent
to the Back option.

cangroup ()

int cangroup(void) ;

Returns non-zero if there are a number of selected
objects that may be grouped. This function is
used to control the Group option.

groupselection()

void groupselection(void) ;
Groups the selected objects. Equivalent to the
Group option.

canungroup ()

int canungroup (void) ;

Returns non-zero if the selected objects may be
ungrouped. This function is used to control the
Ungroup option.

ungroupselection()
void ungroupselection(void) ;
Ungroups the selected objects.

canmakelocal ()

int canmakelocal (void) ;

Returns non-zero if the selected object can be
made local. This function is used to control the
Make local option.

makeselectionlocal ()

void makeselectionlocal (void) ;
Makes selected master object local. Equivalent to
the Make local option.
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canmakemaster()

int canmakemaster (void) ;

Returns non-zero if the selected object can be
made back into a master object. This function is
used to control the Make master option.

makeselectiomaster()
void makeselectionmaster (void) ;

Makes localised object back into a master object.

Equivalent to the Make master option.

snaptogrid()

void snaptogrid(void) ;

Snaps the selected object to the grid. Equivalent
to the Snap to grid option.
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Page menu functions
opennewchapterbox()

void opennewchapterbox(int pos);
Creates a new chapter and opens the Modify
chapter dialogue box. If pos is non-zero the new
chapter is inserted after the current chapter,
otherwise it is inserted before.

openmodchapterbox()
void openmodchapterbox(void) ;
Opens the Modify chapter dialogue box.

ismasterview()
int ismasterview(void) ;
Returns non-zero if the master pages are open.

This function is used to control various options on

the Page menu.

openpageguidebox ()
void openpageguidebox() ;
Opens the Page guidelines dialogue box.

deletechapter ()
void deletechapter (void) ;
Deletes the current chapter.

openinspagebox()
void openinspagebox (void) ;
Opens the Insert page dialogue box.

opendelpagebox()

void opendelpagebox(void) ;
Opens the Delete page dialogue box.
opengotopagebox ()

void opengotopagebox(void) ;
Opens the Goto page dialogue box.
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Misc menu functions

checkstory()

void checkstory(int caret);
Spellcheck current story. If caret is non-zero
the spellcheck commences from the caret
position, otherwise from the start of the story.
Equivalent to the Check from caret and
Check story options.

checkword()

void checkword (void) ;
Spellcheck current word. Equivalent to the
Check word option.

checkdocument ()

void checkdocument (void);
Spellcheck entire document. Equivalent to the
Check document option.

getcheck()

int getcheck(void) ;

Returns non-zero if the Check as you type option
is selected.

setcheck()
void setcheck(int asyoutype);
Selects the Check as you type option.

opendictionarybox()
void opendictionarybox(void) ;
Opens the Dictionary dialogue box.

getuserdict()

int getuserdict (int handle,
string &name) ;

Returns in string name, the name of the
dictionary whose handle is specified by
handle. Returns zon-zero if a dictionary with
that handle exists, otherwise returns zero.

setuserdict ()
void setuserdict(int handle);
Attaches the dictionary specified by handle.

isuserdict ()

int isuserdict(int handle);

For use by the Dictionary dialogue box only.
opencharsbox ()

void opencharsbox(void) ;
Opens the Characters box.
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datestring()
string datestring(void);
Returns the current date.

timestring()
string timestring(void) ;
Returns the current time.

openmergebox ()
void openmergebox (void) ;
Opens the Insert>Merge tag dialogue box.

openprefbox()
void openprefbox(void);
Opens the Preferences dialogue box.

getunits()

int getunits(void);

Returns an integer value representing the current
units:

0 mm
1 inches
2 pts

setunits ()
void setunits(int unit);
For use by the Preferences dialogue box only.

generalpref ()

void generalpref (int autosave,
int interval, int prompt,

int units, int chapter, int
separator) ;

Controls the General preferences on the
Preferences dialogue box (see 14.10).

If autosave is non-zero, Auto save is enabled
with the interval specified in 1/100’s of a second.
If prompt is non-zero, Prompt for auto save is
selected.

Parameter unit s specifies the Document units:

0 mm
1 inches
2 pts

Parameter chapter specifies the Start chapter
number.

Parameter separator is the ASCII code for the
Chapter/page separator.
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viewprefl ()

void viewprefl (int pasteboardx,
int pasteboardy, int rulerx,

int rulery, int snapguides,

int snapobjects, int guidepos);
Controls the View preferences on the Preferences
dialogue box (see 14.11).

The parameter pasteboardx specifies the
Pasteboard width in 1/1000 pt. The parameter
pasteboardy specifies the depth of the
pasteboard above and below the document.

Parameters rulerx and rulery specify Ruler
origin X and Ruler origin Y in 1/1000 pt.

If snapguides is non-zero, Snap to ruler
guides is selected.

If snapobjects is non-zero, Snap to objects
is selected.

If guidepos is zon-zero, Guidelines to front is
selected, otherwise Guidelines to back is
selected.

textpref ()

void textpref (int spacing,
int origin, int superscipt,
subscript, int smallcaps,
int tabchar);

Controls the Text preferences on the Preferences
dialogue box (see 14.12).

int

Parameter spacing is the Baseline grid
spacing specified in 1/1000 pt. The parameter
origin is the Baseline grid origin specified in
1/1000 pt.

Parameters superscript, subscript and
smallcaps specify Superscript size,
Subscript size and Small caps size (where
0x10000 == 100%).

Parameter tabchar is the ASCII code for the
Decimal tab character.
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openeditcolourbox()
void openeditcolourbox(void) ;
Opens the Edit colour dialogue box.

getcolour()

int getcolour (int handle,
&name) ;

Returns in string name, the name of the colour
whose handle is specified by handle. Returns
zon-zero if a colour with that handle exists,
otherwise returns zero.

string

setcolour ()
void setcolour (int handle);
For use by the Edit colour dialogue box only.

getcolourchart()

int getcolourchart(int handle,
string &name) ;

Returns in string name, the name of the colour
chart whose handle is specified by handle.
Returns zon-zero if a colour chart with that
handle exists, otherwise returns zero.

setcolourchart()
void setcolourchart(int handle);
For use by the Colour chart dialogue box only.

iscurrentchart ()
int iscurrentchart (int handle);
For use by the Colour chart dialogue box only.

openmacrobox ()
void openmacrobox(void) ;
Opens the Macros dialogue box.

flushundobuffer ()

void flushundobuffer (void);
Flushes the undo buffer. Equivalent to the
Misc<Min memory option.
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Miscellaneous functions

caretchar ()

int caretchar (void) ;

Return the ASCII code for the character after the
caret, or -1 if there is no active text frame or if the
caret is at the end of a story.

type ()

void type(string &s);

Types the string s at the current caret position. In
addition to the usual printable characters, the
string may contain control codes preceded by |,
escape sequences preceded by /, macros enclosed
in braces {} and system variables enclosed in
angle brackets <> (see 16.5).

type(s);

type(”"Hello World”);
type(”"Beep|G") ;
type(”"Hello World\r”);
type (" {ActiveDate}”);
type(”<SyssTime=") ;

curpageno ()
int curpageno (void) ;
Returns the current page number.

curchapterno()
int curchapterno(void) ;
Returns the current chapter number.

setmaindictionary()

void setmaindictionary(string
mainname) ;

Sets the name of the default main dictionary. This
function is used in AutoRun. !|Custom.

setuserdictionary()

void setuserdictionary(string
username) ;

Sets the name of the default user dictionary. This
function is used in AutoRun. !Custom.

caretcontext ()
void caretcontext (void) ;
For internal use only.
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stringdp()

int stringdp(string &value);
Returns the string value representing a floating
point number converted to an integer. The inverse
of this function is dpstring (). These functions
allow the script language, which only has integer
variables, to handle floating point numbers.

// In this example i =

int i = stringdp("'56.25");
dpstring()

string dpstring(int value,

int decimal) ;

Returns value converted to a string representing
a floating point number. Parameter decimal
specifies the number of decimal places required.
This function is the inverse of stringdp ().

// In this example s = "56.2"
string s = dpstring{ , 1)

stringu()

int stringu(string &value,

int unit);

Returns the string value converted to 1/1000 pt.
The string may be fractional and optionally
followed by the units; mm, in or pt. If the string
value does not specify the units, the parameter
uni t should specify them:

0 mm
1 in
2 pt

The inverse of this function is ustring ().
These functions allow the script language to
handle floating point values in different units.

// In this example i = 36000
int i = stringu("0.5", 1};
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ustring()

string ustring(int value,

int unit);

Returns value in 1/1000 pt, converted to a
string. The units specified by unit are appended
to the string. This function is the inverse of
stringu().

// In this exampl